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 نفت خالقبنام 

 

ٚ ٘مهبٖ اقشجبٜ وشبة اظ ايٗ يف ضٚي قٕب ػعيعاٖ ثبقس. بة ددؽ اظ ٔبٜ ٞب وبض أطٚظ ايٗ وش ضا ؾذبؼ وٝ سٛفيك زازذسا 

اظ ظحٕبر ذٛز ٚاخت ٔيسا٘ٓ ثٝ ايٗ ٚؾيّٝ ثط  يٗ ثبثز اظ ذٛا٘ٙسٜ ػصض سمهيط ٔي ذٛاٞٓ.ا ٚ ِصا ديف اظ ٞطچيع اظ ذبِي ٘جٛزٜ

چطا وٝ اٌط ظحٕبر ايكبٖ ي ضا زاقشٝ ثبقٓ ٟ٘بيز ؾذبؼ ٚ لسضزا٘ زٚؾز ٌطأي خٙبة آلبي ٟٔٙسؼ قبيبٖ ػبثس قيعضي

 ٚ ٛاَ ديطأٖٛ وبض ثبض ٘طْ افعاض ٔي سٛا٘يس اظ َطيك ايٕيُنٛضر زاقشٗ ٞط ٌٛ٘ٝ ؾض ز٘جٛز ايٗ وشبة ٞطٌع آٔبزٜ ٕ٘ي قس. 

 ظيط ُٔطح فطٔبييس. يب ٚثلاي

 اثطاٞيٕي .ْ
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  Drilling officeمعرفي نرم افسار 

ٔؼطفي  حفبضيثٝ نٙؼز   Schlumbergerسٛؾٍ قطوز  وٝ ٔي ثبقس زض ٔطسجٍ ثب ٞٓ وبضثطزي حفبضيٞبي  ثط٘بٔٝزض ٚالغ ٔدٕٛػٝ وبّٔي اظ 
  ضا ثٟيٙٝ ؾبظي ٕ٘بيٙس. ػّٕيبر حفبضي ٚ وبُٔ،خبٔغ  ييسب ثب َطاح ٔي ؾبظز ضا لبزض ؾيٟٗٔٙس ٘طْ افعاض. ايٗ ٜ اؾزٌطزيس

 :كس٘ٔي ثب Drilling office انّي ٞبي ثط٘بٔٝثط٘بٔٝ ظيط اظ  19

BHA Editor, Bit On Seismic, CemCADE, Close Approach, DataBrowser, DD ToolBox, DrillSAFE, 
DrillViz, Hydraulics, PowerDraw, PPW, Query Tool, RiskTRAK, SideKick, Survey Editor, TDAS, Well 
Design, WellTRAK, WEST. 

ثط٘بٔٝ  9 آٔٛظـ ثط٘بٔٝ ثٝ آٔٛظـ زازٜ ذٛاٞس قس ٚ 12ٔي ثبقس  Drilling officeخّسي آٔٛظـ خبٔغ  ض ايٗ وشبة وٝ خّس اَٚ اظ ٔدٕٛػٝ زٚز
 .اؾززيٍط زض خّس زْٚ وشبة آٚضزٜ 

 ٔٝ ٞبي وٝ زض ايٗ وشبة ذٛاٞيس ذٛا٘س ػجبضسٙس اظ:ثط٘ب

 BHA Editor  ثىبض ٌطفشٝ ٔي قٛز َطاحي ضقشٝ سٝ چبٞي ٚ سؼطيف ٞٙسؾٝ حفطٜ چبٜ ثٝ ٔٙظٛض. 

 Close Approach  ٖضا زض اذشيبض وبضثط ٔي ٌصاضز.ثطذٛضز چبٜ ٞب سحّيُ ذُطار أىب 

 Data Browser زؾشطؾي ضاحز ثٝ اَلاػبر ضا فطاٞٓ ٔي وٙس. 

 DrillViz  زض سؼييٗ ذٛزوبض ؾبيع ٔسَ ، ٕ٘بيف ٘مبٌ ثب ايدبز سدؿٕي ؾٝ ثؼسي   survey   ٚ casing ٔحبؾجبر سىطاضي ٚEOU 
 ثىبض ٔي ضٚز.

 Hydraulics  ُسٕيع وطزٖ حفطٜ چبٜ ٚ اسلافبر فكبض ثطاي ٔؿيط چبٜ حميمي ٚ َطاحي قسٜ ثىبض ٔي ضٚز.ثطاي سحّي 

 Power Draw طٚخي ٌطافيىي ايدبز قسٜ زض ذ أىبٖ زؾشىبضي زضDrilling Office وبضثط ٔي زٞسٝ ضا ث. 

 Query Tool  أىبٖ خؿشدٛ ٚ ٌطفشٗ ذطٚخي اظ اَلاػبر شذيطٜ قسٜ زضDrilling Office .ضا ثطاي وبضثط فطاٞٓ ٔي وٙس  

 Survey Editor .أىبٖ ٔحبؾجٝ ٚ سحّيُ ا٘حطاف ضا زض اذشيبض وبضثط لطاض ٔي زٞس 

  Well Design َ.طح ٞٙسؾي چبٜ ضا ايدبز ٔي ٕ٘بيس 

 PPW .ثٝ ٔٙظٛضسرٕيٗ فكبض ؾيبَ ٚ فكبض قىؿز ؾبظ٘س ثىبض ٔي ضٚز 

 

 :ؾيؿشٓ قٕب ثبيس زاضاي حسالُ ٔكرهبر ظيط ثبقس Drilling Officeثطاي ٘هت ٚ اخطاي 

 Windows 2000 (SP-4), Windows XP Professional (SP-1 or SP-2)   

 Microsoft Office 2000 or 2002 (for XP)   

 Laptop (minimum): 266 MHz Pentium II or greater with at least 128 MB memory and 4 GB 
hard disk   

 Laptop (recommended): 600 MHz Pentium III or greater with at least 256 MB memory and 
4 GB hard disk   
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 Desktop/Server: 750 Pentium III or greater with at least 256 MB memory and 20 GB hard 
disk   

 Screen resolution: 1024 x 768 or higher   

 Microsoft Internet Explorer 6.0 SP-1 

٘طْ افعاض ثط ضٚي ٚيٙسٚظ ٞبي ثبلاسط ثب زيسٜ قسٜ اؾشفبزٜ قٛز چطا وٝ  XPسٛنيٝ ٔي قٛز حسإِىبٖ اظ ٚيٙسٚظ ثب سٛخٝ ثٝ وطن قسٜ ثٛزٖ ثط٘بٔٝ 
 .ٜ اؾزٔكىلاسي ٕٞطاٜ ثٛز

 آموزش نصب برنامه:
ثٝ ٔؿيط  ضٚي ؾيؿشٓ ذٛز ٘هت وٙيس. ثٝ ٕٞيٗ ٔٙظٛض ضا ثط Oracleضا ٘هت ٕ٘بييس لاظْ اؾز ثط٘بٔٝ  Drilling officeديف اظ آ٘ىٝ ثط٘بٔٝ انّي 

Oracle 8.1.7\oracle 8.1.7 drill office\install\win32  ثط ضٚيCD ٚ ٝثط ضٚي  ثط٘بٔٝ ضفشsetup  زاثُ وّيه ٕ٘بييس ؾذؽ
 ٔطاحُ ظيط ضا ز٘جبَ ٕ٘بييس.

 اي ثط٘بٔٝ ثٝ ٔكىُ ثط ذٛاٞي ذٛضز.٘ىشٝ: سٕبٔي ٔطاحُ ٘هت ضا ػيٙبً ا٘دبْ زٞيس چطا وٝ زض غيط ايٗ نٛضر زض اخط

 

 .ٕ٘بييس وّيه Next زوٕٝ ضٚي ثط
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 فيّس سٛا٘يس ٔي سٕبيُ نٛضر زض ثبقس ٔي ٔٛخٛز زْٚ ٚ اَٚ ٞبي فيّس زض سطسيت ثٝ ٘هت ذٛاٞس قس ثط٘بٔٝ زض آٖ وٝ ٔحّي ٚ انّي ثط٘بٔٝ فبيُ ٔحُ
 دٙدطٜ ثبضٌعاض ظيط ظبٞط ٔي قٛز. .ٕ٘بييس وّيه Next زوٕٝ ضٚي ثط ؾذؽ .ٕ٘بييس سًٙيٓ قٛز ٘هت ثط٘بٔٝ ذٛاٞيس ٔي وٝ ٔحّي زض ضا زْٚ

 

 .ٕ٘بييس وّيه Next زوٕٝ ضٚي ثط. وٙيس لجَٛ ضا قسٜ ا٘شربة فطو ديف َٛض ثٝ وٝ اَٚ ٌعيٙٝ Available products نفحٝ زض
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 .ٕ٘بييس وّيه Next ٕٝزو ضٚي ثط. وٙيس ا٘شربة ضا Minimal (591MB) ٌعيٙٝ Inistallation Types  نفحٝ زض

 

 .ٕ٘بييس وّيه Next زوٕٝ ضٚي ثط. وٙيس ا٘شربة ضا No ٌعيٙٝ Select Starter Database نفحٝ زض
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 .ٕ٘بييس وّيه Install زوٕٝ ضٚي ثطSummery  نفحٝ زض
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 بة ٕ٘بييس.ا٘شر Net8 Configuration Assistant: Welcomeضا زض دٙدطٜ  .Perform typical configurationٌعيٙٝ 

 

 

 وّيه ٕ٘بييس. Exitثط ضٚي زوٕٝ 
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 وّيه ٕ٘بييس. Yesثط ضٚي زوٕٝ 

 

 ٔي ضؾس. Drilling Officeثٝ دبيبٖ ضؾيسٜ ٚ ٘ٛثز ثٝ ٘هت ثط٘بٔٝ  Oracleزض ايٙدب ٘هت ثط٘بٔٝ 

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   14 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

ٕ٘بييس ؾذؽ ٔطاحُ ظيط ضا ز٘جبَ  زاثُ وّيه setupثط٘بٔٝ ضفشٝ ٚ ثط ضٚي  CDثط ضٚي  drilling office\DrillingOffice\ Setupثٝ ٔؿيط 
 ٕ٘بييس.

 

 وّيه ٕ٘بييس. Yesزض دٙدطٜ ٔحبٚضٜ اي ظبٞط قسٜ ثط ضٚي زوٕٝ 

 

 ثٝ دٙدطٜ ثؼسي ثطٚيس. Nextظبٞط ٔي قٛز ثب وّيه ثط ضٚي زوٕٝ   Welcome Dialogدٙدطٜ 

 

ٔحّي ضا ثطاي ٘هت ثط٘بٔٝ ٔكرم  …Browseٔي سٛا٘يس ثب وّيه ثط ضٚي زوٕٝ  Selection of the instaliton folderزض دٙدطٜ 
 ٕ٘بييس.
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 وّيه ٕ٘بييس.  Nextضا ا٘شربة وطزٜ ٚ ثط ضٚي زوٕٝ  Setup Type   ،Customزض دٙدطٜ

 

 وّيه ٕ٘بييس.  Nextٝ ٞب ضا ا٘شربة وطزٜ ٚ ثط ضٚي زوٕٝ سٕبٔي ٌعيSelect Componetsٙ زض دٙدطٜ 
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ٔي سٛا٘يس ٔحّي ضا ثطاي زايطوشٛضي  Browserثب اؾشفبزٜ اظ زوٕٝ   .Choose the location of the data directoryزض دٙدطٜ 
 اَلاػبسشبٖ ا٘شربة ٕ٘بييس.

 

www.Ir وّيه ٕ٘بييس. Nextثط ضٚي زوٕٝ 
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  Noٝ ثط ضٚي ٔيع وبضسبٖ قٕب ضا ٌيح وٙس ثط ضٚي زوٕ Drilling Officeزض نٛضسي وٝ ٕ٘ي ذٛاٞيس سؼساز ظيبز آيىٗ ٞبي ٔيب٘جط ثط٘بٔٝ ٞبي 
 وّيه ٕ٘بييس.
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 وّيه ٕ٘بييس سب ٘هت دبيٍبٜ زازٜ ثط ٘بٔٝ قطٚع قٛز. Yes ثط ضٚي زوٕٝ 

 

زليمٝ ثٝ ََٛ ذٛاٞس ا٘دبٔيس ( لاظْ ثٝ شوط اؾز وٝ  42سب  22٘ىشٝ: ايٗ ٔطحّٝ اظ ٘هت وٕي َٛلا٘ي ثٛزٜ ٚ لاظْ اؾز وٕي نجٛض ثبقيس) زض حسٚز 
 % ذٛاٞس زاقز.82ٛاٞيس زيس أب خبي ٍ٘طا٘ي ٘يؿز چطا وٝ ثٝ َٛض ٘بٌٟب٘ي  ديكطفشي زض حسٚز ٔسر لبثُ سٛخٟي ديكطفشي زض ثبضٌعاض ٘ر

 

ضا ٘هت ٕ٘بييس  لاظْ اؾز ثط٘بٔٝ ضا  Drilling Officeزض ايٙدب ثٝ دبيبٖ ضؾيس ديف اظ آ٘ىٝ ٞيچ يه اظ ثط٘بٔٝ ٞبي  Drilling Office٘هت 
 وطن ٕ٘بييس.

 آٔٛظـ وطن وطزٖ ثط٘بٔٝ:

 زاثُ وّيه ٕ٘بييس ؾذؽ ٔطاحُ ظيط ضا ز٘جبَ ٕ٘بييس. setupضفشٝ ٚ ثط ضٚي  patch Drilling Officeثٝ دٛقٝ ٘بٔٝ ثط CD زض
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 وّيه ٕ٘بييس.  Nextثط ضٚي زوٕٝ 

 

 وّيه ٕ٘بييس. Nextضا ا٘شربة ٕ٘بييس. ثط ضٚي زوٕٝ  Compeletٌعيٙٝ  Setup Typeزض دٙدطٜ 
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 وّيه ٕ٘بييس. Installثط ضٚي زوٕٝ 

 

 

 وّيه ٕ٘بييس. Finishثط ضٚي زوٕٝ 

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   21 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

 زض نٛضسي وٝ وّيٝ ٔطاحُ فٛق ضا زليمبً ا٘دبْ زازٜ ثبقيس ٞٓ اوٖٙٛ ثط٘بٔٝ قٕب ثطاي اخطا حبيط ٔي ثبقس.

ٝ ديف سط ٘يع ديف اظ آٖ وٝ ثٝ ؾطاق آٔٛظـ ثط٘بٔٝ ثطٚيٓ لاظْ ٔيسا٘ٓ ُٔبِجي ضا ٔرشهطاً زض ضاثُٝ ثب ٘حٜٛ آٔٛظـ ايٗ وشبة قطح زٞٓ. ٕٞبٖ َٛض و
ٔشكىُ اظ ٔدٕٛػٝ سمطيجبً وبّٔي اظ ٘طْ افعاض ٞبي ٟٔٙسؾي حفبضي ٔي ثبقس. وٝ سمطيجبً سٕبٔي ٔجبحث حفبضي ضا  Drilling Officeاقبضٜ ٌطزيس 

ٝ ٘بْ قطوز قّٕجطغض دٛقف ٔي زٞس ٚ ٕٞيٗ أط ايٗ ٘طْ افعاض ضا اظ خّٕٝ ٘طْ افعاض ٞبي ٔحجٛة سٕبٔي ٟٔٙسؾيٗ فؼبَ زض ظٔيٗ حفبضي ٌطزا٘يسٜ اِجش
 ٘يع ثٝ ػٙٛاٖ سِٛيس وٙٙسٜ ايٗ ٘طْ افعاض ثٝ ايٗ ٔحجٛثيز زأٗ ظزٜ اؾز.

ٌؿشطزٌي ٚ ديچيسٌي ٞبي ذبل ٟٔٙسؾي حفبضي ثسيٟي اؾز وٝ سؿٍّ ثط ثب سٛخٝ ثٝ اٌطچٝ ٘حٜٛ وبض ثب ٘طْ افعاض ثؿيبض آؾبٖ ٔي ثبقس ِٚي اِىٗ  

 ٛئٓ ثب ؾبَ ٞب سدطثٝ ٔي ثبقس.َزا٘كي ٌؿشطزٜ ٘يبظٔٙس  Drilling Officeسٕبٔي ثط٘بٔٝ ٞبي 

اظ  زض ايٗ وشبة ثٝ ٔٙظٛض آٔٛظـ وبضثطزي ثط٘بٔٝ ٞب، ٔثبِي ُٔطح ٌطزيسٜ ٚ ٔطحّٝ ثٝ ٔطحّٝ يٕٗ ديف ثطز ٔثبَ سٛييحبسي ديطأٖٛ ٞط لؿٕز
اظ ٟٔٙسؾي حفبضي ضا دٛقف ٔي زٞٙس ؾؼي قسٜ  قبذٝ ذبني Drilling Office. ثب سٛخٝ ثٝ ايٙىٝ ٞط يه اظ ثط٘بٔٝ ٞبي اضائٝ ٌطزيسٜ اؾز ثط٘بٔٝ

 ٞب ٔي ضٚيٓ.Utilitieاضائٝ قٛز. ؾرٗ ضا وٛسبٜ وطزٜ ٚ ثٝ ؾطاق  ٞب ثط٘بٔٝزضن ٞط چٝ ثٟشط سب سٛييحبر ٔرشهطي ثٝ ٔٙظٛض 

 (Utilitiesثط٘بٔٝ ٞب )
Data Management Utilities  ضا ثطاي قٕب ٔيؿط ٔي دبيٍبٜ زازٜ دطٚغٜ سيطيز وٝ أىبٖ ٔ ذب٘ٛازٜ اي اظ ثط٘بٔٝ ٞبي وّي ٔي ثبقٙسزض ٚالغ

 ٌيط٘س. ثبيس ثبٞٓ ٔٛضز اؾشفبزٜ لطاض  ٞبData Management Utilitie. لاظْ ثٝ شوط اؾز وٝؾبظ٘س

Data Management Utilitie  قبُٔ ٔٛاضز ظيط ٔي ثبقس:ٞب 

 License File Location Editor ( ُٔٛلؼيز ٔدٛظ فبيlicense file قٕب ) ؾيؿشٓ سٙظيٓ ٔي ٕ٘بيس. ثطايضا 

 Project Login Utility ٝدبيٍبٜ زازٜ يه دطٚغٜ ٔي ثبقس. اثعاض اسهبَ ث 

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   22 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 Project Manager  دطٚغٜ ٞبي ٔسيطيز ٚ ايدبز GeoFrame
®. 

 Drilling officeقطٚع وبض ثب ثط٘بٔٝ 
 ٕ٘بي وّي :

 لجُ اظ ايٗ وٝ قطٚع وٙيس. 

 ْٛايدبز يه ؾيؿشٓ ٚاحس ٔطؾ 

 ٗسبييس اخبظٜ ٘ٛقش 

 لجُ اظ ايٙىٝ قطٚع وٙيس:  -ثرف اَٚ
وبضثطاٖ ٔٙبَك ٔرشّف  ضفغ ٘يبظ ثطايثب سٛخٝ ثٝ ايٗ وٝ ػّٕيبر حفبضي زض ؾطاؾط خٟبٖ نٛضر ٔي دصيطز ِصا  ثبيس أىبٖ سغييط ؾيؿشٓ ا٘ساظٜ ٌيطي 

سؼييٗ يه ؾيؿشٓ ا٘ساظٜ زازٜ ذٛاٞس قس. ( آٔٛظـ Unit Systemخٟبٖ ٚخٛز زاقشٝ ثبقس . زض ايٗ لؿٕز ثٝ قٕب چٍٍٛ٘ي سغييط  ؾيؿشٓ ٚاحس )

 ا٘دبْ زٞس. Drilling officeثبيس لجُ اظ ا٘دبْ ٞط وبضي زض  ،ٌيطي ، يىي اظ اِٚيٗ چيعٞبيي ٔي ثبقس وٝ وبضثط

 ايدبز يه ؾيؿشٓ ٚاحس ٔطؾْٛ –ثرف زْٚ 
 .ا ا٘شربة ٕ٘بييسض Schlumberger > Drilling Office > Utilities >Project Manager  ٔؿيط Startاظ ٔٙٛي  .1

 ٕ٘بيف زازٜ ذٛاٞس قس. Project Managerدٙدطٜ 

 

 ثٝ ٕ٘بيف زازٜ ٔي قٛز. Project Password Verificationوّيه ٕ٘بييس. دٙدطٜ  زاثُ ٔٛضز ٘ظطسبٖثط ضٚي دطٚغٜ اي  .2

 

 

 ٜدطٚغ
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 وٙيس. OKوّٕٝ ػجٛضسبٖ ضا ٚاضز ٕ٘بييس ٚ  .3

 )ٚاضز قسٖ( وطزٖ log-in. زض ٚالغ ايٗ ٕٞبٖ وّٕٝ ػجٛضي اؾز وٝ قٕب ثطاي ٔي ثبقس proj1ثٝ َٛض  ديف فطو وّٕٝ ػجٛض ٘ىشٝ: 

 اؾشفبزٜ ٔي وٙيس. Drilling Office ثٝ ٞط يه اظ ثط٘بٔٝ ٞبي
 ٕ٘بيف زازٜ ٔي قٛز. Project Unit Systemsضا ا٘شربة وٙيس. دٙدطٜ  Units ٌعيٙٝ Editاظ ٔٙٛي  .4

 ٕب٘س.ثبلي ث Displayثط ضٚي  Select the type of unit system فيّس وٝ٘ىشٝ :  ثبيس ٔس ٘ظط زاقشٝ ثبقيس 

 

 

ٔٙٛي وّيه وطزٜ سب  ثط ضٚي   Select the base unit system for the selected type، فيّسزض ؾٕز ضاؾز  .5
 ي ٔطثٌٛ ثٝ آٖ ثبظ قٛز.يوكٛ

 
 .ٕ٘بييسٔٛضز ٘ظط ذٛز ضا اظ ِيؿز ٕ٘بيف زازٜ قسٜ ا٘شربة  ٚاحس ؾيؿشٓ .6

 ٕ٘بيف زازٜ ٔي قٛز. Customize a Unit Systemدٙدطٜ وّيه وٙيس.  …Details ٝزوٕ ثط ضٚي .7
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8. Scroll  ٜوٕيز  سب ثٝضا دبييٗ وكيسStandardDepthIndex  ٕٝثطؾيس. حبَ ايٗ وٕيز ضا ا٘شربة وطزٜ ٚ ثط ضٚي زو

Modify .دٙدطٜ  وّيه وٙيسUnit Selector (Specify a Unit) .ٕ٘بيف زازٜ ٔي قٛز 

 

 Select a unit expression for the selected measurement،  فيّسٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز ثط ض .9
 وّيه ٕ٘بييس.

 ثطٌطزيس. Customize a Unit Systemوّيه وٙيس. ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .12

 ٞط وٕيز زيٍطي وٝ ٔس٘ظط زاضيس سغييط زٞيس. .11

www.Ir يف زازٜ ٔي قٛز.ٕ٘ب Save asوّيه ٕ٘بييس. دٙدطٜ  Save asثط ضٚي  .12
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 ضا زض ايٗ فيّس سبيخ ٕ٘بييس. Tutorial ػجبضر ثٝ ػٙٛاٖ ٔثبَ .وٙيسسبيخ  فيّس ٔطثَٛٝيه اؾٓ ثطاي ؾيؿشٓ ٚاحس زض  .13

 ثطٌطزيس. Customize a Unit Systemوّيه وٙيس. ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .14

 

 ٔٙسضج ٌطزيسٜ ثٝ ثط٘بٔٝ ايبفٝ ٔي قٛز. Unit Systemبثُ وٝ زض ٔم ػٙٛا٘ي: ايٗ ؾيؿشٓ ٚاحس خسيس، ثٝ َٛض اسٛٔبسيه ثب ٘ىشٝ 

 وّيه وٙيس. Saveثط ضٚي وّيس  .15

 وّيه وٙيس. Okثط ضٚي وّيس  .16

 

ضا زٚثبضٜ ثبظ ٔي وٙيس ٔكبٞسٜ ذٛاٞيس وطز وٝ ؾيؿشٓ ٚاحس خسيس قٕب ثٝ ؾيؿشٓ ٚاحس ٞبي ثط٘بٔٝ ايبفٝ قسٜ اؾز. ايٗ   Drilling Office  ٚلشي 
س زض قىُ ظيط ثجيٙيس. اِجشٝ ثطاي زيسٖ ايٗ نفحٝ زض ؾيؿشٓ ذٛز ثبيس وٕي نجط وٙيس سب آٔٛظـ ايٗ لؿٕز اظ ثط٘بٔٝ ذبسٕٝ يبثس. ٔٛيٛع ضا ٔي سٛا٘ي

www.Ir آٍ٘بٜ قٕب ضا ثب دٙدطٜ ظيط آقٙب ذٛاٞٓ وطز.
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 DataBrowserآموزش 

 ٕ٘بيي وّي:

  آٔٛظـ ٔجب٘يٍ٘بٞي اخٕبِي ثط 

  ٖثبظ وطزDataBrowser ٔ ؼَٕٛ اَلاػبرٚ سٙظيٓ يه ٔؿيط 

 ( ٖايدبز يه ٔيساField) 

  ٓا٘شربة يه ؾيؿش( ٔرشمCoordinate System) 

  ا٘شربة وطزٖ يهStructure 

  ٚاضز وطزٖ يهSlot 

  اؾشفبزٜ وطزٖ اظSlot Wizard 

 ٜايبفٝ وطزٖ يه چب 

 ٜايبفٝ وطزٖ يه حفطٜ چب 

 اؾشفبزٜ وطزٖ اظ ASCII Loader  

 ايدبز اٞساف 

 ٜاذشهبل اٞساف ثٝ حفطٜ چب 

 ٚاضز وطزٖ ٚ ذبضج وطزٖ اَلاػبر 

 

 : آٔٛظـ ٔجب٘يٍ٘بٞي اخٕبِي ثط 

، ثٝ نٛضر ٔسِي ؾّؿّٝ ٔطاسجي اظ اخعاء ٚ فؼبِيز ٞبي حفبضي ؾبذشٝ  قسٜ ا٘س.  Drilling Office ٔدٕٛػٝ ٘طْ افعاض ٞبي حفبضي وبضثطزي 

DataBrowser  حفبضي ضا ايدبز ٚ ٔسيطيز ٕ٘بييس.ايٗ أىبٖ ضا ثطاي قٕب ٔيؿط ٔي وٙس وٝ ايٗ اخعا ٚ فؼبِيز ٞبي 
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ايٗ دبيٍبٜ زازٜ ٕٞبٖ ظٔب٘ي ايدبز ٔي قٛز شذيطٜ ٔي قٛز.  GeoFrameزض دبيٍبٜ زازٜ اي ثٝ ٘بْ  Drilling Officeاَلاػبر ايدبز قسٜ سٛؾٍ 

 ضا ثط ضٚي ؾيؿشٓ ذٛز ٘هت ٔي وٙيس. Drilling Officeوٝ قٕب 

DataBrowser  ْوبض ٞبي شيُ يبضي ٔي ٕ٘بيس:اثعاض اؾز وٝ قٕب ضا زض ا٘دب 

  ؾّؿّٝ ٔطاست اَلاػبر ايدبزDrilling Office 

  ٓٔرشما٘شربة ؾيؿش 

 ٚاضز وطزٖ اَلاػبر ٞسف 

 ٖٔبضن وطز survey- ٞب ثٝ ػٙٛاٖ ٔٛاضز لُؼي 

 خؿشدٛ زض اَلاػبر 

 ٚاضز وطزٖ ٚ ذبضج وطزٖ اَلاػبر 

 ٚ سٙظيٓ يه ٔؿيط ٔؼَٕٛ اَلاػبر DataBrowserثبظوطزٖ  – 1ثرف

 Projectضا ا٘شربة وٙيس. دٙدطٜ  Schlumberger > Drilling Office > DataBrowserٔؿيط  Startٔٙٛي  اظ .1

Login  .ٕ٘بيف زازٜ ٔي قٛز 

 

 يه ٘ٛاض آثي ضً٘ ذبِي ذٛاٞيس زيس. Usernameاٌط ايٗ اِٚيٗ ثبضي اؾز وٝ ثط٘بٔٝ ضا ثبظ ٔي وٙيس زض لؿٕز ٘ىشٝ : 

ايٗ وّٕٝ وبضثطي ثبيس وّيه وطزٜ ٚ وّٕٝ وبضثطي ذٛز ضا ا٘شربة وٙيس. Username ، فيّسؾز ثط ضٚي زوٕٝ خٟز زاض ، زض ؾٕز ضا .2
 ثٝ َٛض اسٛٔبسيه زض ظٔبٖ ٘هت ايدبز قسٜ ثبقس. 
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، وّٕٝ وبضثطي ثٝ قٕب ٕ٘بيف زازٜ ٕ٘ي قٛز ثبيس ثسا٘يس وٝ احشٕبلا ذُبي زض ٔطاحُ ٘هت قٕب ضخ زازٜ وٝ  Username٘ىشٝ: اٌط زض لؿٕز 
  ػسْ ٘هت دبيٍبٜ زازٜ ثط٘بٔٝ ٔي ثبقس. ِصا ثبيس ايٗ ٔٛضز ثطضؾي قٛز.ٔؼٕٛلا
 . آٖ ٘بْ وبضثطي  ُٔؼّك ثٝ آٖ دطٚغٜ ذٛاٞس ثٛز.ٔي قٛيس loggingديف فطو،  ٘بْ وبضثطيٚلشي ثب اؾشفبزٜ اظ ٘ىشٝ: 

. زض ٔٛلؼيز ديف فطو وٝ اؾٓ ٔي ثبقس ، ٘ٝ ٘بْ وبضثطي٘ىشٝ: وّٕٝ ػجٛضي وٝ قٕب اظ آٖ ثطاي ٚضٚز ثٝ ثط٘بٔٝ اؾشفبزٜ ٔي وٙيس وّٕٝ ػجٛض دطٚغٜ 
 ٔي ثبقس. proj1وّٕٝ ػجٛض ٘يع ٔي ثبقس  proj1دطٚغٜ ثٝ َٛض اسٛٔبسيه

 ثط ضٚي زوٕٝ  ٚ ٚاضز وطزٜ ضا ٔي ثبقس proj1وٝ زض ايٙدب  ، وّٕٝ ػجٛض .3

 وّيه ٕ٘بييس. 

ثط ضٚي ؾيؿشٓ ذٛز اخطا ٔي وٙيس وبزض ٟٔبٚضٜ اي ظيط ٕ٘بيف زازٜ ذٛاٞس  ضا Drilling Officeاٌط ايٗ اِٚيٗ ثبضي اؾز وٝ يىي اظ ثط٘بٔٝ ٞبي 
 قس. وٝ قٕب ضا اظ ػسْ سٙظيٓ ٔؿيط ٔؼَٕٛ اَلاػبر آٌبٜ ٔي ؾبظز.

 

وّيه وٙيس. وبزض ٟٔبٚضٜ اي ظيط ظبٞط ذٛاٞس قس وٝ ثٝ ٚاؾُٝ آٖ قٕب ٔدبظ ذٛاٞيس ثٛز سب ٔؿيطي ثطاي شذيطٜ  OKثط ضٚي زوٕٝ  .4
ٕٞٝ  ٍثطاي اخطا وبضثط/ ؾطٚض،  ا٘شربة يه ٘بحيٝ ٔٙبؾت أطي اؾز يطٚضي چطا وٝ ٘بحيٝ ا٘شربثي ثبيس سٛؾ ة وٙيس.اَلاػبر ا٘شرب

 لبثُ زؾشطؾي ثبقس. وبضثطاٖ

 

فٛق اظ . قٕب ٔي سٛا٘يس ٕٞب٘ٙس قىُ ايدبز قسٜ اؾز ثطاي قٕب ٔؼِٕٛي ؾبذشبض زايطوشٛضي ثٝ ٔٙظٛض شذيطٜ آيشٓ ٞبي اَلاػبسيزض َي ٔطاحُ ٘هت، 

وّيه ٕ٘بييس. ٚ يب ثؿشٝ ثٝ ٘يبظ ٞب ٚيػٜ ذٛز دٛقٝ زيٍطي ضا ا٘شربة وٙيس. ثطاي سٙظيٓ وبضثط  OKحبِز ديف فطو اؾشفبزٜ وطزٜ ٚ سٟٙب ثط ضٚي زوٕٝ 
ثطاٖ اظ آٖ ثطاي ٔي سٛا٘يس زايطوشٛضي ضا ثطٌعيٙيس وٝ ٕٞٝ وبض قٕبزض ايٗ ٔيبٖ يب ؾطٚض ، ؾطٚض ثبيس ٕٞبٍ٘ٛ٘ٝ وٝ زض ثبلا ثيبٖ قس ٘هت قٛز 
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زض  ٕ٘بيف زازٜ ٔي قٛز Preferencesوّيه وٙيس دٙدطٜ  Preferences، ثط ضٚي ٌعيٙٝ  Optionsاؾشفبزٜ ٔي وٙٙس.اظ ٔٙٛي  اَلاػبسكبٖ

 وّيه وٙيس. ٚ ثب اؾشفبزٜ اظ زوٕٝ Common Data Pathايٗ دٙدطٜ ثط ضٚي ظثب٘ٝ 

 دٛقٝ اَلاػبر ٔٛضز ٘ظطسبٖ ضا ا٘شربة ٕ٘بييس.

قٕب سٟٙب قبُٔ ٘بْ فطزي اؾز وٝ دبيٍبٜ زازٜ ضا ايدبز  Usernameٔي قٛيس ، ِيؿز  DataBrowserاٌط اِٚيٗ ثبضي اؾز وٝ ٚاضز سٛخٝ: 
 ثٝ قٕب ٘حٜٛ ايبفٝ وطزٖ وبضثطاٖ خسيس ثٝ دطٚغٜ آٔٛظـ زازٜ ذٛاٞس قس.  User Managerوطزٜ اؾز. زض ثرف 

 ُٔبثك سهٛيط ظيط ٕ٘بيف زازٜ ٔي قٛز. DataBrowserثؼس اظ آ٘ىٝ ٚاضز ثط٘بٔٝ قسيس ، دٙدطٜ انّي 

 

 چؿجٙسٖاثعاضٞبي ثطاي وذي وطزٖ ، ثطيسٖ ٚ ٔي ثبقس. وٝ  standard Editزض ظيط ٘ٛاض ٔٙٛ ، ؾٝ ٘ٛاض اثعاض ٚخٛز زاضز . اِٚيٗ ٘ٛاض اثعاض ، ٘ٛاض اثعاض  
ٞب زؾشطؾي زاقشٝ ثبقيس. ٘ٛاض اثعاض زْٚ قبُٔ ِيؿز ؾيؿشٓ ٚاحس ٔي ثبقس. زض   ٘يع ثٝ ايٗ اثعاض Edit. ٔي سٛا٘يس اظ ٔٙٛي  زض اذشيبض وبضثط لطاض ٔي زٞس

ثب وّيه ثط  وٝ ذٛاؾشيس سٟٙب ٞط ظٔبٖز ؾيؿشٓ ٚاحس ٔٛضز ٘ظط ذٛز ضا ا٘شربة قسٜ اؾز أب قٕب لبزض ذٛاٞيس ثٛ Englishسهٛيط فٛق ؾيؿشٓ ٚاحس 
 ضٚي ِيؿز وكٛيي ا٘شربة وٙيس.

 قطح زازٜ قسٜ اؾز. Using the Project Managerاثعاض ؾيؿشٓ ٚاحس زض لؿٕز ٘ىشٝ: ٘حٜٛ سغييط زض ٘ٛاض 

ٔي ثبقس. ثطاي آ٘ىٝ زضيبثيس ٞط آيىٖٛ چٝ وبضثطزي زاضز وبفيؿز ثب ٘كبٍ٘ط ٔٛؼ ذٛز ِحظٝ اي ثط  Application Launcherآذطيٗ ٘ٛاض اثعاض 
٘يع لبثُ زؾز ضؾي  Launchٔٙٛي ثٝ قٕب ٕ٘بيف زازٜ قٛز. ايٗ ثط٘بٔٝ ٞب اظ ٔجٙي ثط ٘بْ وبضثطي آٖ آيىٗ  يضٚي آٖ آيىٗ زضً٘ فطٔبييس سب ديبٔ

 ٔي ثبقٙس.

قسٜ ٚ ثط ضٚي ػٙٛاٖ ٘ٛاض ٔٛضز ٘ظط  view٘ىشٝ : اٌط ٞط وساْ اظ ٘ٛاض اثعاض ٞبي ثحث قسٜ ثطاي قٕب لبثُ ضٚيز ٕ٘ي ثبقٙس وبفيؿز ٚاضز ٔٙٛي 
 ٘ٛاض اثعاض ٔٛضز ٘ظط ذٛز ضا ثطزاضيس.ىؽ ايٗ ػُٕ قٕب لبزض ذٛاٞيس ثٛز ٝ ثب ا٘دبْ ػوّيه وٙيس سب آٖ ٘ٛاض اثعاض ظبٞط قٛز. ثسيٟي اؾز و
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. ايٗ دٙدطٜ زض وٝ آيىٗ دبيٍبٜ زازٜ ٞبي دطٚغٜ ضا ٘كبٖ ٔي زٞسآذطيٗ آيشٕي وٝ زاضاي إٞيز فطاٚا٘ي ٔي ثبقس ثرف دٙدطٜ انّي ثط٘بٔٝ ٔي ثبقس 
 ٞبي دطٚغٜ يشبٖ ضا ايدبز ذٛاٞيس وطز. ٚالغ ٕٞبٖ لؿٕشي اؾز وٝ قٕب ؾبذشبض دبيٍبٜ زازٜ

 ضا ثبظ وطزٜ ايس، ذٛز ضا ثطاي ايدبز ؾبذشبض اَلاػبسشبٖ آٔبزٜ وٙيس. DataBrowserاوٖٙٛ وٝ  

 ايدبز يه ٔيساٖ -2ثرف 

 ثب ٘حٜٛ ايدبز وطزٖ يه ٔيساٖ زض دبيٍبٜ زازٜ آقٙب ٔي قٛيس.، زض ايٗ زضؼ

 وّيه وٙيس. ضفشٝ ٚ ضاؾز Project Databaseثط ضٚي آيىٖٛ  .1

 

ثٝ قٕب ٕ٘بيف زازٜ ٔي قٛز. ثطاي    Refresh, Insert Field, Export Data  ٚImport Dataٔٙٛيي قبُٔ ٌعيٙٝ ٞبي  .2
 وّيه وٙيس سب دٙدطٜ ظيط ظبٞط قٛز. Insert Fieldٚاضز وطزٖ ٔيساٖ ثط ضٚي ٌعيٙٝ 

 آٟ٘ب ضا دبن وٙيس. deleteضز ثب ا٘شربة ٔشٗ ٚ فكطزٖ وّيس ٚخٛز زا text field  ،Name٘ىشٝ : اٌط اَلاػبسي ثٝ نٛضر ديف فطو زض 
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 ضا سبيخ وٙيس. Zeusوّٕٝ  Nameزض لؿٕز  .3

 ضا ا٘شربة وٙيس. Western Europeاظ ِيؿز وكٛيي  Regionزض لؿٕز  .4

5. Time Zone ا سغييط زٞيس.ثٝ َٛض ديف فطو ٕٞبٖ ٘بحيٝ ظٔب٘ي وبٔذيٛسط قٕب ضا ا٘شربة ٔي وٙس وٝ زض نٛضر ٘يبظ ٔي سٛا٘يس آٖ ض 

 ذٛاٞيس زاقز ٔرشهبرزض ازأٝ قٕب ٘يبظ ثٝ ا٘شربة يه ؾيؿشٓ  .6

 ٔرشهبرا٘شربة يه ؾيؿشٓ  -3ثرف 

 ثطاي ٔيسا٘شبٖ ا٘شربة ٕ٘بييس. ٔرشهبرزض ايٗ زضؼ ثٝ قٕب آٔٛظـ زازٜ ٔي قٛز وٝ چٍٛ٘ٝ يه ؾيؿشٓ 

ٕ٘بيف زازٜ ٔي  Select Coordinate Systemوّيه وٙيس. دٙدطٜ  Coordinate Systemثط ضٚي زوٕٝ خؿشدٛي  .1
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 < Europeثب وّيه ثط ضٚي ٕ٘بز + ٔي سٛا٘يس قبذٝ ٔطثٌٛ ثٝ آٖ ضا ثبظ وٙيس. حبَ ثبسٛخٝ ثٝ ٘ىشٝ ثيبٖ قسٜ ٚاضز ٔؿيط ظيط قٛيس  .2

North Sea > UTM Zone 31 on ED50 Datum  ٕٝؾذؽ زوOK .ٕ٘بييس 

 N 61 24 "يط ٔمبز Latitudeثطاي لؿٕز  Geodeticؾشٖٛ  زض اثشسا Reference Pointاَلاػبر ثطا ٚاضز وطزٖ  .3

ضا ثفكبضيس سب ٔمبزيط ٔشٙبظط ثب  Tabضا ٚاضز ٕ٘بييس . وّيس  ." E 2 26 23.492 "ٔمبزيط   Longitudeٚ ثطاي لؿٕز  " 12.763

Northing  ،Easting  ،Scale Factor   ٚGrid Convergence قٛ٘س. اٌط سٟٙب  ثطاي ٔٛلؼيز ا٘شربثي قٕب ثٝ ضٚظ ضؾب٘ي
 ثيٗ زٚ ٘مُٝ( سطيٗ ٔؿيط وٛسبٜ ذٍ اِمهط) ضا زض اذشيبض زاقشيس دؽ اظ ٚاضز وطزٖ آٟ٘ب ثط٘بٔٝ Northing  ٚEastingاَلاػبر 
 ضا ا٘شربة ذٛاٞس وطز. ٔرشهبر

 ٘ىشٝ:

 Scale Factor ُٔٛضز ٘ظط ٔي ثبقس.: ٘ؿجز فبنّٝ ا٘ساظٜ ٌيطي قسٜ ضٚي ٘مكٝ ثٝ فبنّٝ ا٘ساظٜ ٌيطي قسٜ ضٚي ظٔيٗ زض ٔح 

Grid Convergence.ثٝ اذشلاف ظاٚيٝ ثيٗ قٕبَ حميمي ثٝ قٕبَ قجىٝ زض يه ٔٙظمٝ ٌفشٝ ٔي قٛز : 

ضا ا٘شربة وٙيس. زض ٚالغ ثب ايٗ وبض قٕب ؾُح ٔجٙبي ٔيساٖ ذٛز ضا  MSL ٌعيٙٝ Elevation Nameاظ ِيؿز ٔٛخٛز زض لؿٕز  .4

 طزٜ ايس.( ا٘شربة و Mean Sea Levelؾُح زضيب )  ٔشٛؾٍ
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 وّيه وٙيس. OKثط ضٚي زوٕٝ  .5

 ٚاضز وطزٖ يه ؾبذشبض -4ثرف 

 .ٔي قٛزؾبذشبض ثطاي يه ٔيساٖ آٔٛظـ زازٜ ٘حٜٛ ايدبز ثٝ قٕب  ،زض ايٗ زضؼ

ٔي ثبقس. ثطاي ايٗ  Englishلجُ اظ ايٙىٝ قطٚع ثٝ ٚاضز وطزٖ اَلاػبر، ثطاي ايٗ ؾبذشبض وٙيس. ُٕٔئٗ قٛيس وٝ ؾيؿشٓ ٚاحس قٕب  .1

 ضا اظ ِيؿز ا٘شربة وٙيس. Englishوّيه وطزٜ ٚ  unit systemثط ضٚي ٘ٛاض اثعاض  ٔٙظٛض

ؾبذشبض ) يب ؾىٛ ( ثٝ ضٚقي ٔكبثٝ، ضٚـ ٔيساٖ ايدبز ٔي قٛز. ثٝ لؿٕشي ثطٚيس وٝ ديف سط آٖ ضا زض دبيٍبٜ زازٜ ٞبيشبٖ ايدبز وطزيس  .2

 بيف زازٜ قسٜ ا٘شربة ٕ٘بييس.ضا اظ ٔيب٘جط ٕ٘ Insert Structureؾذؽ ضٚي آٖ وّيه ضاؾز وٙيس. 
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 ظبٞط ٔي قٛز. Insert Structureدٙدطٜ 
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لطاض ٌطفشٝ اؾز. ػلاٜٚ ثط ايٗ ديىبٖ لطٔع ضً٘ ثٝ َٛض ديف فطو ٔمبزيطي وٝ ديف سط ثطاي آٟ٘ب ٚاضز وطزٜ ايس  geodetic  ٚgrid زض ٘ىشٝ :

. اٌط ٔٛلؼيز اقبضٜ زاضز Local Cartesianثٝ ٔرشهبر   ، ديىبٖ لطٔع ضً٘ٔجيٗ چٍٍٛ٘ي شذيطٜ ٔرشهبر زض دبيٍبٜ زازٜ ٔي ثبقس. زض سهٛيط ثبلا
 Gridيب   Geodetic اٌط ديىبٖ لطٔع ضً٘ ثٝ ؾٕز ٔرشهبر ُّٔك٘مُٝ ٔطخغ ٔيساٖ سغييط وٙس زض آٖ نٛضر ؾبذشبض ٘يع ثب آٖ خبثٝ خب ٔي قٛز. 

 ٔي ٔب٘س.٘كب٘ٝ ضفشٝ ثبقس ٚ ٘مُٝ ٔطخغ ٔيساٖ سغييط وٙس، ؾبذشبض ثبثز ثبلي 

يب  Plan to  ،Slotديىبٖ لطٔع ضً٘ زض ٔمبثُ ٞط زؾشٝ اي وٝ آٖ ضا ٚاضزوطزٜ ايس لطاض ٔي ٌيطز، ٘ؿجي يب ُّٔك. ٕٞچٙيٗ ٔي سٛا٘يس 
Structure  ضا ا٘شربة وٙيس. ثطاي ايٗ سٕطيٗ اخبظٜ زٞيسPlan to  ثط ضٚيSlot .ثبلي ثٕب٘س 

يب ثٝ نٛضر ٔرشهبر  Gridيب  Geodetic (Lat./Long.)بر ُّٔك ثب ٚاضز وطزٖ ٔرشهبر ٞٓ اوٖٙٛ ٔي سٛا٘يس ٔٛلؼيز ؾبذشبض ضا زض ٔرشه

ثطاي ضاحشي ثيكشط اخبظٜ زٞيس وٝ فطو  سؼطيف ٕ٘بييس. Local Polarيب  Local Cartesian٘ؿجز ثٝ ٘مُٝ ٔطخغ ٔيساٖ ثب ٚاضز وطزٖ ٔرشهبر 
سبٖ ٚاضز ٘ىٙيس ٚ  localطاض ٔي ٌيطز. زض چٙيٗ حبِشي ٞيچ ٔمساضي ضا ثطاي ٔرشهبر وٙيٓ ؾبذشبضٔبٖ زض ٔٛلؼيز ٔكبثٝ ٕٞب٘ٙس ٘مُٝ  ٔطخغ ٔيساٖ ل

 ٕٞبٖ َٛض وٝ ٞؿشٙس ضٞب وٙيس. Lat/Long  ٚGridٔرشهبر ٞبي 

 .A. Structureي ثطاي ؾبذشبض ذٛز سبيخ وٙيس ٔثلا ػٙٛا٘ Nameزض لؿٕز  .3

 .Schlumberger ثبيس ٘بْ ٔكشط يب اضثبة ضخٛع ضا سبيخ وٙيس ٔثلا Clientزض لؿٕز  .4
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 ثطاثط نفط زض ٘ظط ٌطفشٝ قسٜ اؾز. Radiusثٝ َٛض ديف فطو ٔمساض  Surface Uncertaintyثرف زض  .5

،  text field ثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز Default Survey Tool Error Modelثطاي سؼيييٗ ثرف  .6
Model Name  وّيه وطزٜ ٚ اظ ِيؿز وكٛييSLB ISCWSA ييس.ضا ا٘شربة ٕ٘ب 

ضا  Platform Elevationثط ضٚي زوٕٝ خٟز زاض وّيه وٙيس ؾذؽ  text field ، Elevation Name زض ؾٕز ضاؾز .7
 ضا سبيخ وٙيس. 122ٔمبزض  .ft relative to MSLا٘شربة وٙيس ٚ زض لؿٕز 

 سبيخ وٙيس. ft relative to MSLضا ثطاي  -112ٔمساض  Sea Bed/Ground Levelزض لؿٕز  .8

 قٕب ثبيس ثٝ نٛضر ظيط ثبقس. Insert Structureدطٜ ٞٓ اوٖٙٛ دٙ

 

ا٘شربة وٙيس. ظٔب٘ي وٝ يىي اظ ايٗ زٚ ضا ا٘شربة ٔي  True Northيب  Grid Northضا ثٝ نٛضر  Azimuth Reference٘ىشٝ: ٔي سٛا٘يس 
 ٔي ثبقس.  Grid Northزض حبِز ديف فطو ايٗ لؿٕز  وٙيس وّيٝ ٔمبزيطي سحز ايٗ ؾبذشبض ثٝ لؿٕز قٕبَ ا٘شربة قسٜ اضخبع زازٜ ذٛاٞس قس.

 وّيه وٙيس. OKثط ضٚي زوٕٝ  .9

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   37 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 Slotٚاضز وطزٖ يه  -5ثرف

 ثطاي ؾبذشبضسبٖ ثٝ قٕب آٔٛظـ زازٜ ٔي قٛز. Slotزض ايٗ زضؼ ٘حٜٛ ايدبز يه 

 ضا ا٘شربة وٙيس. Edit Structure/Slotsضٚي ؾبذشبضي وٝ ؾبذشيس ضفشٝ ٚ ضٚي آٖ ضاؾز وّيه وٙيس .ؾذؽ ثط  .1

 

 ُٔبثك سهٛيط ظيط ظبٞط ٔي قٛز. Slotsوّيه وٙيس. دٙدطٜ  Slotsزض دٙدطٜ ظبٞط قسٜ ضٚي ظثب٘ٝ  .2
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 ٕ٘بيف زازٜ ٔي قٛز. Insert Slotوّيه وٙيس. دٙدطٜ  Newثط ضٚي  .3
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 ضا سبيخ ٕ٘بييس. Slot #1ػٙٛاٖ  Nameزض لؿٕز  .4

ضٚي زوٕٝ خٟز زاض وّيه   Referenceزض لؿٕز زٞيٓ. ضا ثب اؾشفبزٜ اظ ٔرشهبر ٔحّي ٘ؿجز ثٝ ٔيساٖ لطاض ٔي  Slotٔٛلؼيز  .5

 ضا اظ ِيؿز ثبظ قسٜ ا٘شربة ٕ٘بييس. Fieldوٙيس ٚ ٌعيٙٝ  

 referenceاظ  local Cartesianثٝ ػٙٛاٖ يبٔٙي ثطاي ٕ٘بيف زازٖ سغييط ٘مُٝ ٔرشهبر  reference٘ىشٝ : ا٘شربة 
ثٙبثطايٗ ٕٞيكٝ زض ؾبذشبض قٕب ثبلي ٔي ٔب٘ٙس سب ظٔب٘ي وٝ ثٝ ايٗ ي قٛ٘س اَلاػبر شذيطٜ ٕ٘ ثب ايٗ سٙظيٕبر ٕٞطاٜ ز.قٛٔي اؾشفبزٜ 

 دٙدطٜ ثطٌطزيس.

 ٔٙسضج ٌطزيسٜ اؾز. N 0 ft   ٚE 0 ft ثٝ َٛض ديف فطو Local Cartesianزض لؿٕز ٞبي ٔطثٌٛ ثٝ ٔرشهبر  .6

ا٘شربة قسٜ  0ٞط زٚ  Distance  ٚAzimuthثٝ َٛض ديف فطو ثطاي  Local Polarزض  لؿٕز ٞبي ٔطثٌٛ ثٝ ٔرشهبر  .7

 ضا فكبض زٞيس. Tabوّيس  اؾز.

ا٘شربة قسٜ اؾز اخبظٜ زٞيس ٕٞيٗ ٔمساض ضا حفظ وٙس. وّيس  0قؼبع ثٝ َٛض ديكفطو ،  Surface Uncertaintyزض لؿٕز  .8

Tab .ضا فكبض زٞيس 

ضا  Top of Slotز وّيه وٙيس. اظ ِيؿ  text fieldثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز  Elevation Nameزض لؿٕز  .9
 ا٘شربة ٕ٘بييس.

ثطاي ايٗ لؿٕز سبيخ وطزٜ ٚ  ft 115-ثطٚيس. ٔمساض  Relative to Platform Elevationثٝ لؿٕز  Tabثب اؾشفبزٜ اظ وّيس  .12
 ضا فكبض زٞيس. Tabوّيس 

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   42 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

 وّيه فطٔبييس. OKثطاي لجَٛ ٔٛاضز فٛق ثط ضٚي زوٕٝ  .11

 بثك اَلاػبر خسَٚ ظيط سىطاض وٙيس. ايبفٝ ، ُٔ slots 19ضا ثطاي  11سب  1ٔطاحُ  .12

 ٞبي ذبِي ثٝ ٔٙظٛض َطاحي زض ظٔب٘ي اؾز وٝ ثيكشط ثب ٘طْ افعاض آقٙب قسٜ ايس. -slot٘ىشٝ: ثيكشط 

ft relative to MSL Elevation Name Local East Local North Slot Name 
5.00 Top of Slot 0.00 0.00 Slot #1 
5.00 Top of Slot 5.28 5.28 Slot #2 
5.00 Top of Slot 10.57 10.57 Slot #3 
5.00 Top of Slot 15.85 15.85 Slot #4 
5.00 Top of Slot -5.28 5.28 Slot #5 
5.00 Top of Slot 0.00 10.57 Slot #6 
5.00 Top of Slot 5.28 15.85 Slot #7 
5.00 Top of Slot 10.57 21.13 Slot #8 
5.00 Top of Slot -10.57 10.57 Slot #9 
5.00 Top of Slot -5.28 15.85 Slot #10 
5.00 Top of Slot 0.00 21.13 Slot #11 
5.00 Top of Slot 5.28 26.42 Slot #12 
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5.00 Top of Slot -15.85 15.85 Slot #13 
5.00 Top of Slot -10.57 21.13 Slot #14 
5.00 Top of Slot -5.28 26.42 Slot #15 
5.00 Top of Slot 0.00 31.70 Slot #16 
5.00 Top of Slot -21.13 21.13 Slot #17 
5.00 Top of Slot -15.85 26.42 Slot #18 
5.00 Top of Slot -10.57 31.70 Slot #19 
5.00 Top of Slot -5.28 36.98 Slot #20 

 

  Slot Wizardاؾشفبزٜ اظ  -6ثرف 

ايٗ ٚيػٌي أىبٖ  فطاٞٓ ٔي ٕ٘بييس. ثطاي وبضثط ٞبي حفبضي ؾبذشبضٞب -Slotٔٙبؾجي ثٝ ٔٙظٛض وبض ثب  ٚاؾُٝ Slot Wizardايٗ ٚيػٌي خسيس 

 ٞب ثب ثٟطٜ ٌيطي اظ اٍِٛٞبي ٔؿشُيّي يب زايطٜ اي ضا ثطاي وبضثط ٔيؿط ٔي ؾبظز. -Slotَطاحي ٚ ايبفٝ وطزٖ 

 ضاؾز وّيه وٙيس. DataBrowserثط ضٚي ؾبذشبض ٔٛخٛز زض قبذٝ ، Slot Wizardثطاي قطٚع وبض ثب   .1

2. Edit Structure/Slots .ضا ا٘شربة ٕ٘بييس 

 ضا ا٘شربة ٕ٘بييس. Slotsظثب٘ٝ  .3
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 ٕ٘بيف زازٜ قٛز. Slot Wizardوّيه وٙيس سب دٙدطٜ  Wizardثط ضٚي زوٕٝ  .4

 

 وٙٛ٘ي  Slotٔكبٞسٜ آضايف )َطح ثٙسي( 

Slot Wizard  ٘كبٖ زٞٙسٜ آضايفSlot خ ثبلاي دٙدطٜ، ٔٛخٛز ٔي ثبقس. زض ٌٛقٝ چSlot Layout chart  ٝٚخٛز زاضز. وSlot  ٞبي
 وطٜ ثطاق ضٚي ٕ٘ٛزاض ٘كبٖ زازٜ ٔي قٛز. ثٝ ػٙٛأٖٛخٛز  Slotيه ؾبذشبض ضا ٘كبٖ ٔي زٞس. ٞط  localٔٛخٛز زض ؾيؿشٓ ٔرشهبر 

يٗ ٕ٘ٛزاض ٘كبٖ زٞٙسٜ ػطو ٚ اضسفبع ثيبٖ قسٜ اػساز ٘ٛقشٝ قسٜ ثط ضٚي ا ٔكرم ٔي قٛز.  ،ضٚي وطٜ  ظضز ضً٘ Xٔطخغ ثب ػلأز  slot:  ٘ىشٝ 
 زض ٚاحس ٞبي اظ ؾيؿشٓ ٔرشهبر ٔحّي ٔي ثبقٙس.

 

 ٞب ٘كبٖ زازٜ قسٜ ا٘س. - Slotلطاض زاضز وٝ زض ايٗ خسَٚ سه سه   Slot Datasheetييٗ دٙدطٜ انّي ، بزض د

ضا زض  Slotبي ديىبٖ زاض ويجٛض اؾشفبزٜ وٙيس. ٕٞچٙيٗ ٔي سٛا٘يس يه ٔي سٛا٘يس اظ وّيس ضاؾز ٔٛؼ يب وّيس ٞ Slotثطاي ا٘شربة ؾَّٛ ٔطثٌٛ ثٝ ٞط 

ٕٞچٙيٗ ٔي ثبقس. ٔٛضز ٘ظط  Slotٔٛلؼيز ٔطثؼي ضٚي آٖ ٕ٘بيف زازٜ ٔي قٛز وٝ ٔكرم وٙٙسٜ  خسَٚ ا٘شربة وطزٜ ٚ ثب وّيه ثط ضٚي ٕ٘ٛزاض 
 س.ٔي سٛا٘يس ؾَّٛ ٔطثٌٛ ثٝ آٖ ضا ٔكرم ٕ٘بيي Slotثب وّيه وطزٖ ثط ضٚي ٞط 

زض ٔٛخٛز زض نفحٝ اؾشفبزٜ وٙيس ٚ يب نفحٝ ضا ثٝ ا٘ساظٜ ٔٛضز ٘ظط ذٛز ثعضي ٕ٘بييس.  scrollٔي سٛا٘يس اظ  Slot Datasheet وبُٔ ثطاي ٔكبٞسٜ

ٔٙسضج ٌطزيسٜ وٝ ثب وّيه ثط ضٚي ٞطيه سٕبٔي ٔٛاضز Reference , New , Existing , Planned   ٚ Deletedظيط ٕ٘ٛزاض ٕ٘بز ٞبي اظ 
 وّيه وٙيس. Existingٞب لاظْ اؾز سب ثط ضٚي  Slotثطاي ا٘شربة ٕٞٝ ثٝ آٖ ٕ٘بز زض قىُ ا٘شربة ٔي ٌطزز. ثٝ ػٙٛاٖ ٔثبَ ٔكب
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 وبض ثب ؾيؿشٓ ٞبي ٔرشهبر

وكٛيي  ِيؿز ثب اؾشفبزٜ اظ وٙشطَ ٞبي ٔٛخٛز زض ؾٕز ضاؾز ٕ٘ٛزاض، ٔرشهبر ؾيؿشٓ ضا سغييط زٞيس. Slot Wizardزض دٙدطٜ  ٔي سٛا٘يسقٕب 
Coordinates  ٖثٝ قٕب ضا لبزض ٔي ؾبظز اظ ٔيبGeodetic, Grid, Local Cartesian  ٚLocal Polar .ٕٞچٙيٗ  يىي ضا ا٘شربة وٙيس

Azimuth Reference  ٘يع ا٘شربة ٞبيGrid North  يبTrue North .ؾُح ٔجٙب ضا ٔي سٛا٘يس اظ ِيؿز  زض اذشيبض قٕب لطاض ٔي زٞس
ا٘شربة ٕ٘بييس.ثب سغييط ٞط وساْ اظ دبضأشط ٞبي  Sea bed/Ground level يب   ,Relative to  ،MSL, Platform Elevationوكٛيي 

 ضا ثٝ ضٚظ ضؾب٘ي ٔي وٙٙس.  Data sheet Slotثٝ َٛض اسٛٔبسيه  Wizardفٛق 

 ثبقس.خٛز زض ٔرشهبر ٔحّي ٔي ٕٞيكٝ ٘كبٖ زٞٙسٜ اَلاػبر ٔٛ Slot Chartچطا وٝ   ٘جبيس زازٜ قٛزسغييطي  Slot Chart٘ىشٝ: زض 

  Slotسغييط اَلاػبر 

 ا٘شربة ٕ٘بييس.ضا ثب وّيه  ٔٛؼ يب اؾشفبزٜ اظ وّيس ٞبي خٟز زاض خؼجٝ وّيسسبٖ  Nameؾَّٛ ٔطثٌٛ ثٝ  Data sheet Slotزض  .1

 ط وّيه ٕ٘بييس.ضا ثفكبضيس يب ثط ضٚي ؾِّٛي زيٍ Enterٔٛضز ٘ظط ا٘شربة ٕ٘بييس ٚ زوٕٝ  Slotحبَ يه ٘بْ زيٍط ضا ثطاي  .2

 Individual Slotايبفٝ وطزٖ 

 اػٕبَ وٙيس. Slot Wizardوّيه وٙيس لاظْ اؾز سٙظيٕبر ظيط ضا ثط ضٚي وٙشطَ ٞبي  Add one slot٘ىشٝ: لجُ اظ ايٙىٝ ثطضٚي زوٕٝ 

 ا٘شربة ٕ٘بييس.  Coordinatesلؿٕز  اظضا  Reference point location  ،Local Cartesianزض ثرف  .1

 ا٘شربة ٕ٘بييس. Azimuth Rel  ،Grid Northزضلؿٕز  .2

ضا ثطاي 122سٙظيٓ وطزٜ ؾذؽ ٔمساض  MSLضا ثط ضٚي  Relative toٚ  لؿٕز  Top of Slotضا ثط ضٚي  Nameلؿٕز  .3

Elevation .ٔٙظٛض فطٔبييس 
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دبز قسٜ زض ؾيؿشٓ يٞبي ا Slotٞبي خسيسي وٝ ايدبز قٛ٘س اذشهبل زازٜ ٔي قٛز.  -slot٘ىشٝ: ايٗ ؾيؿشٓ ٔرشهبر ثٝ سٕبٔي 

  Grid( ظٔب٘ي وٝ ٔٛلؼيز ؾبذشبض سغييط يبثس ، سغييط ذٛاٞٙس وطز. ؾيؿشٓ ٞبي ٔرشهبر structure) ؾبذشبضٔرشهبر ٔحّي ، يه 
 ٚgeodetic  ٔٛلؼيز زائٕي ثطايslot .ٞبيشبٖ ايدبز ٔي وٙس 

ضا اظ  tabي آٖ ٚاضز ٕ٘بييس ؾذؽ وّيس ضا ثطا 32ضفشٝ ٔمساض  Northing، ثٝ لؿٕز  Reference Point Locationزض ثرف  .4
ضٚي خؼجٝ وّيس ذٛز ثفكبضيس ٚ يب ذبضج لؿٕز ٘ٛقشبضي وّيه ٕ٘بييس ، ؾبػز قٙي ثٝ قٕب ٕ٘بيف زازٜ ٔي قٛز وٝ ٘كبٖ ٔيسٞس 

 سغييطار زض حبَ ا٘دبْ قسٖ ٞؿشٙس. 

ضا اظ ضٚي خؼجٝ وّيس  tabييس. ؾذؽ وّيس ضا ثطاي ايٗ لؿٕز ٔٙظٛض ٕ٘ب 12ضفشٝ ٚ ٔمساض  Eastingثٝ لؿٕز  tabثب فكطزٖ وّيس  .5
ذٛز ثفكبضيس ٚ يب ذبضج لؿٕز ٘ٛقشبضي وّيه ٕ٘بييس ، ؾبػز قٙي ثٝ قٕب ٕ٘بيف زازٜ ٔي قٛز وٝ ٘كبٖ ٔي زٞس سغييطار زض حبَ 

 ا٘دبْ قسٖ ٞؿشٙس. 

 ضا ا٘شربة ٕ٘بييس. Fieldضفشٝ ٚ اظ ِيؿز وكٛيي  Referenceثٝ لؿٕز  tabثب فكطزٖ وّيس  .6

ٕ٘بيف ٔي زٞس ثب ٞط سغييطي ثٝ ٔٛليز خسيسي ٔٙشمُ ٔي  Slotٔطخغ )ٔجٙب( ضا ضٚي ٕ٘ٛزاض  Slotظضز ضٍ٘ي وٝ ٔٛلؼيز  X٘ىشٝ: 

 ضا ٞٓ اوٖٙٛ ايبفٝ وٙيٓ. Slotٔطخغ ا٘شربة ٘كسٜ أب لاظْ اؾز وٝ ايٗ  Slotخسيسي ثٝ ػٙٛاٖ  Slotٞطچٙس  قٛز.
 

 

 ضا سبيخ ٕ٘بييس. Test Slot #1ػٙٛاٖ  New slot name prefixزض لؿٕز  .7

 زض دبييٗ نفحٝ وّيه ٕ٘بييس. Add one slotحبَ ثط ضٚي زوٕٝ  .8

 ٘ىشٝ: 

The Wizard composes a new slot name using the current prefix text, followed by a number, which 
is the lowest number that makes the name unique. So if there were already a slot named Example 
Slot #1, the next new slot created with the same name prefix would be assigned the name Test Slot 
#2 . The yellow X reference mark location on the chart is now enclosed by the hollow blue rectangle 

icon, signifying a New slot. In the Data List, a new addition is added to the bottom of the current list 
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of slots, so you may need to scroll down to find the new entry. The added slot  has a status of New 
in the grid also. 

 
 

 Slotاضافو کشدن الگوىای 
ٞب ٔي ثبقٙس وٝ  چيسٜ ٔب٘ي ٕٞب٘ٙس ٔؿشُيُ يب زايطٜ زاقشٝ ٚ زاضاي ٘مُغ ٔطخؼي ٔي ثبقٙس وٝ زض اٍِٛي  Slotزض ٚالغ ٌطٚٞي اظ  Slotاٍِٛي 

 ٜ اؾز.ٔؿشُيّي ايٗ ٘مُٝ ٔطخغ زض دبييٗ ٌٛقٝ ؾٕز چخ لطاض زاقشٝ ٚ زض اٍِٛي زايطٜ اي ايٗ ٘مُٝ زض ٔطوع زايطٜ ٚالغ قس

 زضخٝ ثچطذٙس. 362سب  2( سغييط يبثٙس ٚ ثب ٞط ظاٚيٝ اي ثيٗ individual slotايٗ اٍِٛ ٞب ٔي سٛا٘ٙس ثب سغييط ٔٛلؼيز ٘مُٝ ٔجٙب  )ُٔبثك ضٚـ 

ٜ ، ٌٛقٝ ؾٕز ضاؾز سؼطيف قس Wizardٔٛخٛز زض ثبلاي دٙدطٜ  Template Property Sheetا٘ساظٜ ٚ ديىط ثٙسي يه اٍِٛ ثب اؾشفبزٜ اظ 
 اؾز.

 

ٞبي ،غيط لبثُ  Slotٔي زٞس ٚ  ٕبيفاٍِٛي َطاحي قسٜ ضا ضٚي ٕ٘ٛزاض ٘ Wizardظٔب٘ي وٝ اَلاػبر وبفي ثطاي ايدبز يه اٍِٛ ٚاضز قٛ٘س 

 ايبفٝ ٔي وٙس. Slot data sheetٚيطايف ثٝ 
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 ٙس.ٔي ثبق Plannedٞبي خسيسي وٝ ثٝ ٚؾيّٝ ايٗ ضٚـ سِٛيس قسٜ ا٘س زاضاي ٚيؼيز  Slotٕٞٝ ٘ىشٝ: 

 

 ثطاي اٍِٛ ٞبي ٔؿشُيّي Slotٔحبؾجبر ٔٛليز ٞبي 

Slot Wizard  3زض ايٗ سٕطيٗ ٔب ،ٔمبزيط فبنّٝ يه اٍِٛ ضا ايدبز ٔي وٙس. سؼساز ؾشٖٛ ٞب، سؼساز ضزيف ٞب ٚ  ٕٞچٖٛ ٚضٚزي ٞبي زضيبفزثب 
فبنّٝ ٔٙظٛض فٛر 4دبٚض زض ضزيف ٞب ٚ ؾشٖٛ ٞب ٞبي ٔ Slotثيٗ  ٕٞچٙيٗضا زض ذٛز خبي زازٜ ايدبز ذٛاٞيٓ وطز  Slot 2ضزيف وٝ ٞط ضزيف 

 ضا ُٔبثك زؾشٛض ظيط سىٕيُ ٕ٘بييس. Template Property sheet  ٚReference dataدبضأشط ٞبي ٔٛخٛز زض   .ذٛاٞيٓ وطز

 ضا ا٘شربة ٕ٘بييس. Rectangleظثب٘ٝ  .1

 ضا ٚاضز ٕ٘بييس. 3ضفشٝ ٚ ػسز  N rowsثٝ لؿٕز  Tabثب وّيس  .2

 ضا ٚاضز ٕ٘بييس. 2ضفشٝ ٚ ػسز  N colsلؿٕز ثٝ  Tabثب وّيس  .3

 ضا ٚاضز ٕ٘بييس. 4ز ٚ ػس Row spacingثٝ لؿٕز  Tabثب وّيس  .4

 ضا ٚاضز ٕ٘بييس. 4ٚ ػسز  Column spacing ثٝ لؿٕز Tabثب وّيس  .5

 ضا ٚاضز ٕ٘بييس. 4ز ٚ ػس Row Shift ثٝ لؿٕز  Tabثب وّيس  .6

 اضز ٕ٘بييس.ضا ٚ 2ٚ ػسز  Column Shift ثٝ لؿٕز Tabثب وّيس  .7

 ا٘شربة ٕ٘بييس.  .Azimuth Refضا ثطاي  Reference point location   ،Grid North زض ثرف .8

 ضا ثطي آٖ ٚاضز ٕ٘بييس. -22ضفشٝ ٚ ٔمساض  Eastingثٝ لؿٕز  Tabثب وّيس  .9

 ضا اظ ِيؿز وكٛيي ا٘شربة ٕ٘بييس. Fieldضفشٝ ٚ  Referenceثٝ لؿٕز   Tabثب وّيس  .12

 

ٚ  Row shift) دبييٗ ٌٛقٝ چخ ( اؾز سٛؾٍ ٔمبزيط ٔكرم قسٜ زض لؿٕز  Slotوٝ زض ٔٛلؼيز  point of rotationٝ ايٗ اٍِٛ ٘ؿجز ث

Column shift .خبثٝ خب ٔي قٛز  
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 اٍِٛٞبي زايطٜ اي

ثٝ ٕٞبٖ نٛضر وٝ زض لؿٕز  Template Property sheetضٚي  Circleثٝ ٔٙظٛض سؼطيف يه اٍِٛي زايطٜ اي ثط ضٚي ظثب٘ٝ 
 ٘كبٖ زازٜ قسٜ، وّيه ٕ٘بييس. ظيط

 

Slot Wizard  ثب اؾشفبزٜ اظ ٔمبزيطRadius  ٚNumber of slots  ٗاٍِٛي زايطٜ اي ضا ايدبز ٔي وٙس. اِٚيSlot  زض ايٗ اٍِٛ ، ٔؿشميٕب زض
 زض خٟز ػمطثٝ ٞبي ؾبػز ٚ زٚض ٔطوع زايطٜ اػٕبَ ٔي قٛز. Rotationخٟز قٕبَ ٔطوع اٍِٛ لطاض ٔي ٌيطز. 

 

 فٝ ٕ٘ٛزٖ يه اٍِٛ ثٝ ؾبذشبضايب

وّيه ٕ٘بييس. ثٝ ٔٛخت ايٗ  Add template slots، ثط ضٚي زوٕٝ  ٌطزيسٞب ثٝ نٛضر ٔؿشُيّي يب زايطٜ اي سؼطيف Slot ظٔب٘ي وٝ چيسٔبٖ  
 يطايف وٙيس.وٝ ٔي ذٛاٞيس ٔؿشملا ٚٞب ضا  slotحبَ ٔي سٛا٘يس ٞط يه اظ سغييط ٔي زٞس.  Newضا ثٝ  Plannedٞبي  slotوبض ٚيؼيز 
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 ىا Slotحزف کشدن 

1. slot  يبslot  ٞبي ضا وٝ ٔي ذٛاٞيس آٟ٘ب ضا اظSlot Grid Sheet .ٔي سٛا٘يس ٞط ٔدٕٛػٝ اظ ؾشٖٛ ٞب ضا  حصف وٙيس ا٘شربة وٙيس
 وٝ ٔي ذٛاٞيس ا٘شربة ٕ٘بييس.

 سغييط ٔي زٞس. Deletedضا ثٝ  ٞبي ا٘شربة قسٜ slotحبِز  Wizard٘طْ افعاض  وّيه ٕ٘بييس. Delete Slot(s)ثط ضٚي زوٕٝ  .2

ٞبي وٝ ثٝ ػٙٛاٖ حصف قسٜ ثٝ قٕب ٕ٘بيف زازٜ ٔي قٛ٘س زض حميمز  ٞٙٛظ حصف ٘كسٜ ٚ لبثُ ثبظ ٌطزا٘ي ٞؿشٙس ٍٔط ايٙىٝ ثط ضٚي  Slotسٛخٝ: 
 اظ ثط٘بٔٝ ذبضج قٛيس. OKوّيه وٙيس يب ثٝ ٚاؾُٝ وّيه وطزٖ ثط ضٚي زوٕٝ  Applyزوٕٝ 

 ن قسٜ:ٞبي دب Slotثبظ ٌطزا٘ي 

1. Slot .ٞبي ضا وٝ ٔي ذٛاٞيس ثبظٌطزا٘يس ا٘شربة ٕ٘بييس 

 آٖ ضا ثٝ حبِز لجّي ثط ذٛاٞس ٌطزا٘س. Wizard زض دبييٗ نفحٝ وّيه ٕ٘بييس. Undelete Slot(s)ثط ضٚي زوٕٝ  .2

 رخيشه کشدن یا سد کشدن نتایح:

Apply   .حبِز ٞط زض ذٛاؾز زض حبَ ا٘دبٔي ضا سغييط ٔي زٞسSlot ِز ٞبي ثب حبNew  ٝثExisting  .سغييط ٔي يبثٙسSlot  ٞبي ثب حبِز
Deleted  ٜاظ ِيؿز خسا ٔي قٛ٘س اِجشٝ ثسٖٚ ايٙىٝ اظ دٙدطWizard  ذبضج قٛ٘س. ٞيچ سغييطي سب ظٔب٘ي وٝ ثط ضٚيApply   وّيه ٘ىطزٜ ايس يب

Slot Wizard  ضا ثب وّيهOK.  ٘جؿشٝ ايس ثط ضٚي دطٚغٜ اػٕبَ ٕ٘ي قٛز . اٌطSlot ثب اٍِٛي  ٞبيPlanned  ٜزاضيس وٝ ثٝ ؾبذشبض ايبفٝ ٘كس
زض نٛضسي وٝ  لهس ذطٚج اظ ثط٘بٔٝ ضا زاضيس ؾيؿشٓ ثب ٕ٘بيف ديبْ ٞكساضي قٕبضا اظ ايٗ ٔٛيٛع آٌبٜ ٔي ؾبظز. OKا٘س ظٔب٘ي وٝ ثب اؾشفبزٜ اظ زوٕٝ 

 اظ ثط٘بٔٝ ذبضج قٛيس. Cancelٝ ٘يبظي ثٝ شذيطٜ سغييطار ايدبز وطزٜ زض ثط٘بٔٝ ٘ساضيس ٔي سٛا٘يس ثب فكطزٖ زوٕ

وّيه وٙيس ثط٘بٔٝ ثسٚ٘ٝ آ٘ىٝ ٞكساضي ٔجٙي ثط اظ زؾز زازٖ سغييطار شذيطٜ ٘كسٜ اسبٖ ثٝ قٕب ٘كبٖ زٞس  يب  Cancel٘ىشٝ: اٌط ثط ضٚي زوٕٝ 
 ثؿشٝ ٔي قٛز.

 ٘ىبر وٕىي:

ذٛز چٙس ِحظٝ  (mouse، وبفيؿز ثب ٘كبٍ٘ط ٔٛقٛاضٜ )چٝ وبضي ا٘دبْ ٔي زٞس  Slot Wizardاٌط فطأٛـ وطزيس وٝ ٞط يه اظ اخعا دٙدطٜ 
 ضٚي آٖ ٔشٛلف قٛيس سب سٛييح ٔرشهطي اظ ػّٕىطز وٙشطَ ا٘شربثي ثٝ قٕب ٕ٘بيف زازٜ قٛز.

 

 اضافو نمودن یک چاه:

 ضاؾز وّيه ٕ٘بييس. DataBrowserسبٖ زض قبذٝ ثط ضٚي ؾبذشبض  .1
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 بييس.ضا ا٘شربة ٕ٘ Insert Wellاظ ٔيب٘جط ٕ٘بيف زازٜ قسٜ  .2

 Slotsثٝ نفحٝ  Yesدٙدطٜ اي حبٚي ديبْ ظيط ثٝ ٕ٘بيف زض آٔس لاظْ اؾز سب ثؼس اظ وّيه ثط ضٚي  Insert Well٘ىشٝ : اٌط ثؼس اظ ا٘شربة 

Property   ثطٌكشٝ ٚ يهslot .خسيس ايبفٝ ٕ٘بييس 

 

. Name, API#, UWI#, Assigned Slot  ٚReferenceسٟٙب لؿٕز ٞبي وٝ ٔي سٛا٘ٙس زض ايٗ دٙدطٜ انلاح قٛ٘س ػجبضسٙس اظ ٘ىشٝ: 
ثط ضٚي دبيٍبٜ زازٜ ٞب سبثيط ٕ٘ي ٌصاضز أب ثٝ قٕب اخبظٜ ٔي زٞس سب ؾطيؼب  ٔٛلؼيز چبٜ ضا ٘ؿجز ثٝ ٞط آ٘چٝ ا٘شربة ٔي وٙيس،  Referenceسغييط 

 ثطضؾي وٙيس.

 ضا ثٝ ػٙٛاٖ ٘بْ چبٜ سبيخ وٙيس. Name  ،W-1زض لؿٕز  .3

وٝ ثطاثط قٕبضٜ چبٜ  Slotوّيه وٙيس اظ ِيؿز قٕبضٜ  Assigned Slotٕز ضاؾز لؿٕز ٔطثٌٛ ثٝ ثط ضٚي زوٕٝ خٟز زاض زض ؾ .4

 اذشهبل يبثس. Slot #1ثٝ  W-1ٔي ثبقس ضا ا٘شربة ٕ٘بييس. ٔثلا 

 ضا ا٘شربة ٕ٘بييس. Fieldٌعيٙٝ  Referenceاظ ِيؿز وكٛيي ،  Locationزض ثرف  .5
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 وّيه ٕ٘بييس. OKثط ضٚي  .6

 ثط ٌطزيس. DataBrowserچبٜ ايبفي سىطاض وٙيس. ٚ ؾذؽ ثٝ دٙدطٜ انّي  19طاي ايدبز ضا ث 5سب 1ٔطاحُ  .7

ثٝ  Edit Structure. دٙدطٜ ضا ا٘شربة ٕ٘بييس Edit Structure/Slotsٚ ٌعيٙٝ  وّيه ضاؾز وطزٜ A. Structureثط ضٚي  .8
 ظيط ثبقٙس. screen snap shotب ثبيس قجيٝ ثٝ زض ثبلاي دٙدطٜ  وّيه ٕ٘بييس اَلاػبر قٕ Slotsٕ٘بيف زض ٔي آيس ثط ضٚي ظثب٘ٝ 
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 اضافو نمودن حفشه چاه -8بخش

 ثطاي چبٜ ذٛز ايدبز ٕ٘بييس. (boreholeذٛاٞيس آٔٛذز وٝ چٍٛ٘ٝ حفطٜ) زض ايٗ زضؼ

يكٕبض يب ٔي سٛا٘س قبُٔ يه يب چٙسيٗ حفطٜ ثبقس. ثطاي ٔثبَ ٔي سٛاٖ چبٜ چٙس ٌب٘ٝ اي ضا ثب قبذٝ ٞبي ث DataBrowserيه چبٜ زض 
sidetrack  ٖاظ حفطٜ چبٜ اِٚيٝ سهٛض وطز. زض ايٗ ثرف چبٜ انّي ضا ايدبز ذٛاٞيٓ وطز ٚ زض آٔٛظـ ثؼسي ٘حٜٛ ايدبز وطزsidetrack off  اظ

 ايٗ چبٜ ضا ذٛاٞيس آٔٛذز.

ضاؾز وّيه  W-1چبٜ ثبظ ٕ٘بيس. ثطاي ايبفٝ وطزٖ يه حفطٜ ثط ضٚي  W-1ثب وّيه وطزٖ ثط ضٚي ػلأز + قبذٝ ٞبي دطٚغٜ ضا سب  .1
 ٕ٘بيف زازٜ ٔي قٛز. Insert Boreholeضا اظ ٔٙٛي ٔيب٘جط ا٘شربة ٕ٘بييس. دٙدطٜ  Insert Boreholeوطزٜ ٚ ٌعيٙٝ 

ثٝ  5سب زض ٔطحّٝنطف ٘ظط وٙيس  Rigلؿٕز  ثٝ نٛضر ذبِي ضٞب وٙيس. فؼلا اظ  #APIضا سبيخ ٕ٘بييس. Name  ، B-1 زض لؿٕز  .2
ٔي ثبقس. ايٗ  Unique Well Identifierثٝ ٔؼٙي  #UWIضا سغييط ٘سٞيس.  #UWIػبر ٔطثٌٛ ثٝ ا٘شربة آٖ ثذطزاظيٓ. اَلا

زيٍطي وٝ زاقشٝ  trackingثطاي حفطٜ اؾز أب ٔي سٛاٖ ثٝ ٞط سؼساز  internal trackingلؿٕز ثٝ َٛض ديف فطو ثٝ سؼساز 
 َ ضٞب وٙيس.ضا ٘يع فؼلا ثٝ ٕٞيٗ حب Drilling Contractor ثبقيس سغييط زازٜ قٛز.
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 ضا ا٘شربة ٕ٘بييس. RKBضفشٝ ٚ اظ ِيؿز وكٛيي  Elevation Nameثٝ لؿٕز  .3

 ضا ٚاضز ٕ٘بييس. 3227ٔمساض  relative to Platform Elevationثطاي لؿٕز  .4

ضز ثٝ قٕب اخبظٜ ٔي زٞس سب ٞط وساْ اظ ؾٝ اضسفبػي وٝ ٔي قٙبؾيس ضا ٚا DataBrowser(، elevations٘ىشٝ: ثطاي اضسفبع ٞب )

 ٔٛاضز زيٍط ضا  ٔحبؾجٝ ٔي وٙس. Tabوطزٜ ٚ ؾذؽ ثب فكطزٖ وّيس 

 

 Rig Listوّيه وٙيس. دٙدطٜ  Rigزض ؾٕز ضاؾز لؿٕز  ثٝ ايٗ حفطٜ ، ثط ضٚي زوٕٝ  rigثطاي اذشهبل زازٖ يه  .5
 ثٙكبٖ زازٜ ٔي قٛز.
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 ثٝ ٕ٘بيف زض ٔي آيس. Rig Editorوّيه وٙيس. دٙدطٜ  New Rigثط ضٚي زوٕٝ  .6

 

 ضا سبيخ ٕ٘بييس. Name  ،Jack_Up Rigلؿٕز  زض .7

 ضا ا٘شربة ٕ٘بييس. Jack-up Rigؾذؽ اظ ِيؿز وكٛيي ٌعيٙٝ  Typeثٝ لؿٕز  Tabثب فكطزٖ وّيس  .8

 ضا ثطاي آٖ سبيخ ٕ٘بييس. WS Professionalضفشٝ   Rig Contractorثٝ لؿٕز  Tabثب فكطزٖ وّيس  .9

 ضا ثطاي آٖ سبيخ ٕ٘بييس. WS218ضفشٝ ٚ  Rig Modelثٝ لؿٕز  Tabثب فكطزٖ وّيس  .12
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 ثبظ ذٛاٞيس ٌكز. Rig Listوّيه وٙيس.قٕب زٚثبضٜ ثٝ دٙدطٜ  OKثط ضٚي  .11

 

 ثبظ ٌطزا٘سٜ ٔي قٛيس. Insert Boreholeضا وّيه وٙيس. ثٝ دٙدطٜ  OKزوٕٝ  .12

ربثي قٕب ٕ٘بيف زازٜ ٌٛقٝ ؾٕز ضاؾز زوٕٝ خٟز زاضي ٚخٛز زاضز وٝ ثب وّيه ثط ضٚي آٖ ِيؿشي حبٚي زوُ ا٘ش Rigزض لؿٕز  .13

 ضا ا٘شربة ٕ٘بييس. Jack_Up Rigٔي قٛز .اظ ايٗ ِيؿز 

 ثٝ ٕٞيٗ نٛضر وٝ ٞؿز ضٞب وٙيس. Data   ٚWell Infoثرف ٞبي ثبليٕب٘سٜ ضا ثطاي  .14

15. OK .ضا وّيه وٙيس 

يه  W-20سب  W-2حفطٜ چبٜ ايبفي سىطاض وٙيس. ثطاي سٕبٔي چبٜ ٞبي  19ضا ثطاي ايدبز  13ٚ ٕٞچٙيٗ ٔطحّٝ  4سب  1ٔطاحُ  .16

 ٘بْ ٌعاضي وٙيس. B-20سب  B-2حفطٜ ايدبز وٙيس. حفطٜ ٞب ضا ثٝ سطسيت 

زض ؾٕز چخ ٞط وساْ اظ حفطٜ ٞبي وٝ خسيسا ايدبز وطزٜ ايس  DataBrowser٘ىشٝ: ٔكبٞسٜ ذٛاٞيس وطز وٝ ٘كب٘ٝ + زض قبذٝ 
،  Evaluateزيٍط اظ حفبضي ذٛاٞيس ثٛز  لؿٕزٚخٛز زاضز . ثط ضٚي ػلأز + وّيه وٙيس سب ثبظ قٛز حبَ قٕب قبٞس ؾٝ 

Execute, and Plan. 
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Evaluate  :( ُايٗ لؿٕز قبُٔ ٕٞٝ آيشٓ ٞبي لبثُ سحٛيdeliverables( اؾٙبز ، )documentation ُاَلاػبر ٔطثٌٛ ثٝ سحّي ٚ )

post-well .ٔي ثبقس 

Execute َي اخطاي چبٜ ٔي ثبقس. : ايٗ لؿٕز قبُٔ ٕٞٝ آيشٓ ٞبي لبثُ سحٛيُ ، اؾٙبز ٚ اَلاػبر زض 

Plan  :.ايٗ لؿٕز سّفيمي اظ آيشٓ ٞبي لبثُ سحٛيُ ، اؾٙبز ، َطح ٞبي ايدبز قسٜ زض َي فبظ ثط٘بٔٝ ضيعي يب َطاحي چبٜ ٔي ثبقس 

 

 ASCIIاستفاده اص باس گزاسنذه  -8بخش 

ASCII    فبيُ ٘ٛقشبضي  ثبضٌعاضيثٝ ٔٙظٛضASCII   يىي اظ وب٘بَ ٞبي ثٌٛ ثٝٔطلؿٕز ٞبي ذبِي اَلاػبر ػٕك زض Evaluate,   

Execute,   يب Plan  ٜٔٛخٛز زض دبيٍبٜ زازٜ  ٕٞچٙيٗ ايٗ ثبضٌعاض٘سٜ ٔي سٛا٘س ثطاي افعٚزٖ اَلاػبر خسيس ثٝ ٔدٕٛػٝ وب٘بَ قٛز.ٔي  اؾشفبز

 اؾشفبزٜ قٛز. DataBrowserٞبي 

 planثؿٍ زٞيس. ثط ضٚي آيىٗ  Zeus > A. Structure > W-13 > B-13 > Planقبذٝ دطٚغٜ ذٛز ضا ثب ا٘شربة ٔؿيط  .1

activity  ُٔضاؾز وّيه وٙيس ٔٙٛي ٔيب٘جطي قبArray Loader  ٚRefresh  .ٕ٘بيف زازٜ ٔي قٛزArray Load  ٗضا اظ اي

 ٕ٘بيف زازٜ ٔي قٛز. Array Loadٔٙٛ ا٘شربة ٕ٘بييس.دٙدطٜ 
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سب فبيّي ضا ثٝ  ٕ٘بييس. ايٗ وبض قٕب ضا لبزض ٔي ؾبظز وّيه ٚ ثط ضٚي زوٕٝ  ضفشٝ File Typeثٝ لؿٕز  Inputزض ثرف  .2
 ٔٙظٛض ثبضٌعاضي ا٘شربة ٕ٘بييس.

 ثٝ ٔٛلؼيز ٔٛضز ٘ظط ثطٚيس. .3

ٕ٘بيف زازٜ ٔي قٛ٘س. فبيّي وٝ لطاض اؾز ثبضٌعاضي قٛز  Array ASCII File (*.csv, *.txt)٘ىشٝ: ثٝ َٛض ديف فطو فبيُ ٞبي ثب فطٔز 

دكشيجب٘ي ٔي  comma-delimited (*.csv)  ٚtab-delimited (*.txt)ايٗ ثط٘بٔٝ اظ ٞط زٚ فطٔز  ثبيس زاضاي فطٔز نحيحي ثبقس.
 يبٔيٗ ٔٛضز ٘يبظ دٛقٝ زازٜ ثط٘بٔٝ زض ظيط ِيؿز قسٜ اؾز: وٙس.

   اِٚيٗ ضزيف ثبيس قبُٔ اؾبٔي ٔؼشجطOilfield Services Data Dictionary (OSDD) .ثطاي وب٘بَ ثبقس 

 ٔٚاحس ٞبي ٔٛضز  اؾشفبزٜ  ثطاي اَلاػبر زازٜ قسٜ ثبقس اِجشٝ زض لبِت وّٕبر اذشهبضي زٚٔيٗ ضزيف ثبيس قب ُOSDD. 
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 .اَلاػبر حميمي ثبيس ثٝ ٌٛ٘ٝ اي ٔي ثبقٙس وٝ ػٕك زض ؾشٖٛ اَٚ لطاض ٌيطز زض يٕٗ ٘ي سٛاٖ ٔمساض ػٕك ضا افعايف يب وبٞف زاز 

فٛر ثبقس ِٚي ايٗ فبنّٝ زض ٚاحس  225ر سبثيط ٌصاض ثبقٙس. اٌط فبنّٝ حميمي اَلاػبر ضٚي اَلاػب ٘ىشٝ: ذُبٞبي سجسيُ ؾيؿشٓ ٚاحس ٔي سٛا٘ٙس ثط

سبٖ ثٝ ٚاحس ٞبي ٔحّي اؾشفبزٜ وٙيس وٝ ثب ايٗ وبض زيٍط ثب ذُب  ASCIIثطاي ثطٌطزا٘سٖ اَلاػبر  ®Excelٔشط  )يب ثطػىؽ( شذيطٜ قسٜ ثبقساظ 
ٔدسز شذيطٜ  CSVآٖ اَلاػبر ضا ثٝ نٛضر فبيُ  DataBrowserٌعاضي اَلاػبر زض ٞبي سجسيُ ٔٛاخٝ ٘رٛاٞيس قس ٚ لاظْ اؾز لجُ اظ ثبض

 C:\Program) ثبظٜ ػٕك ايٗ فبيُ ٚ ِيؿشي اظ ٕٞٝ وب٘بَ ٞبي ٔٛخٛز ٕٞب٘ٙس قىُ ظيط ثٝ قٕب ٕ٘بيف زازٜ ٔي قٛ٘س ٕ٘بييس.

Files\Schlumberger\Drilling Office\bin\asl_popwits\ascii_dep_) ٔٛخٛز زض  . اظ سٙظيٕبرInput Data   ثطاي ا٘شربة
 وب٘بَ ٞبي وٝ لاظْ اؾز سجسيُ قٛ٘س اؾشفبزٜ ٕ٘بييس.
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ايدبز وٙيس. اٌط  .New fileوّيه وطزٜ سب اَلاػبر ثٝ وب٘بَ وٙٛ٘ي افعٚزٜ قٛ٘س يب  Appendثط ضٚي زوٕٝ  Outputزض ثرف  .4

Append ٌيطز وٝ ثٝ ٚاؾُٝ آٖ قٕب ٔي سٛا٘يس  ثٝ زض اذشيبض قٕب لطاض ٔي   يس زوٕٝ خؿشدٌٛط ضا ا٘شربة وطزChannel 

set .ٔٛضز ٘ظط ثطٚيس 

 

 ٚاضز ٕ٘بييس. Channel Set Nameضا زض لؿٕز  Tutorialضا ا٘شربة وطزٜ ٚ  New fileزوٕٝ 

 ٘ىشٝ: 

The depth range to convert defaults to the whole input file but can be modified within the range of 
available data. Resampling to a new output interval has not been implemented and the output 
interval will be fixed at the input interval. When appending, new channels can be added to an 

existing channel set but the start depth of the channel set cannot be changed (shallower data 
cannot be added to an increasing depth file, deeper cannot be added to a decreasing file). When 
the appended depths already exist in the data, the new values will always overwrite the older data. 

زض  يس.زض ثط٘بٔٝ ثبظٜ ػٕك ثٝ نٛضر ديف فطو ثطاي زازٜ ٞبي ٚضٚزي ٔٛخٛز ٔي ثبقس ٚ ِي قٕب ٔي سٛا٘يس ايٗ ثبظٜ ضا ثؿشٝ ثٝ ٘يبظ ذٛز سغييط زٞ
 نٛضسي وٝ ثطاي ٕ٘ٛ٘ٝ خسيس ٘يبظ ثٝ اػٕبَ سغييط زض ذطٚخي زاضيس لاظْ اؾز ايٗ سغيطار ضا زض ٚضٚزي ايٗ ٕ٘ٛ٘ٝ ٘يع اػٕبَ ٕ٘بييس. 

ٕ٘بيف زازٜ ٔي  ،  قبذٝ اَلاػبر ايبفٝ وطزٜ قٕبActivityوّيه ٕ٘بييس. زض لؿٕز  Loadثط ضٚي زوٕٝ  4اظ ا٘دبْ ٔطحّٝ  ثؼس .5
 قٛز .

ASCII Viewer / Exporter 

 ٔي سٛا٘س ثطاي ٔكبٞسٜ يب ذبضج وطزٖ اَلاػبر ٔٛخٛز اظ وبّٟ٘ب اؾشفبزٜ قٛز.  ASCIIٔكبٞسٜ ٌط/ ذبضج وٙٙسٜ 

ثؿٍ زٞيس. ثط ضٚي آيشٓ  Zeus > A. Structure > W-13 > B-13> Plan > Tutorialا٘شربة ٔؿيط قبذٝ دطٚغٜ ضا ثب  .1

Tutorial   ٜزض قبذٝ دطٚغDataBrowser .سبٖ وّيه ضاؾز وٙيس www.Ir
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2. View/Export  ٜضا ا٘شربة ٕ٘بييس. دٙدطArray Viewer  ٜٕ٘بيف زازٜ ٔي قٛز. زض دٙدطArray Viewer  ِيؿشي اظ سٕبٔي
ن قسٜ ضا ثب وّيه وطزٖ اظ حبِز ٔبضن ض. قٕب ٔي سٛا٘يس ٔٛاضز ٔب(ٕٞٝ آٟ٘بيي وٝ  ثب ضً٘ آثي ٔبضن قسٜ ا٘س )ي ٚخٛز زاضز وب٘بَ ٞب

  ذبضج وٙيس.
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 وٙيس سب ِيؿز ٔٙٛي آٖ ثبظ قٛززض ؾٕز ضاؾز وّيه ، زوٕٝ خٟز زاضثط ضٚي   text field، Output Format  لؿٕززض  .3
 ا٘شربة وٙيس. ضأٛضز ٘ظط  Outputفطٔز   ؾذؽ

 View, Comma separated, Tab separated, Tabular View  ٚLAS ٌعيٙٝ ٞبي Output Formatزض ِيؿز  ٘ىشٝ:

ربة ٕ٘بييس ٌعيٙٝ ضا ا٘شComma separated  ٚ Tab separatedزض اذشيبض قٕب لطاض ٔي ٌيطز. زض نٛضسي وٝ ٞط يه اظ ٌعيٙٝ ٞبي 
Separate units row اٌط ٔي ذٛاٞيس ٚاحسٞب ضا زض يه ضزيف خسا ثٙٛيؿيس ايٗ ٌعيٙٝ ضا ا٘شربثي قٕب ايبفٝ ذٛاٞس قس.  ٘يع ثٝ ٔٛاضز

 اٌط ٔي ذٛاٞيس سطويجي اظ  ٚاحس ٞب ٚ ٘بْ زض ضزيف اَٚ زاقشٝ ثبقيس ايٗ سيه ضا ثطزاضيس.سيه ثع٘يس. 

 .حسٚز ديف فطو ٞبي ذطٚخي ثطاي ٕٞٝ حسٚز زض زؾز ضؼ اؾز أب ٔي سٛا٘س سغييط وٙس

4. OK  .فطٔز فبيُ لجلا ا٘شربة قسٜ ثبقس ، وبزض ٔحبٚضٜ اي اٌط ضا وّيه وٙيس سب وبض ديف ضٚزOpen   ثٝ قٕب اخبظٜ ٔي زٞس سب ثٝ فيب
 ذٛز اؾٓ ٚ ٔٛلؼيز اذشهبل ثسٞيس.

 ایداد ىذف -9بخش 

 زض ايٗ زضؼ ذٛاٞيس آٔٛذز وٝ چٍٛ٘ٝ اٞساف ضا ايدبز ٕ٘بييس.
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 Edit Field/Targets/Boundaryبز وطزيس ضاؾز وّيه ٕ٘بييس. اظ ٔٙٛ ٔيب٘جط ٌعيٙٝ وٝ ديف سط ايد Zeusثط ضٚي فيّس  .1

Lines...  ٜضا ا٘شربة ٕ٘بييس. دٙدطEdit Field .ٕ٘بيف زازٜ ٔي قٛز 

 وّيه ٕ٘بييس. Targetsزض ثبلاي دٙدطٜ ضٚي ظثب٘ٝ  .2

 

 زازٜ ٔي قٛز. Create Targetوّيه ٕ٘بييس. دٙدطٜ  ٕ٘بيف  Newثطاي سؼطيف وطزٖ يه ٞسف خسيس ثط ضٚي  .3
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 ضا سبيخ ٕ٘بييس. Target #1ػٙٛاٖ  Nameزض لؿٕز  .4

 ضا ٚاضز وٙيس. 1951ضفشٝ ٚ ٔمساض   Local Cartesian +N/-Sثٝ لؿٕز  Tabثب اؾشفبزٜ اظ وّيس  .5

 ضا ٚاضز وٙيس. 3715.2ضفشٝ ٚ ٔمساض   Local Cartesian +E/-Wثٝ لؿٕز  Tabثب اؾشفبزٜ اظ وّيس  .6

زاقشيس ٔي سٛا٘يس فيّس ٔطثٌٛ ثٝ آٖ ضا Grid يب  Geodetic اٌط ٔرشهبر (طاي ٔحبؾجٝ زيٍط ٔرشهبر فكبض زٞيس ضا ث Tabوّيس  .7

 ٔحبؾجٝ ٕ٘بييس.( Local Cartesian  ٚLocal Polarٔرشهبر ضا ثطاي   Tab ٚاضز وطزٜ  ٚ ثب فكطزٖ وّيس 

ٚلشي يىي اظ ايٗ زٚ ضا ا٘شربة ٕ٘بييس سٕبٔي ضا ا٘شربة ٕ٘بييس.  True Northيب  Grid Northٔي سٛا٘يس  Azimuth Referenceثطاي ٘ىشٝ: 
سٙظيٓ ٔي  Grid Northثطٚي  Azimuth Reference ا٘شربثي سغييط ٔي وٙٙس. زض حبِز ديف فطو  Northلؿٕز ٞبي زيٍط ٘ؿجز ثٝ 

 ثبقس.

 سبيخ ٕ٘بييس. 10587.0ٔمساض  TVDزض لؿٕز  .8

ضا ا٘شربة  Rectangular.ثط ضٚي زوٕٝ خٟز زاض وّيه وٙيس. اظ ِيؿز ثبظ قسٜ ثطٚيس  Shapeثٝ لؿٕز  Tabثب فكطزٖ وّيس  .9
 ٕ٘بييس.

 ضا ثطاي ايٗ لؿٕز ٚاضز ٕ٘بييس. 50ضفشٝ ٚ ٔمساض  Lengthثٝ لؿٕز  Tabثب فكطزٖ وّيس  .12
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 ضا ثطاي ايٗ لؿٕز ٚاضز ٕ٘بييس. 30ضفشٝ ٚ ٔمساض Widthثٝ لؿٕز  Tabثب فكطزٖ وّيس  .11

 ضا ثطاي ايٗ لؿٕز ٚاضز ٕ٘بييس. 0ضفشٝ ٚ ٔمساض  Rotationؿٕز ثٝ ل Tabثب فكطزٖ وّيس  .12

 ضا ثطاي ايٗ لؿٕز ٚاضز ٕ٘بييس. 10ضفشٝ ٚ ٔمساض  Thicknessثٝ لؿٕز  Tabثب فكطزٖ وّيس  .13

 ضا ثطاي ايٗ لؿٕز ٚاضز ٕ٘بييس. 0ضفشٝ ٚ ٔمساض  Dipثٝ لؿٕز  Tabثب فكطزٖ وّيس  .14

 ضا ثطاي ايٗ لؿٕز ٚاضز ٕ٘بييس. 0ٝ ٚ ٔمساض ضفش Dip Azimuthثٝ لؿٕز  Tabثب فكطزٖ وّيس  .15

 

 ثط ٌطزيس. Edit Fieldثٝ دٙدطٜ  OKثب وّيه ثط ضٚي زوٕٝ  .16
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 ضا  ُٔبثك اَلاػبر قىُ ظيط سىطاض وٙيس.  3 -16ثطاي ايدبز زٚٔيٗ ٞسف ٔطاحُ  .17
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 ثبظ ٌطزيس. Edit Fieldوّيه وٙيس سب ثٝ دٙدطٜ  OKثط ضٚي  .18

 ثجٙسيس.دٙدطٜ ضا  Closeثب فكطزٖ زوٕٝ  .19

 اذشهبل اٞساف ثٝ حفطٜ ٞبي چبٜ -12ثرف 

 زض ايٗ زضؼ ٘حٜٛ اذشهبل زازٖ اٞساف ثٝ يه چبٜ ضا ذٛاٞيس آٔٛذز.

ضاؾز وّيه وطزٜ ٚ اظ  B-13ثط ضٚي  ثؿٍ زٞيس. Zeus > A. Structure > W-13 > B-13قبذٝ دطٚغٜ سبٖ ضا زض ٔؿيط  .1
 ضا ا٘شربة ٕ٘بييس. ...Edit Borehole/Targets/Boundary Linesٔٙٛي ٔيب٘جط ٌعيٙٝ 
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 ٕ٘بيف زازٜ ٔي قٛز. Edit Boreholeدٙدطٜ 
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 وّيه ٕ٘بييس. Targetsثط ضٚي ظثب٘ٝ  .2
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3. Target #1 .وٝ زض ثرف آذط ايدبز وطزيس ضا ا٘شربة وٙيس 

 ثب ايٗ ا٘شربة زوٕٝ ٞبي ٔٛخٛز زض ضزيف اَٚ فؼبَ ٔي قٛ٘س.٘ىشٝ: 

 ٔي قٛز. Borehole Targetsٚاضز ثرف  Target #1ٕ٘بييس. وّيه  Attach to Boreholeثط ضٚي زوٕٝ  .4

 سىطاض وٙيس. B-13ثٝ حفطٜ  Target #2ضا ثبضي اذشهبل  3-4ٔطاحُ  .5

 وّيه وٙيس. Closeثٝ ٔٙظٛض سبييس اَلاػبر ثط ضٚي زوٕٝ  .6

 Structure  ٚSlotٌعاضقبر 

 ٌعاضـ ثٍيطيس. Structure)ثٝ ضاحشي ٔي سٛا٘يس اظ  قبذٝ ؾبذشبض )

ثؿٍ زازٜ ؾذؽ ثب ضاؾز وّيه ثط ضٚي آٖ ٔٙٛي ٔيب٘جطي ثٝ قٕب ٕ٘بيف زازٜ ٔي قٛز اظ  A. Structureطٚغٜ ضا سب ؾبذشبض قبذٝ د .1

 ضا ا٘شربة ٕ٘بييس. ...Structure Reportايٗ ٔٙٛ 
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 دٙدطٜ ٌعاضـ ؾبذشبض ُٔبثك قىُ ظيط ٕ٘بيف زازٜ ٔي قٛز.
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 زض ٘ٛاض ػٙٛاٖ ثط٘بٔٝ ٕ٘بيف زازٜ ٔي قٛز. ٘ىشٝ: سؼساز زفؼبسي وٝ اظ ؾبذشبض ٌعاضـ ٔي ٌيطيس

 

 واسد کشدن و خاسج کشدن اطلاعات -11بخش 
 ثطاي آٔٛظـ ٘حٜٛ ٚاضز وطزٖ ٚ ذبضج وطزٖ اَلاػبر اؾشفبزٜ ٔي وٙيٓ. Help Systemزض ايٗ ثرف اظ 

ٔسيطيز وٙيس  import/exportشبٖ ضا ثب اثعاض ٞبي قبيس ثؼس ٞب ٘يبظ زاقشٝ ثبقيس اَلاػبس اؾشفبزٜ ٘ىٙيس. import/export٘ىشٝ: اظ زؾشٛضاِؼُٕ 

 ،Help .ثط ضٚي ٔٙٛي  ثط٘بٔٝ ٘حٜٛ ايٗ وبض ضا ثٝ قٕب آٔٛظـ ٔي زٞسHelp  ٝٙثط٘بٔٝ ضفشٝ ٚ ٌعيHelp Topics .ضا ا٘شربة ٕ٘بييس 
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اخطا  DataBrowser Help Systemضا ا٘شربة ٕ٘بييس.  Help > Help Topicsٔؿيط  DataBrowserاظ دٙدطٜ انّي  .1
 ٔي قٛز.

 

 وّيه وٙيس سب ِيؿز ػٙبٚيٗ ثبظ قٛز. Importing and Exporting Dataثط ضٚي ػلأز + زض ؾٕز چخ وشبة  .2

 ضا ا٘شربة ٕ٘بييس. ٔي سٛا٘يس اظ ؾشٖٛ ؾٕز ضاؾز زؾشٛض اِؼُٕ ٞبي ايٗ لؿٕز ضا ثرٛا٘يس. Importing Dataػٙٛاٖ  .3
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 ي سٛا٘يس اظ ؾشٖٛ ؾٕز ضاؾز زؾشٛض اِؼُٕ ٞبي ايٗ لؿٕز ضا ثرٛا٘يس.ضا ا٘شربة ٕ٘بييس. ٔ  Exporting Dataػٙٛاٖ  .4

 ثبظ ٌطزيس. DataBrowserضا ثؿشٝ ٚ ثٝ  Help Systemدٙدطٜ  .5

 ٘ىبسي زضثبضٜ ٚاضز ٚ ذبضج وطزٖ اَلاػبر

 ٚزي قٕب ثٝ فبيُ ٞٓ زلز فطٔبييس ظٔب٘ي وٝ اَلاػبسي ضا ثٝ ؾيؿشٓ ٚاضز ٔي وٙيس لؿٕز ٞٓ ٘بْ آٖ ٚخٛز ٘ساقشٝ ثبقس چطا وٝ فبيُ ٚض
 ٘بٔف اِحبق ٔي قٛز.

  ٚلشي اَلاػبر ضا ثب اؾشفبزٜ اظ اثعاضdata import .اِحبق ٔي وٙيس، آذطيٗ اَلاػبر ثٝ ضٚظ ضؾب٘ي قسٜ شذيطٜ ٔي قٛ٘س 

  ٚلشي اَلاػبسي  ضاimport  ٔي وٙيٓ فبيُ ٞبي انّيimport ٛ٘س ٚ ٔي قٛ٘س، أب ديٛ٘س ٞبي آٟ٘ب ثٝ َٛض اسٛٔبسيه ٚاضز ٕ٘ي ق
 Userٚاضز قٛ٘س. ثطاي وؿت اَلاػبر ثيكشط ٔي سٛا٘يس ثٝ ثرف  fields  ٚboreholes لاظْ اؾز سٛؾٍ ٔسيط دطٚغٜ

Manager .ٔطاخؼٝ وٙيس 

 BHA Editorآموصش 
 ٕ٘بيي وّي

 ٍ٘بٞي اخٕبِي 

 لجُ اظ ايٙىٝ قطٚع وٙيس 

  ٖثبظ وطزBHA Editor 

  ؾبذشٗ يهBHA 

  شذيطٜ وطزٖ يهBHA 

  ايدبزBHA Reports 
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 ( ٜايدبز ٞٙسؾٝ حفطٜ چبWellbore Geometry) 

 کليات آموصشنگاىی اخمالی بش  -1بخش 
( يبضي  ٔي ٕ٘بييس. ثطاي ايٗ ٔٙظٛض Bottom Hole Assemblyايٗ ثرف اظ آٔٛظـ قٕب ضا ثطاي لسْ ٟ٘بزٖ زض َطاحي ضقشٝ زضٖٚ چبٜ ٞي)

ٚ ٕٞچٙيٗ اخعائ ٔثُ سجسيُ ، ِِٛٝ  MWD/LWDثبلاي ٔشٛض، زٚ اثعاض ٔشكىُ اظ  ٔشٛض، سثجيز وٙٙسٜ زض  "1/2 8ثب لُط  BHA٘حٜٛ ؾبذز 
( وٝ ذٛاٞيٓ ؾبذز ، ٔشكىُ اظ يه لؿٕز حفطٜ ثبظ well geometryٞٙسؾي چبٞي ) ثٝ قٕب آٔٛظـ زازٜ ٔي قٛز. زض ايٗ ثرف ٞبي ٚظ٘ٝ ، ...

 ٚ يه لؿٕز زاضاي خساضي ٔي ثبقس. 

 قبل اص اینکو ششوع کنيذ -2بخش 
ضا ثٝ َٛض وبُٔ ذٛا٘سٜ ايس ٚ يب اظ ديف ثب آٖ DataBrowser ٝ قٕب اظ ؾيؿشٓ ٚاحس ٞبي اٍّ٘يؿي اؾشفبزٜ ٔي وٙيس ٚ فهُ آٔٛظقي ثب فطو ايٙى

 ، چبٜ ٚ حفطٜ چبٜ ضا يدبز وطزٜ ايس ايٗ ثرف آٔٛظقي ضا قطٚع ٔي وٙيٓ.slotآقٙبيي زاضيس ٚ ٕٞچٙيٗ ٔيساٖ ، ؾبذشبض، 

اؾشفبزٜ  BHA Editorٚخٛز زاضز ثطاي آقٙبيي ثيكشط ثب  BHA Editorوٝ زض  on-line helpاظ ؾيؿشٓ  ػلاٜٚ ثط ايٗ وشبة قٕب ٔي سٛا٘يس

 ضا ا٘شربة ٕ٘بييس. Help Topicsٌعيٙٝ  Helpؾيؿشٓ ٘يع ٔي سٛا٘يس اظ ٔٙٛي  Helpٕ٘بييس. ثطاي زؾز ضؾي ثٝ 

 BHA Editorباص کشدن  -3بخش 
 ٕچٙيٗ آقٙبيي ثب ٔحيٍ ثط٘بٔٝ ضا ذٛاٞيس آٔٛذز. ٚ ٞ BHA Editorزض ايٗ ثرف ، ٘حٜٛ ثبظ وطزٖ 

 ٘ىبر: 

 ( َٕٛزض ٘ٛاض اثعاض اؾشب٘ساضز ، ػلاٜٚ ثط آيىٗ ٞبي  ٔؼcut, paste,… آيىٗ ٞبي زيٍطي ٘يع ٚخٛز زاض٘س وٝ ثطذي اظ آٟ٘ب ثٝ َٛض )
 خٛز زاضز.ثُٛض ٔؼَٕٛ زض ٕٞٝ ثط٘بٔٝ ٞب ٚ ،اِٚيٝ غيط فؼبَ ٔي ثبقٙس. ٘ٛاض اثعاض ٚاحس ٞب 

  ثطاي ايٗ ثرف اظ ثط٘بٔٝ فطو قسٜ وٝ ؾيؿشٓ ٚاحس اٍّ٘يؿي ضا ا٘شربة وطزٜ ايس. اِجشٝ اٌط ثب ؾيؿشٓ ٚاحس ٞبي زيٍط ضاحز سط ٞؿشيس
 ٔي سٛا٘يس ٞط ظٔبٖ وٝ ذٛاؾشيس آٖ ضا ػٛو وٙيس.

 ٕ٘بيف زازٜ قٛز. BHA Editorقٛيس سب دٙدطٜ انّي  Start >       > BHA Editorٚاضز ٔؿيط   .1

 وّيه وٙيس. ضا ا٘شربة ٕ٘بييس يب ثط ضٚي آيىٗ  New DrillStringٌعيٙٝ  Fileي اظ ٔٙٛ .2
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 قسٜ ثٝ َٛض ٔفهُ سٛنيف ذٛاٞس قس. ٔكرموٝ زض قىُ فٛق ٞبي  panel٘ىشٝ: 

 ٕ٘بيف زازٜ قسٜ زض قىُ ضا ثجيٙيس. panelوٙيس سب ثشٛا٘يس ٞط ؾٝ  desktopدٙدطٜ ثط٘بٔٝ ضا ثٝ ا٘ساظٜ  .3

 DrillString Components Catalog  ،DrillString Components Schematicٞبي  panelيٗ ثرف اظ آٔٛظـ ثٝ ٘ىشٝ: ا

View  ٚDrillString Properties Panel اذشهبل ذٛاٞس يبفز. 

Panel #1فٟطؾز اخعاء ضقشٝ حفبضي : 

Equipment Database  :ثٝ زٚ ٌطٜٚ سدٟيعار سمؿيٓ ثٙسي ٔي قٛ٘سCatalog  ٚUser.  Catalog  فٟطؾشي اظ ِِٛٝ ٞبي حفبضي، اثعاض
MWD/LWD  .ٔشٛضٞب ، سثجيز وٙٙسٜ ٞب، ... ٔي ثبقس ،Catalog  زض ٚالغ قبُٔ سٕبٔي چيع ٞبي اؾز وٝ زض ؾبذزBHA  يبWell 

Geometry  .٘يبظ ٞؿشٙسUser .فٟطؾشي اظ اخعاء سؼطيف قسٜ سٛؾٍ وبضثط ٔي ثبقس 

ثطاي ايٗ وبض ثبيس ٘كبٍ٘ط ٔٛقٛاضٜ ذٛز ضا ضا ػطيى سط وٙيس.  Panel #1وٝ ثٝ ٔٙظٛض ٔكبٞسٜ اؾبٔي ٕٞٝ اخعا ، : ٕٔىٗ اؾز ٘يبظ زاقشٝ ثبقيس ٘ىشٝ
ٞب لطاض زٞيس ٔكبٞسٜ ذٛاٞيس وطز وٝ ٘كبٍ٘ط ٔٛقٛاضٜ سغييط قىُ ذٛاٞس زاز زض ايٗ حبِز ثب ٍ٘ٝ زاقشٗ  Panelثط ضٚي ذٍ ػٕٛزي سمؿيٓ وٙٙسٜ 

 ضا ثطاثط ٘يبظ ذٛز سغييط زٞيس. Panelزوٕٝ چخ ٔٛقٛاضٜ ،ا٘ساظٜ 

ثط  Catalogزض لؿٕز حبَ ثيبيس سب ٍ٘بٜ ٔرشهطي ثٝ اخعاء ٔٛخٛز زض فٟطؾز ثيٙساظيٓ ثطاي قطٚع ثٟشط اؾز ؾطي ثٝ ٔشٝ ٞب ثع٘يٓ. ثطاي ايٗ وبض 
ٔشٝ ثٝ قٕب  ي اظ ؾبيعٞبي ٔرشّفٔحسٚزٜ ٚؾيؼ وّيه ٕ٘بيس سب Bitيب ثط ضٚي ػلأز + زض ؾٕز چخ آيىٗ  زاثُ وّيه وٙيس ٚ Bitضٚي وّٕٝ 

لطاض ٔي زٞس وٝ قٕب ضا زض ٔكبٞسٜ قبذٝ ثبظ وطزٜ سبٖ يبضي ٔي  Panelي زض ؾٕز ضاؾز -scrollثط٘بٔٝ ثٝ َٛض اسٛٔبسيه  ٕ٘بيف زازٜ ٔي قٛ٘س.
زاثُ وّيه وٙيس  Max OD "7/8 3زض ظيط قبذٝ ٞط ٔشٝ، ٔشٝ ٞبي ثب ؾبيع ٞبي ٔرشّف ثس٘ٝ ٚخٛز زاضز.  ثٝ ػٙٛاٖ ٔثبَ اٌط ثط ضٚي ٔشٝ زٞس. 

 ذٛاٞيس زيس وٝ زٚ ؾبيع ثس٘ٝ زيٍط ٘يع  زض اذشيبض قٕب لطاض ٔي ٌيطز.

Panel #1 Panel #2 Panel #3 
DrillString Components Catalog DrillString Components  

Schematic View 
DrillString Properties Panel 
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 وّيه وٙيس يب ثط ضٚي قبذٝ آٖ ضاؾز وّيه ٕ٘بييس. –ثطاي ثؿشٗ قبذٝ ٞبي وٝ ثبظ وطزيس يب ثط ضٚي ػلأز 

The User section is a repository located underneath the main catalog with a list of components 
with the same headings. This is where you can store your own customized components or 
frequently used components that are perhaps not yet in the main catalog. 
 

Panel #2 قٕبسيه اخعاء ضقشٝ حفبضي : 

Drillstring Components Schematic View  خبي اؾز وٝ قٕب ثب وكيسٖ ٚ ضٞب وطزٖ اخعاء اظ فٟطؾزPanel #1  ،BHA 

 سٛخٝ وٙيس.Panel ايٗ وبض ثطاي قٕب ثيبٖ ذٛاٞس قس أب فؼلا فمٍ ثٝ ٞط ذٛزسبٖ ضا ٔي ؾبظيس. وٕي زيٍط خعئيبر ثيكشطي اظ ٘حٜٛ ا٘دبْ

  ضا زض حيٗ ؾبذز ٘كبٖ ٔي زٞس. BHAقىُ ظيط قٕبسيىي اظ  
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Panel #3 سبثّٛ ذٛال اخعاء ضقشٝ حفبضي : 

ا٘شربة وطزٜ ايس ضا ٘كبٖ ٔي زٞس. ظٔب٘ي وٝ َطح وّي  BHA، ذٛال ٞط خعئي وٝ زض  Drillstring Component Propertiesسبثّٛ 

BHA  زضPanel #2  ْػلأز ]+[ زض وٙبض ٘ب( ثؿشٝ ٔي ثبقسBHA  يب ٞيچ خعئي ثطاي ، )٘كبٖ زازٜ ٔي قٛزBHA ذٛال بقسا٘شربة ٘كسٜ ث .
ٚظٖ وُ ضقشٝ   Total Weightوٝ ََٛ وُ ضقشٝ حفبضي اؾز وٝ ايدبز وطزٜ ايس ٚ  Total Lengthػجبضسٙس اظ  Panel #3ٔٛخٛز زض 

 حفبضي زض ٞٛا ٔي ثبقس.
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ٌ ثٝ آٖ خعء ٚيػٌي ٞبي ٔطثٛ Panel #3ثبظ ثبقس ٚ يىي اظ اخعاء ضقشٝ حفبضي زض حبِز ا٘شربة ثبقس. زض  Panel #2زض  BHAاٌط قٕبسيه 
 يه ٔٛسٛض ٔي ثبقس. Generalٕ٘بيف زازٜ ٔي قٛ٘س. سهٛيط ظيط ٘كبٖ زٞٙسٜ ٚيػٌي ٞبي 
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، ...ٔي ثبقس. نفحٝ length  ،ID ،OD( ٔب٘ٙس General) ػٕٛٔي ٚيػٌي ٞبي بُٔنفحٝ قٚخٛز زاضز. اِٚيٗ  Panel #3ٔؼٕٛلا ؾٝ نفحٝ زض 

ذي اَلاػبر ايبفي ٔي ثبقس وٝ ٕٞيكٝ يطٚضي ٘يؿز ايٗ اَلاػبر ضا دط وٙيس. نفحٝ ؾْٛ ٘ٛقشٝ قسٜ قبُٔ ثط Moreزْٚ وٝ ثط ضٚي ظثب٘ٝ آٖ 
زضج  Motorٔرهٛل خعئي ٔي ثبقس وٝ ا٘شربة قسٜ اؾز ٕٞبُ٘ٛض وٝ ٔي ثيٙيس حبَ وٝ ٔب خعء ٔشٛض ضا ا٘شربة وطزيٓ زض ظثب٘ٝ ؾْٛ ٘يع ٔؼٕٛلا 

 ظاٚيٝ ا٘حطاف ٔٛسٛض ، فبنّٝ ظاٚيٝ ا٘حطاف اظ اسهبَ دبييٙي،... اؾشفبزٜ وطز. ثطاي ٚاضز وطزٖ ٔمبزيط ٌطزيسٜ اؾز.اظ ايٗ نفحٝ ٔي سٛاٖ

 ٔي ثبقس. BHAٞب ، ؾبذز يه  Panelثٟشطيٗ ضاٜ ثطاي زضن ػّٕىطز ٞط يه اظ 

 BHAساخت یک  -4بخش
 ضا ذٛاٞيس آٔٛذز. Tutorial #1ثطاي ثرف افمي چبٜ  BHAزض ايٗ سٕطيٗ ، چٍٍٛ٘ي ؾبذز يه 

 انتخاب متو:

 ذٛاٞيٓ ؾبذز. "1/2 8ثطاي حفطٜ اي ثٝ لُط  BHAايٗ سٕطيٗ زض 
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 وّيه وٙيس، سب ِيؿز ٕ٘بيف زازٜ قٛز. Catalogثط ضٚي + زض ؾٕز ضاؾز  .1

 ٞبي ٔرشّف ٕ٘بيف زازٜ ٔي قٛز. ODوّيه وٙيس، ِيؿز قبُٔ  Bitثط ضٚي + زض ؾٕز ضاؾز  .2

 ف زازٜ ٔي قٛز.ٕ٘بي Body ODزاثُ وّيه وٙيس ِيؿشي اظ زٚ  Max OD "1/2 8ثط ضٚي  .3

4. 6" Body OD  ضا ا٘شربة ٕ٘بييس. زوٕٝ ؾٕز چخ ٔٛقٛاضٜ ضا ٍٟ٘ساقشٝ ٚ آٖ ضا زض ظيط ٕ٘بزBHA  ، زضPanel 

 ٕ٘بيف زازٜ ٔي قٛز. BHAضٞب وٙيس. ٔشٝ زض قٕبسيه  #2

 

ظ ايٗ ٚيػٌي ٞب ٞٓ ظٔبٖ ثب ا٘شربة ٔشٝ اظ سغييط ٔي وٙس سب ثشٛا٘س ٚيػٌي ٞبي ٔطثٌٛ ثٝ ٔشٝ ضا ٘كبٖ زٞس ثطذي ا Panel #3زض ايٗ ِحظٝ ٘ىشٝ: 
 فٟطؾز ، زضج قسٜ ا٘س ٚ ٚيػٌي ٞبي زيٍط ضا ثبيس ثٝ َٛض زؾشي ٚاضز ٕ٘بييس.

 . ثبيس ثط ضٚي زوٕٝ خٟز زاض ٚالغ زض ؾٕز ضاؾز ايٗ لؿٕز وّيه وٙيس.Panel #3اظ  Typeثطاي سؼييٗ لؿٕز  .5

 ٕ٘بييس.ضا ا٘شربة  Insert Bitاظ ِيؿز وكٛيي ٕ٘بيف زازٜ قسٜ  .6
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 ثطٚيس. Nozzlesثٝ ثرف  Bitثب وّيه ثط ضٚي ظثب٘ٝ  .7
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 ضا سبيخ وٙيس. 3ػسز  Countزض ؾَّٛ اَٚ ؾشٖٛ  .8

 ضا فكبض زٞيس. tabضا سبيخ وطزٜ ٚ ٔدسزا وّيس  15ػسز  Size (1/32")ضا فكبض زٞيس. زض اِٚيٗ ؾَّٛ اظ ؾشٖٛ  tabوّيس  .9

 ثٝ َٛض ذٛزوبض ٔحبؾجٝ ٔي قٛز. TFA٘ىشٝ: 

 وطزٖ يه ٔشٛضايبفٝ 

 ٞب ثؿشٝ قٛ٘س.OD وّيه ٕ٘بييس سب ِيؿز  Panel #1زض  Bit، زض ؾٕز چخ فٟطؾز  –ثط ضٚي  ػلأز  .1

 وّيه وٙيس. ؾٝ فٟطؾز ٔشٛض ٕ٘بيف زازٜ ٔي قٛ٘س. Motorثط ضٚي  ػلأز + زض ؾٕز ضاؾز فٟطؾز  .2

 زازٜ قٛز. ٞبي ٔرشّف ثٝ قٕب ٕ٘بيفOD زاثُ وّيه ٕ٘بييس سب ِيؿشي اظ   Anadrillثط ضٚي  .3

 ضا ثب زاثُ وّيه وطزٖ ثط ضٚي آٖ ا٘شربة ٕ٘بييس. "OD ،6 3/4ٞب Anadrill Motor اظ ِيؿز  .4

ٚ اؾشفبزٜ اظ  BHAثٝ ٘ٛع ٔشٛض ا٘شربة قسٜ زض   DrillSAFE  ٚHydraulicsزؾشطؾي ذٛزوبض  Drilling Officeيىي اظ ٔعايبي ػٕسٜ : ٘ىشٝ 
 ( ٔي ثبقس.hydraulics powerٔٙحٙي ٞبي ٘يطٚي ٞيسضِٚيىي )
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 ٌعيٙٝ زض ذشيبض قٕب لطاض ٔي ٌيطز. 4زاثُ وّيه ٕ٘بييس.  A675M4570XPثط ضٚي  .5

 ٌعيٙٝ زيٍط زض اذشيبض قٕب لطاض ذٛاٞس ٌطفز. 4زاثُ وّيه وٙيس.  NC50 (IF) (Up) "1/2 4ثط ضٚي ٌعيٙٝ  .6

زض   BHAٔز ضا ا٘شربة وطزٜ ٚ ثب وكيسٖ ٚ ضٞب وطزٖ آٖ ثط ضٚي ػلا Reg (Down) "1/2 4ٌعيٙٝ  .7
Panel #2  ٝآٖ ضا ثBHA .ذٛز ايبفٝ وٙيس 

 

ذُبٞبي وٝ زض ٔحسٚزٜ چه سٟٙب ٔي سٛا٘س ذُبٞبي ٔحسٚزي ضا چه وٙس ٚ ٕٔىٗ اؾز اخعا ضا زض ٞط ٔطسجٝ اي لطاض زٞس.  BHA Editor٘ىشٝ: 
 .چه ٔي قٛ٘سثٛزٜ ٚ سٛؾٍ ايٗ زٚ ثط٘بٔٝ  DrillSAFE  ٚHydraulics ٘يؿشٙس زض ٔحسٚزٜ BHA Editorوطزٖ 

 وّيه ٕ٘بييس. Panel #3زض ثبلاي لؿٕز  Motorثط ضٚي ظثب٘ٝ  .8

 ضا سبيخ ٕ٘بييس. 125ٔمساض  Angelثطاي  Bend #1زض ثرف  .9

 ٚاضز قسٜ اؾز. populatedاظ فٟطؾز  Bend to Bottom Connection٘ىشٝ: لؿٕز 
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 تثبيت کننذه موتوس

ٞبيي ٔي ثبقٙس . قٕب ٘يع ٔي سٛا٘يس ثب وكيسٖ ٚ ضٞب وطزٖ يه سثجيز وٙٙسٜ اظ ِيؿز  اغّت ٔٛسٛض ٞبي ٔٛخٛز زض فٟطؾز زاضاي سثجيز وٙٙسٜ
 ثط ضٚي ٔشٛض ، سثجيز وٙٙسٜ اي ثٝ آٖ ايبفٝ وٙيس.

 ٘يبظ اؾز سب ثطذي اظ ٚيػٌي ٞبي سثجيز وٙٙسٜ اـ ضا سغييط زازٜ قٛز. ا٘شربة وطزيس زٔٛسٛض زاضاي سثجيز وٙٙسٜ اي وٝ ديف سط  اظ ِيؿ

 وّيه ٕ٘بييس. ِيؿز اخعاء آٖ ثبظ ٔي قٛ٘س. Panel #2زض  A675M4570XPزض ؾٕز چخ ٔٛسٛض  لأز ثط ضٚي ػ .1

 ٕ٘بيف زازٜ قٛ٘س. Panel #3وّيه وٙيس سب ٚيػٌي ٞبي آٖ زض  Stabilizer #1ثط ضٚي  .2

 ظٜ حفطٜ سٙظيٓ ٔي قٛز.ثطاي ٔشٛض ٞبي ثب سثجيز وٙٙسٜ، ثطاثط ثب وٛچىشطيٗ ا٘سا Max. Outer Diameter ٘ىشٝ: ثٝ َٛض ديف فطو

سبيخ  .Blade Mid-Point To PDM’s Bottom Connثطاي ضا   0.585ٔمساض  Blade Distancesزض لؿٕز  .3
 ٕ٘بييس.
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 ضا ثفكبضيس سب ٔمبزيط خسيس زض ثط٘بٔٝ ٔٙظٛض قٛ٘س. tabوّيس  .4

 

 تثبيت کننذه بش سوی موتوس اضافو کشدن

 لطاض اؾز ضٚـ ايبفٝ وطزٖ سثجيز وٙٙسٜ ضٚي ٔٛسٛض اظ ايٗ

 وّيه وٙيس سب ِيؿز آٖ ثؿشٝ قٛز. Panel #1زض ؾٕز چخ قبذٝ ٔشٛض ٚالغ زض   –ثط ضٚي ػلأز   .1

 وّيه ٕ٘بييس. Panel #1ٚالغ زض  Stabilizer ضؾشٝثط ضٚي ػلأز + زض ؾٕز چخ  .2

 ٞب ٕ٘بيف زازٜ ٔي قٛز.ID. ِيؿشي اظ زاثُ وّيه ٕ٘بييس OD "3/4 6ثط ضٚي  .3

 ٕ٘بييس. سب ِيؿشي اظ اسهبلار ٕ٘بيف زازٜ قٛز. زاثُ وّيه ID "3ثط ضٚي  .4

سثجيز وٙٙسٜ قٕب ثبلاي ٔٛسٛض ظبٞط ٔي  BHAضا ا٘شربة ٕ٘بييس. ثب وكيسٖ ٚ ضٞب وطزٖ آٖ ثط ضٚي آيشٓ  NC50 (4 1/2 IF)اسهبَ  .5
 قٛز.

س ثب ضٞب وطزٖ ٔي سٛا٘يطزٜ ايس لطاض ٔي ٌيطز. وٝ ايبفٝ و ىٙئٛضز ٘ظط ، ضٚي آذطيٗ آي شٓ، آي BHAٞب ضٚي ٕ٘بز  شٓ٘ىشٝ: ثب وكيسٖ ٚ ضٞب وطزٖ آي
 آيشٓ ضٚي آيىٗ ٔٛضز ٘ظط، آٖ آيشٓ ضا زض ٔىبٖ ٔٛضز ٘ظط ذٛز لطاض زٞيس.
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 وّيه وٙيس. Typeوّيه وٙيس ؾذؽ ثط ضٚي زوٕٝ خٟز زاض  زض ؾٕز ضاؾز لؿٕز  Generalظثب٘ٝ  ثط ضٚي .6

 آٖ ثٝ َٛض اسٛٔبسيه ا٘شربة ذٛاٞس قس. Checkbox ضا ا٘شربة ٕ٘بييس. Non-Magnetic Stabilizerاظ ِيؿز وكٛيي  .7

 ٚاضز ٕ٘بييس. Lengthضا ثطاي  3ٔمساض  Dimensionsزض ثرف  .8

 ضا ٚاضز ٕ٘بييس. 8.25ٔمساض  Bladeزض لؿٕز  .9

 

www.Ir وّيه وطزٜ ٚ دبضأشط ٞبي ظيط ضا ٚاضز ؾبظيس. Stabilizerثط ضٚي ظثب٘ٝ  .12
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 ضا ازأٝ ٔي زٞيٓ BHA ؾبذز

 BHAثٝ  ٞٙٛظ ئي وٝضا سب ضؾيسٖ ثٝ ِِٛٝ ٞبي حفبضي ازأٝ زٞيس. زض ازأٝ ِيؿز ٔفهّي اظ اخعا BHAٔي سٛا٘يس ؾبذز ثٝ ضٚقي وٝ ٌفشٝ قس 

 آٚضزٜ قٛ٘س آقٙب ٔي قٛيس. BHAٕٞچٙيٗ ثب اخعائي وٝ لاظْ اؾز زض  آٚضزٜ قسٜ اؾز ٘ىطزٜ ايسايبفٝ 

 CDRاثعاض 

 ثؿشٝ قٛز. ضؾشٝوّيه ٕ٘بييس. سب ِيؿز ٔٛخٛز زض ايٗ  Panel #1ٚالغ زض  Motor ضؾشٝزض ؾٕز چخ   –ثط ضٚي ػلأز  .1

 وّيه ٕ٘بييس. MWD/LWD ضؾشٝثط ضٚي ػلأز + زض ؾٕز چخ  .2

 زاثُ وّيه ٕ٘بييس. Anadrillثط ضٚي  .3

 زاثُ وّيه ٕ٘بييس. CDRثط ضٚي  .4

 ايبفٝ وٙيس.آٖ ضا ثٝ ضقشٝ ذٛز  BHAضا ا٘شربة وطزٜ ٚ ثب وكيسٖ ٚ ضٞب وطزٖ ثط ضٚي ػلأز  OD "3/4 6ٌعيٙٝ  .5

 ثٝ َٛض وبُٔ سىٕيُ ٘كسٜ ٘يبظي ثٝ سغييط زض ايٗ خعء ٕ٘ي ثبقس. BHAسب ظٔب٘ي وٝ ٕٞٝ ٘ىشٝ: 

Drill Collar 

 وّيه وٙيس. Panel #1ٚالغ زض  Collar ضؾشٝثط ضٚي ػلأز + زض ؾٕز چخ  .1

 زاثُ وّيه ٕ٘بييس. OD "3/4 6ثط ضٚي  .2

 زاثُ وّيه ٕ٘بييس. ID "3ثط ضٚي  .3

 ضٞب وٙيس. BHAضا ا٘شربة ، ٚ آٖ ضا وكيسٜ ٚ ثط ضٚي ٕ٘بز  NC50(4 1/2 IF)ٌعيٙٝ  .4

 ٔي ضؾس. Panel #3ٚالغ زض  Generalحبَ ٘ٛثز ثٝ ٚيطايف ٚيػٌي ٞبي ٔٛخٛز زض ظثب٘ٝ 

ضا ا٘شربة  Non-Magnetic Drill Collarوّيه وطزٜ ٚ اظ ِيؿز وكٛي ثبظ قسٜ  Typeثط ضٚي زوٕٝ خٟز زاض زض لؿٕز  .5
 ٕ٘بييس.

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   87 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 ضا سبيخ وٙيس. Monel 6 3/4" Collarػٙٛاٖ  Name ثطاي لؿٕز .6

 ضا ٔٙظٛض ٕ٘بييس. 30ٔمساض  Lengthثطاي لؿٕز  Dimensionsزض ثرف  .7

 ضا سبيخ ٕ٘بييس. 5.5ٔمساض  Top Size  ٚBottom Sizeثطاي لؿٕز ٞبي  Connectionزض ثرف  .8

 ضا ثجٙسيس. Panel #1ٚالغ زض  Collarفٟطؾز   –ثب وّيه ثط ضٚي ٕ٘بز  .9

 حفبضي )ثرف اَٚ( ِِٛٝ

 وّيه وٙيس. Panel #1ٚالغ زض ِيؿز سدٟيعار  Drill Pipeضؾشٝ ثط ضٚي ػلأز + زض ؾٕز چخ  .1

 زاثُ وّيه ٕ٘بييس. OD "5ثط ضٚي  .2

 زاثُ وّيه ٕ٘بييس. lbm/ft 19.5ثط ضٚي  .3
 زاثُ وّيه ٕ٘بييس. E-75 ثط ضٚي  .4

 زاثُ وّيه ٕ٘بييس. NC50 (4 1/2 IF)ثط ضٚي  .5
6. 10% Wear ة وطزٜ ، آٖ ضا وكيسٜ ٚ ثط ضٚي ٕ٘بز ضا ا٘شربBHA .ضٞب وٙيس 

 ٔي ضؾس. Panel #3ٚالغ زض  Generalحبَ ٘ٛثز ثٝ ٚيطايف ٚيػٌي ٞبي ٔٛخٛز زض ظثب٘ٝ 

 فٛر ٔٙظٛض ٕ٘بييس.  2000ٔمساض  Lengthثطاي لؿٕز  Dimensionsزض ثرف  .7

 طزٜ سب ِيؿز ٔطثَٛٝ ثؿشٝ قٛز.وّيه و Panel #1ٚالغ زض  Drill Pipeزض ؾٕز چخ ضؾشٝ  –ثط ضٚي ػلأز   .8

Misc. Sub 

 وّيه وٙيس. Panel #1ٚالغ زض ِيؿز سدٟيعار  Misc. Subثط ضٚي ػلأز + زض ؾٕز چخ ضؾشٝ  .1

 زاثُ وّيه ٕ٘بييس. OD "3/4 6ثط ضٚي  .2

 زاثُ وّيه ٕ٘بييس. ID "1/4 2ثط ضٚي  .3

 زاثُ وّيه ٕ٘بييس. NC50 (4 1/2 IF)ثط ضٚي  .4

 ضٞب وٙيس. BHAضا وكيسٜ ٚ ثط ضٚي ٕ٘بز  ضا ا٘شربة وطزٜ ، آٖ 1/2 4 .5

 ٔي ضؾس. Panel #3ٚالغ زض  Generalحبَ ٘ٛثز ثٝ ٚيطايف ٚيػٌي ٞبي ٔٛخٛز زض ظثب٘ٝ 

 ضا ا٘شربة ٕ٘بييس. Crossoverوّيه وطزٜ ٚ اظ ِيؿز وكٛي ثبظ قسٜ  Typeثط ضٚي زوٕٝ خٟز زاض زض لؿٕز  .6

 زضج ٔي ٌطزز. Panel #2  ٚPanel #3٘ىشٝ: ٘بْ ايٗ خعء ثٝ َٛض ذٛز وبض زض 

 فٛر ٔٙظٛض ٕ٘بييس.  2ٔمساض  Lengthثطاي لؿٕز  Dimensionsزض ثرف  .7

 ايٙچ ضا سبيخ ٕ٘بييس. 5.5ٔمساض   Bottom Sizeثطاي لؿٕز  Connectionزض ثرف  .8

ضا  API Full Holeضٚي زوٕٝ خٟز زاض وّيه وطزٜ ٚ اظ ِيؿز وكٛيي،  Bottom Connection Type زض ؾٕز ضاؾز  .9
 ربة ٕ٘بييس.ا٘ش

 ضا ا٘شربة ٕ٘بييس. Pinزوٕٝ  .12

Heavy Weight Drill Pipe  
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 وّيه وطزٜ سب ِيؿز ٔطثَٛٝ ثؿشٝ قٛز. Panel #1ٚالغ زض  Misc. Subزض ؾٕز چخ ضؾشٝ  –ثط ضٚي ػلأز  .1

 وّيه وٙيس. Heavy Weight Drill Pipeثط ضٚي ػلأز + زض ؾٕز چخ ضؾشٝ  .2

 زاثُ وّيه ٕ٘بييس.  OD "5ثط ضٚي  .3

 زاثُ وّيه ٕ٘بييس.Heavy Weight Drill Pipe ضٚي ثط  .4

5. 50.38 lbm/ft  ضا ا٘شربة وطزٜ ، آٖ ضا وكيسٜ ٚ ثط ضٚي ٕ٘بزBHA .ضٞب وٙيس 

 ٔي ضٚيٓ. Panel #3ٚالغ زض  Generalحبَ ثٝ ؾطاق  ٚيطايف ٚيػٌي ٞبي ٔٛخٛز زض ظثب٘ٝ 

 س.فٛر ٔٙظٛض ٕ٘بيي  300ٔمساض  Lengthثطاي لؿٕز  Dimensionsزض ثرف  .6

وّيه وطزٜ سب ِيؿز ٔطثَٛٝ ثؿشٝ  Panel #1ٚالغ زض  Heavy Weight Drill Pipeزض ؾٕز چخ ضؾشٝ  –ثط ضٚي ػلأز  .7
 قٛز.

Misc. Sub 

 وّيه وٙيس. Panel #1ٚالغ زض ِيؿز سدٟيعار  Misc. Subثط ضٚي ػلأز + زض ؾٕز چخ ضؾشٝ  .1

 زاثُ وّيه ٕ٘بييس. OD "3/4 6ثط ضٚي  .2

 وّيه ٕ٘بييس. زاثُ ID "1/4 2ثط ضٚي  .3

 زاثُ وّيه ٕ٘بييس. NC50 (4 1/2 IF)ثط ضٚي  .4

 ضٞب وٙيس. BHAضا ا٘شربة وطزٜ ، آٖ ضا وكيسٜ ٚ ثط ضٚي ٕ٘بز  1/2 4 .5

 ٔي ضؾس. Panel #3ٚالغ زض  Generalحبَ ٘ٛثز ثٝ ٚيطايف ٚيػٌي ٞبي ٔٛخٛز زض ظثب٘ٝ 

 ضا ا٘شربة ٕ٘بييس. Crossoverقسٜ  وّيه وطزٜ ٚ اظ ِيؿز وكٛي ثبظ Typeثط ضٚي زوٕٝ خٟز زاض زض لؿٕز  .6

 زضج ٔي ٌطزز. Panel #2  ٚPanel #3٘ىشٝ: ٘بْ ايٗ خعء ثٝ َٛض ذٛز وبض زض 

 فٛر ٔٙظٛض ٕ٘بييس.  2ٔمساض  Lengthثطاي لؿٕز  Dimensionsزض ثرف  .7

 ايٙچ ضا سبيخ ٕ٘بييس. 5.5ٔمساض   Top Sizeثطاي لؿٕز  Connectionزض ثرف  .8

ضا ا٘شربة  API Full Holeضٚي زوٕٝ خٟز زاض وّيه وطزٜ ٚ اظ ِيؿز وكٛيي،  Top Connection Type زض ؾٕز ضاؾز  .9
 ٕ٘بييس.

 ضا ا٘شربة ٕ٘بييس. Box زوٕٝ  .12

 ايٙچ ضا سبيخ ٕ٘بييس. 5.5ٔمساض   Bottom Sizeثطاي لؿٕز  Connectionزض ثرف  .11

ضا ا٘شربة  NC50 (IF)ز وكٛيي، ضٚي زوٕٝ خٟز زاض وّيه وطزٜ ٚ اظ ِيؿBottom Connection Type زض ؾٕز ضاؾز  .12
 ٕ٘بييس.

 ضا ا٘شربة ٕ٘بييس.Pin زوٕٝ  .13

Drill Pipe 

لطاض ٌيط٘س زض ٚالغ ايٟٙب ِِٛٝ ٞبيي ٞؿشٙس وٝ سب  BHAضٞب ٘ىٙيس چطا وٝ ايٗ ِِٛٝ ٞب ثبيس ثط ضٚي  BHAايٗ ِٛثٝ ٞبي حفبضي ضا ضٚي ٕ٘بز ٘ىشٝ: 
 ؾُح وكيسٜ قسٜ ا٘س.
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 وّيه وٙيس. Panel #1ٚالغ زض ِيؿز سدٟيعار  Drill Pipe ثط ضٚي ػلأز + زض ؾٕز چخ ضؾشٝ .1

 زاثُ وّيه ٕ٘بييس. OD "5ثط ضٚي  .2

 زاثُ وّيه ٕ٘بييس. lbm/ft 19.5ثط ضٚي  .3

 زاثُ وّيه ٕ٘بييس. E-75 ثط ضٚي  .4
 زاثُ وّيه ٕ٘بييس. NC50 (4 1/2 IF)ثط ضٚي  .5

6. 10% Wear  ضا ا٘شربة وطزٜ ، آٖ ضا وكيسٜ ٚ ثط ضٚي ٕ٘بزBHA س.ضٞب وٙي 

 ٔكبٞسٜ ٔي وٙيس ثبيس ٔكبثٝ سهٛيط ظيط قسٜ ثبقس.  Panel #2ضقشٝ حفبض افمي وٝ زض 

 

 BHAشذيطٜ يه  -5ثرف

 سبٖ ضا شذيطٜ وٙيس. .BHAزض ايٗ ٔطحّٝ ػبللا٘ٝ اؾز وٝ 

1. <No Name>  ضا زض ثبلايBHA  ٚالغ زضPanel #2 .ا٘شربة ٕ٘بييس 

 زاضيس ثٙٛيؿيس. BHAضاثُٝ ثب ٞط سٛييحي زض  Panel #3ٚالغ زض  Remarkزض لؿٕز  .2

 ٘ىشٝ: لؿٕز ٞبي زيٍط غيط لبثُ ٚيطايف ٔي ثبقٙس.
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 ٕ٘بيف زازٜ ٔي قٛز. Save BHA Asضا ا٘شربة ٕ٘بييس. دٙدطٜ  Save Asٌعيٙٝ  Fileاظ  ٔٙٛ  .3

 ثؿٍ زٞيس. Zeus > A. Structure > W-13 > B-13 > Planدبيٍبٜ زازٜ ٞبي دطٚغٜ ضا زض ٔؿيط  .4

 ضا سبيخ ٕ٘بييس. Save BHA As  ،BHA (Horizontal)دطٜ زض لؿٕز ثبلاي دٙ .5

 <No Name>٘بْ دٛقٝ اظ  Panel #2  ٚPanel #3ثطٌطزيس. زض  BHA Editorوّيه وطزٜ سب ثٝ نفحٝ  OKثط ضٚي زوٕٝ  .6
 سغييط يبفشٝ اؾز. BHA (Horizontal)ثٝ 

 

اٌط ٘بْ ٔكبثٟي ثب ٘بْ ا٘شربثي قٕب ٚخٛز زاقشٝ ثبقس ديبْ ذُبي  ٞبي ثب ٘بْ سىطاضي ثجز وٙيس.BHAقٕب ٕ٘ي سٛا٘يس  BHA Editorزض ٘ىشٝ: 
 ٕ٘بيف زازٜ ٔي قٛز وٝ ثٝ قٕب اذُبض ٔي زٞس شذيطٜ وطزٖ قٕب سطسيت اثط زازٜ ٕ٘ي قٛز.

 BHA Reportsايدبز  -6ثرف

Schematic Report 

 ثٝ آٖ ضا ايدبز وٙيس. ٚ اَلاػبر ٔطثٌٛ BHAقٕب ذٛاٞيس آٔٛذز وٝ چٍٛ٘ٝ ٌعاضقي اظ قٕبسيه زض ايٗ ثرف، 

 BHA Schematic Reportضا ا٘شربة ٕ٘بييس. دٙدطٜ  Output > Schematic Reportٔؿيط  BHA Editor اظ دٙدطٜ .1
 ٕ٘بيف زازٜ ٔي قٛز.
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 ٕ٘بيف زازٜ ٔي قٛز. Microsoft Excelزض  BHA Schematic Report وّيه ٕ٘بييس. …Generateثط ضٚي زوٕٝ  .2

 

www.Ir ٕٞطاٜ ثب قٕبسيىي اظ آٖ ٕ٘بيف زازٜ ذٛاٞس قس. BHAزض ٌعاضـ وّيه ٕ٘بييس. ٌعاضقي اظ  Load Current BHAثط ضٚي زوٕٝ  .3
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 Client Logoايبفٝ وطزٖ يه 

 ٕ٘بيف زازٜ ٔي قٛز. Select Logoدٙدطٜ  زض زاذُ ٌعاضـ وّيه ٕ٘بييس. Insert Logoثط ضٚي زوٕٝ  .1

 

 ضا ثيبثيس. asl_logoٚ دٛقٝ  Program Files\Schlumberger\Drilling Office\binثٝ ٔؿيط  .2
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 ٕ٘بيف زازٜ ٔي قٛز. (wmf.*)ايٗ دٙدطٜ فبيُ ٞبي ثب دؿٛ٘س 

،   large_دؿٛ٘س  )وٛچه( ٘كبٖ زٞٙسٜ ا٘ساظٜ وبغص ٌعاضقبر اؾز. small_ دؿٛ٘س زاضاي زٚ ا٘ساظٜ وٛچه ٚ ثعضي ٔي ثبقٙس.ٞب  logo٘ىشٝ: 

 ٔي ثبقس. large logoاٌط فبيّي ٞيچ دؿٛ٘س ا٘ساظٜ اي ٘ساقز آٖ  .ٔي ثبقس  wallmapثب ا٘ساظٜ   logo٘كبٖ زٞٙسٜ 

3. Logo  ،powerplantutorial_small.wmf  ٗضا ا٘شربة ٕ٘بييس. ايlogo  زض ٌٛقٝ ثبلاي ؾٕز چخSchematic 

Report .ثبضٌعاضي ٔي قٛز 

اظ سغييط ا٘ساظٜ ٚ سغييط ٔٛلؼيز ٌعاضـ قٕب ثبيس  ٔي سٛا٘يس ثٝ نٛضر زؾشي ا٘ساظٜ آٖ ضا ثب ؾط سيشط ٌعاضـ ٞٓ ا٘ساظٜ وٙيس. ثؼس٘ىشٝ: 
 قجيٝ ثٝ ٌعاضـ ظيط ثبقس.
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 شذيطٜ وطزٖ يه ٌعاضـ

ثبض ٌعاضي قسٜ، ثٝ  BHA_Drawزض لبِجي ثٝ ػٙٛاٖ  Excel spreadsheetوٝ لجلا َطاحي وطزيس( وٝ زض  BHAثطاي شذيطٜ ايٗ ٌعاضـ )٘ٝ 
 File nameٜ ٚ ػٙٛا٘ي ثطاي وطزٔىب٘ي ضا ثطاي شذيطٜ ا٘شربة  ،ربة ٕ٘بييس. زض دٙدطٜ ثبظ قسٜضا ا٘ش Save Asضفشٝ ٚ ٌعيٙٝ  Excel, Fileٔٙٛي 

 ضا وّيه ٕ٘بييس. Saveسبيخ ٕ٘بييس ؾذؽ وٕٝ 

 ٌعاضـ اؾشب٘ساضز

 زض ايٗ ثرف ٘حٜٛ ايدبز يه ٌعاضـ اؾشب٘ساضز ضا ذٛاٞيس آٔٛذز.

وٝ حبٚي  BHA Standard Reportٕبييس. دٙدطٜ ضا ا٘شربة ٘ Standard Reportضفشٝ ٚ ٌعيٙٝ  Outputثٝ ٔٙٛي  .1
 اَلاػبر الشجبل قسٜ اظ دبيٍبٜ زازٜ ٔي ثبقس ٕ٘بيف زازٜ ٔي قٛز.
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 ٕ٘بيف زازٜ ٔي قٛز. BHA Standard Reportوّيه ٕ٘بييس. دٙدطٜ  Generate ثط ضٚي زوٕٝ
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 ظيط ٔي ثبقس: ثٛزٜ ٚ قبُٔ اَلاػبر component-by-component listingٌعاضـ اؾشب٘ساضز ٔجيٗ 

 ٚظٖ ظيط خبضٞب 

 اثؼبز سثجيز وٙٙسٜ ٞب 

  ٝظاٚيMotor bend housing ٜذٕيسٌي زض اسهبَ سٝ چب ٚ 

  ٝفٛانُ ؾٙؿٛض سب ٔش 

 Bit nozzles count size TFA 

 بٜ ضا ذٛاٞيٓ ؾبذز.ؾبذشٝ ، آٖ ضا زض دبيٍبٜ اَلاػبر شذيطٜ وطزٜ ٚ ٌعاضقي اضائٝ زٞيس. ٞٓ اوٖٙٛ ٞٙسؾٝ حفطٜ چ BHAسجطيه، قٕب ٔٛفك قسيس 
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 ايدبز ٞٙسؾٝ حفطٜ چبٜ -7ثرف

 ضا ذٛاٞيس آٔٛذز. wellbore geometryزض ايٗ ثرف، ٘حٜٛ ايدبز يه 

فطٜ ثبظ ، ... ( ٔي دطزاظيٓ. ٕٞبٖ ضٚقي ، ح riserٍٍٛ٘ي ؾبذز ٞٙسؾٝ حفطٜ چبٜ ) ِِٛٝ خساضي، چثٝ قطح  BHA Editorزض ايٗ ٔطحّٝ اظ آٔٛظـ 

٘يع ٔي سٛا٘يس  wellbore geometryثىبض ٔجطزيٓ زض ايٙدب ٘يع ٔٛضز اؾشفبزٜ لطاض ٔي ٌيطز. ٕٞچٙيٗ ثطاي  BHAؾبظي  وٝ ثطاي ايدبز ٚ شذيطٜ
 ٞطزٚ ٞٙسؾٝ چبٜ ضا زض ٌعاضقبر ذٛز ٔٙظٛض ٔي ٕ٘بيٙس. DrillSAFE  ٚHydraulicsٌعاضقي ايدبز ٕ٘بييس. سٛخٝ ثٝ ايٗ ٘ىشٝ يطٚضي اؾز وٝ 

 اخبظٜ زٞيس ٞٙسؾٝ چبٞي ثب ذهٛنيبر ظيط ضا ايدبز وٙيٓ: Wellbore Geometryثطاي قطٚع وبض ثب 

  ََٛ ٝ10500ِِٛٝ خساضي ث ft  1/4 12ٚ  لُط" (42 lbm/ft) 

  3589ََٛ حفطٜ ثبظ ft  8.5ثٝ لُط" 

 سؼطيف ٞٙسؾٝ حفطٜ چبٜ

 Browse Dataضا ا٘شربة ٕ٘بييس. دٙدطٜ  New Wellbore Geometryٌعيٙٝ  Fileاظ ٔٙٛي  BHA Editorزض ثط٘بٔٝ  .1
ٕ٘بيف زازٜ ٔي قٛز. ثب اؾشفبزٜ اظ ايٗ دٙدطٜ ٔي سٛا٘يس حفطٜ ٔٛضز ٘ظطسبٖ ضا ا٘شربة ٕ٘بييس. ثٝ ايٗ ٚؾيّٝ ثٝ َٛض ذٛزوبض فبنّٝ 

 ( ٚ ػٕك آة زض چبٜ ٞبي زضيبيي سٙظيٓ ٔي ٌطزز.air gapٞٛايي)

ٕ٘بيف زازٜ  Wellbore Geometryدطٜ انّي ا٘دبْ زٞيس آٖ ضا ثجٙسيس. دٙ Browse Dataثسٖٚ ايٙىٝ ا٘شربثي زض دٙدطٜ  .2
زض نٛضسي وٝ ٕٞٝ دُٙ ٞبي ٘كبٖ زازٜ قسٜ زض قىُ ظيط ثطاي قٕب لبثُ ضٚيز ٘جبقٙس لاظْ اؾز سب ا٘ساظٜ نفحٝ ضا ثعضٌشط  ٔي قٛز

 دُٙ ثطاي قٕب ٔيؿط ٌطزز. 3ٕ٘بييس. سب ٔكبٞسٜ ٞط 

 

 Hole Sectionٚاضز وطزٖ اَلاػبر 

 3دُٙ   1دُٙ 2دُٙ 
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 ٚخٛز ٘ساقشٝ ثبقس. Offshoreا٘شربة قسٜ ثبقس ٚ سيىي ثطا  Hole Sectionثب٘ٝ زلز وٙيس وٝ ظ .3

 ضا ثفكبضيس. Tabوّيس  ضا سبيخ وٙيس. 12.25ٔمساض  IDٚ ثطاي ؾشٖٛ  10500.0ٔمساض  Toزض ضزيف زْٚ اظ ؾشٖٛ  .4

 ضا ثفكبضيس. Tabوّيس  ضا سبيخ وٙيس. 8.5ٔمساض  IDٚ ثطاي ؾشٖٛ  14089.0ٔمساض  Toزض ضزيف ؾْٛ اظ ؾشٖٛ  .5

 ايدبز قسٜ اؾز. 2حفطٜ چبٜ زض دُٙ  ٞٓ اوٖٙٛ قٕبسيىي اظ ٘ىشٝ: 

 

 ٚاضز وطزٖ اَلاػبر ثرف ِِٛٝ خساضي

 اظ چبٜ ٔٙظٛض ذٛاٞيٓ وطز. ft 10500ضا ثطاي  "5/8 9زض ايٗ ثرف ِِٛٝ خساضي  .1

 ٛيسضفشٝ ٚاضز ٔؿيط ٕ٘بيف زازٜ قسٜ زض قىُ ظيط ق 1زض دُٙ  Equipment Databaseثٝ لؿٕز  .2
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ضا ا٘شربة وطزٜ ٚ ثب وكيسٖ ٚ ضٞب وطزٖ آٖ ثط ضٚي ٕ٘بز  Drift 8.679 ٌعيٙٝ زاثُ وّيه وطزٜ سب ثبظ قٛز lm/ft 40ثط ضٚي آيشٓ  .3
 ايبفٝ ٕ٘بييس. Wellbore Geometryآٖ ثٝ  

 ٔي قٛز. 3زض دُٙ  Casing String٘ىشٝ : ايٗ وبض ثبػث ظبٞط قسٖ دُٙ 

 ضا سبيخ ٕ٘بييس. 10500ض ٔمسا Bottomزض ضزيف اَٚ ؾشٖٛ  .4
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 ٕ٘بيف زازٜ ٔي قٛز. "1/4 12زض ايٗ ِحظٝ قٕبسيىي اظ ِِٛٝ خساضي زض ثرف 

 ايدبز يه ٌعاضـ ضا ذٛاٞيس آٔٛذز. شذيطٜ ٚ ٞٓ اوٖٙٛ ٔٛفك قسيس ثرف َطاحي ٞٙسؾٝ چبٜ ضا ثٝ دبيبٖ ضؾب٘يس زض ازأٝ ٘حٜٛ

 ايدبز يه ٌعاضـ ٞٙسؾي

 ضا ا٘شربة ٕ٘بييس سب دٙدطٜ ظيط ٕ٘بيف زازٜ قٛز. Wellbore Geometry Reportٌعيٙٝ  Outputاظ ٔٙٛي  .1
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 وّيه وٙيس سب اَلاػبر ٌعاضـ ضا دط وٙس. Get Infoٕ٘بيف زازٜ ٘كس٘س ثط ضٚي زوٕٝ  زض ايٗ دٙدطٜ فطو اٌط اَلاػبر ديف .2

 وّيه وٙيس سب ٌعاضقي ٔب٘ٙس سهٛيط ايدبز قٛز.  Generateثط ضٚي زوٕٝ  .3

 

 ٝ چبٜشذيطٜ وطزٖ ٞٙسؾ

ٕ٘بيف زازٜ  Save Geometry Asضا ا٘شربة ٕ٘بييس. دٙدطٜ  Save Asضفشٝ ٌعيٙٝ  Fileثٝ ٔٙٛي  BHA Editorزض ثط٘بٔٝ  .1
 ٔي قٛز.

قٛيس. زض لؿٕز ذبِي زض ثبلاي ايٗ دٙدطٜ  Zeus > A. Structure > Slot #13 > W-13 > B-13 > Planٚاضز قبذٝ  .2
 ػٙٛاٖ  ضا سبيخ ٕ٘بييس.
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 وّيه ٕ٘بييس. OKثط ضٚي زوٕٝ  .3

 سغييط يبفشٝ اؾز. Tutorial Well Geometry #1ثٝ  <No Name>٘بْ ٕ٘بيف زازٜ قسٜ زض دُٙ ؾٕز ضاؾز  ٞٓ اوٖٙٛ اظ ٘ىشٝ: 

 Survey Editorآٔٛظـ 
 ٕ٘بيي وّي

  وّيبر آٔٛظـٕ٘بيي اخٕبِي اظ 

 ديف اظ قطٚع 

  ٖثبظ وطزSurvey Editor 

 سهحيح سٙظيٕبر ديف فطو 

  ٚاضز وطزٖ يهSurvey 

  ايدبز يهSurvey خسيس 

 کليات آموصشنمایی اخمالی اص  -1بخش 
Survey Editor  ثط٘بٔٝ اي اؾز وٝ قٕب ضا زض ٔسيطيزdirectional survey .زض ايٗ ثرف ٘حٜٛ ايدبز  ٞب يبضي ٔي ضؾب٘سPlan View ٞب

 ٚVertical Section view ٞب اظsurvey  ٚWall Map  ا ذٛاٞيس آٔٛذز.سطويجي اظ ٘مكٝ ٞبي حفبضي ضيب 

ضا ٘هت وطزٜ ايس ثب  Drilling Officeٞبي وٝ زض ايٗ ثرف آٔٛظقي اؾشفبزٜ قسٜ ضا زض ٔحّي وٝ فبيُ ٞبي survey٘ىشٝ: قٕب ٔي سٛا٘يس ٕ٘ٛ٘ٝ 
 C:\Program Files\Schlumberger\Drilling Office\bin\asl_dataثيبثيس. ثٝ ػٙٛاٖ ٔثبَ  asl_data٘بْ 
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 کشدن پيش اص ششوع – 2بخش 
ضا ايدبز وطزٜ ايس.  DataBrowserؾّؿّٝ ٔطاست ٔطثٌٛ ثٝ ٚ  Field, Structureزض ايٗ ثرف اظ آٔٛظـ فطو ضا ثط آٖ ٌصاقشيٓ وٝ قٕب 

 (measured depth, inclination and azimuth)وٝ قبُٔ اَلاػبسي  Exceثب فطٔز  surveyٕٞچٙيٗ فطو قسٜ وٝ قٕب  ثٝ فبيُ 
 .ٔي ثبقس زؾز ضؾي زاضيس

 Survey Editorباص کشدن   -3بخش 
 ٚ  چٍٍٛ٘ي سغييط ٌعيٙٝ ٞب ، ثٝ قٕب آٔٛظـ زازٜ ٔي قٛز. Survey Editorزض ايٗ ثرف ٘حٜٛ ثبظ وطزٖ 

 < Schlumbergerضفشٝ ٚ ٔؿيط   Startثطاي قطٚع وبض ثب ثط٘بٔٝ لاظْ اؾز سب اثشسا ثط٘بٔٝ ضا ثبظ وٙيس اظ ٕٞيٗ ضٚ ثٝ ٔٙٛي  .1

Drilling Office > Survey Editor .ضا ا٘شربة ٕ٘بييس 

ٕ٘بيف زازٜ  Select Tie-In Pointضا ا٘شربة ٕ٘بييس. دٙدطٜ  Newٌعيٙٝ  Fileوّيه وٙيس يب اظ ٔٙٛي  ثط ضٚي آيىٗ  .2
 ٔي قٛز.

 

 ٕ٘بيف زازٜ ٔي قٛز. Select Tie-In Borehole، وّيه ٕ٘بييس. دٙدطٜ ثط ضٚي زوٕٝ خؿشدٛ  .3

 ٍبٜ زازٜ دطٚغٜ ضا ثؿٍ زٞيس.دبي +ثب وّيه ثط ضٚي ػلأز  .4

 ثؿٍ زٞيس.  Zeusقبذٝ ضا ثٝ ٔيساٖ  +ثب وّيه ثط ضٚي ػلأز  .5

 زض لؿٕز ػٙٛاٖ ٕ٘بيف زازٜ ٔي قٛز. B-13ثؿٍ زٞيس ،   W-13 قبذٝ ضا ثٝ +ثب وّيه ثط ضٚي ػلأز  .6

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   124 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

 Boreholeزض  B-13 يس ػٙٛاٖثبظ ٌطزيس. زض ايٗ ِحظٝ ثب Set Tie-in Pointوّيه ٕ٘بييس سب ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .7
 ٕ٘بيف زازٜ قٛز.

 

 ٕ٘بيف زازٜ ٔي قٛز. Save Asوّيه وٙيس. دٙدطٜ  OKثط ضٚي زوٕٝ  .8

 ضا سبيخ ٕ٘بييس. Survey #1زض لؿٕز ػٙٛاٖ  .9

 ٔٛضز ٘ظط ضا ا٘شربة ٕ٘بييس. Plan  ،Planثب وّيه ثط ضٚي  .12
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 بظ ذٛاٞيس ٌكز.ث Survey Editorثٝ دٙدطٜ انّي س. يوّيه ٕ٘بي OKثط ضٚي زوٕٝ  .11

 ٚاضز قسٜ ا٘س. Horizontal Reference  ٚElevation Referenceٔمبزيط ٘ىشٝ: 
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 تصحيح تنظيمات پيش فشض -4بخش 
ضا  قىُ فٛق ثؿشٝ ثٝ ديىط ثٙسي ؾيؿشٓ ، ٚيٛح نفحٝ ٕ٘بيف ،... ٕٔىٗ اؾز وٕي ٔشفبٚر ثبقس. اٌط ٕٞٝ ؾشٖٛ ٞبي وٝ زض سهٛيط ثبلا ٚخٛز زاض٘س

زض ؾيؿشٓ ذٛز ثجيٙيس خبي ٍ٘طا٘ي ٘يؿز، ايٗ أطي ػبزي ٔي ثبقس وٝ ٔي سٛا٘يس ثب ثعضي وطزٖ ا٘ساظٜ دٙدطٜ ثط ايٗ ٔكىُ فبئك آييس. ٕ٘ي سٛا٘يس 
 قطٚع وٙيٓ اخبظٜ زٞيس ٘حٜٛ سٙظيٓ ٌعيٙٝ ٞبي ديف فطو ضا ثٝ َٛض ٔرشهط ثطايشبٖ قطح زٞٓ. Survey Editorديف اظ آ٘ىٝ وبض ضا ثب 

 ضا ا٘شربة ٕ٘بييس. Display Formatsعيٙٝ ٌ Formatاظ ٔٙٛي  .1

 

 

سؼساز ػساز ػكبضي وٝ زض ثطٌٝ وبض  ٕ٘بيف زازٜ ٔي ٕ٘بيف زازٜ ٔي قٛز. ثب ثٟطٜ ٌيطي اظ ايٗ دٙدطٜ ٔي سٛا٘يس  Display Formatدٙدطٜ  .2
 قٛز ضا سٙظيٓ ٕ٘بييس.

 ضا ثفكبضيس. OKسغييطار ٔٛضز ٘ظطسبٖ ضا اػٕبَ وطزٜ ؾذؽ زوٕٝ  .3
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 Options > Preferences > DLS Course Length(DLL)ثٝ ٔؿيط  DLS Course Lengthٜ ديف فطو ثطاي ٔكبٞس .4
 ثطٚيس.
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 ٔي ثبقس. m 30ٚ ٔشطيه  ft 100٘ىشٝ: ٔمساض ديف فطو ثطاي ؾيؿشٓ ٚاحس اٍّ٘يؿي 

 

 Computationزض دٙدطٜ  surveyٚ ٔسَ ذُبي اثعاض  surveyوّيه ٕ٘بييس. ضٚـ ديف فطو ٔحبؾجٝ  OKثط ضٚي زوٕٝ  .5

Methods .٘كبٖ زازٜ ٔي قٛز 

 Directional Surveyقٛيس. دٙدطٜ  ...Options > Preferences > Computation Methodsٚاضز ٔؿيط  .6

Computation Methods .ٕ٘بيف زازٜ ٔي قٛز 
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  Survey tool error modelثٛزٜ ٚ ٞيچ ٔسِي ثطا   ضٚـ ٔحبؾجٝ ثطايثٝ  Minimum curvature ثٝ َٛض ديف فطو  ٘ىشٝ:

 ا٘شربة ٕ٘ي قٛز.

ضا ا٘شربة  SLB ISCWSAثط ضٚي زوٕٝ خٟز زاض وّيه وطزٜ ٚ اظ ِيؿز وكٛيي ٌعيٙٝ  Survey Tool Error Modelزض لؿٕز  .7

 وّيه ٕ٘بييس. OKٕ٘بييس. ثط ضٚي زوٕٝ 

 ٕ٘بيف زازٜ ٔي قٛز. Limitsضا ا٘شربة ٕ٘بييس. دٙدطٜ  Options > Preferences > Limitsٔؿيط  .8

 

 ٔٙظٛض ٔي ٌطزز. Limitsوٝ ٔي سٛا٘يس زض ٔحبؾجبر اؾشفبزٜ وٙيس زض دٙدطٜ  inclination٘ىشٝ: ٔبوؿيْٕٛ 

 وّيه وٙيس. OKثط ضٚي زوٕٝ  .9

 ضا ا٘شربة ٕ٘بييس. Page Setupٌعيٙٝ  File اظ ٔٙٛي .12
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 شربة ٕ٘بييس.ا٘ Page Setup٘ىشٝ: ٘حٜٛ لطاض ٌيطي ٚ ا٘ساظٜ نفحٝ ثطاي َطح ٞب ضا ٔي سٛا٘يس اظ دٙدطٜ 
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Plan View, Vertical Section  ٚDrilling Map  ٍٕٞي ٔي سٛا٘ٙس ثٝ َٛض ٔؿشمُ اظ يه زيٍط ا٘شربة قٛ٘س. ػلاٜٚ ثط ايٗ ثٝ َٛض
وّيه  OKا٘شربة قسٜ وٝ ا٘ساظٜ يه ٘مكٝ زيٛاضي ٔؼِٕٛي ٔي ثبقس.  ثط ضٚي زوٕٝ  Drill Map  ،E-Size ديف فطو ا٘ساظٜ نفحٝ ثطاي 

 ب سٙظيٕبر ضا ثٝ ٕٞبٖ نٛضر وٝ ٞؿشٙس دصيطفشٝ ثبقيس.س ٕ٘بييس

ؾيؿشٓ  اظ ا٘شربة ٚلاظْ اؾز سب ؾيؿشٓ ٚاحس ضا ٘يع ٔلاحظٝ ثؼس اظ آ٘ىٝ سٙظيٕبر ديف فطو ضا ٔكبٞسٜ ٚ زض نٛضر ٘يبظ سهحيحبسي ضا اػٕبَ وطزيس 
 ٚاحس ٔٙبؾت إَيٙبٖ حبنُ ٕ٘بييس.

 وّيه ٕ٘بييس. Unit Systemثط ضٚي  زوٕٝ خٟز زاض زض ؾٕز ضاؾز  لؿٕز  .11

 ضا ا٘شربة ٕ٘بييس. Englishاظ ِيؿز وكٛيي ثبظ قسٜ  .12

ؾيؿشٓ ٚاحس نحيحي ا٘شربة قسٜ ثبقس. چطا وٝ اٌط زازٜ ٞبي انّي زض  survey٘ىشٝ: ثؿيبض ٟٔٓ اؾز وٝ لجُ اظ ٚاضز ٚ شذيطٜ وطزٖ  زازٜ ٞبي 

ٞب زچبض سغييط قٛز. ِصا سىٕيُ ٔطحّٝ ٔصثٛض زض حيٗ وبض ثؿيبض ؾرز  surveyٚاحس زيٍطي ا٘ساظٜ ٌيطي قسٜ ثبقٙس ٕٔىٗ اؾز ٚيػٌي ٞبي انّي 
 ٔي قٛز.

 surveyٚاضز وطزٖ يه  -5ثرف 

 Import Utilityاؾشفبزٜ اظ 

 ٞب ضا ذٛاٞيس آٔٛذز. surveyضاٜ ٞبي ٔرشّف ٚاضز وطزٖ زض ايٗ زضؼ، 

 ٕبيف زازٜ ٔي قٛز.٘ Import Surveyضا ا٘شربة ٕ٘بييس. دٙدطٜ  Importٌعيٙٝ  Fileاظ ٔٙٛي  .1
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ثط٘بٔٝ( ٚ ثط ضٚي  CDقسٜ ) ثط ضٚي  drilling office\doc\PowerPlan\Tutorials\dataٚاضز ٔؿيط  .2

Survey_1.xls .زاثُ وّيه ٕ٘بييس. دٙدطٜ ُٔبثك سهٛيط ظيط ٕ٘بيف زازٜ ٔي قٛز 

 

 ٛي ذُبي ظبٞط ذٛاٞس قس.فبيّي وٝ ثبظ قسٜ ضا ٘جبيس ثب ثط٘بٔٝ زيٍطي ثبظ قٛز زض غيط ايٗ نٛضر زيبِ٘ىشٝ: 

 وّيه ٕ٘بييس سب وبض ازأٝ يبثس. Yesثط ضٚي زوٕٝ  .3

 Surveyثبضٌعاضي ذٛاٞس قس ٚ ٔمبزيط سٕبٔي ؾشٖٛ ٞب ٔحبؾجٝ ٚ ٔٙظٛض ٔي ٌطز٘س ثٝ غيط اظ ؾشٖٛ  Survey Editorفبيُ زض  .4

Tool .وٝ ثبيس ثٝ َٛض زؾشي ٚاضز قٛز 
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 ضا ا٘شربة ٕ٘بييس. Saveٌعيٙٝ  Fileٔٙٛي زض دبيٍبٜ زازٜ اظ  surveyثطاي شذيطٜ ايٗ  .5

 

 ضا ثجٙسيس. Surveyدٙدطٜ  ثبلا ؾٕز ضاؾز،  ثب وّيه وطزٖ ثط ضٚي  .6

 وّيه ٘ىٙيس وٝ ايٗ وبض وُ ثط٘بٔٝ ضا ذٛاٞس ثؿز. Survey Editorُٔؼّك ثٝ دٙدطٜ انّي  ٔطالت ثبقيس ثط ضٚي ٘ىشٝ: 

 خسيس Surveyايدبز يه  -6ثرف 

 خسيس ضا ذٛاٞيس آٔٛذز. Surveyيدبز يه زض ايٗ زضؼ، ٘حٜٛ ا

 ٕ٘بيف زازٜ قٛز. Set Tie-in Pointوّيه ٕ٘بييس سب دٙدطٜ ثط ضٚي ػلأز  Survey Editorزض دٙدطٜ انّي  .1

 ٕ٘بيف زازٜ ٔي قٛز. Select Tie-In Boreholeوّيه ٕ٘بييس. دٙدطٜ  ثط ضٚي زوٕٝ خؿشدٛ  .2

 قٛيس. Zeus > A. Structure > W-13 > B-13بييس. ٚاضز ٔؿيط ثطاي ثؿٍ قبذٝ دطٚغٜ ثط ضٚي ػلأز + وّيه ٕ٘ .3

ٕ٘بيف زازٜ  B-13ػٙٛاٖ  Boreholeثط ٔي ٌطزيس . زض لؿٕز  Set Tie-in Pointوّيه ٕ٘بييس. ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .4
 ٔي قٛز.

 ٕ٘بيف زازٜ ٔي قٛز. Save Asدٙدطٜ  .5

 يخ ٕ٘بييس.سب Tutorial Surveyزض لؿٕز ذبِي زض ثبلاي دٙدطٜ ػٙٛاٖ  .6

7. Plan .ٔٛضز ٘ظطسبٖ ضا ا٘شربة ٕ٘بييس 

www.Ir وّيه ٕ٘بييس. OKثط ضٚي زوٕٝ  .8
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لجُ اظ ايٙىٝ قطٚع ثٝ ٚاضز وطزٖ اَلاػبر وٙيس چه وٙيس وٝ ؾيؿشٓ ٚاحس نحيح ضا ا٘شربة وطزٜ ثبقيس. زض ايٗ آٔٛظـ ؾيؿشٓ ٚاحس  .9
English .اؾشفبزٜ قسٜ اؾز 

 ضا ثطاي آٖ سبيخ ٕ٘بييس. 50ضفشٝ ٚ ػسز  MD (measured depth)بِي ظضز ضً٘ ثٝ اِٚيٗ ؾشٖٛ ذ Tabثب اؾشفبزٜ اظ وّيس  .12

 ضا ثطاي آٖ سبيخ ٕ٘بييس. 0.05ضفشٝ ٚ ػسز  INCLثٝ اِٚيٗ ؾشٖٛ  Tabثب اؾشفبزٜ اظ وّيس  .11

 ضا ثطاي آٖ سبيخ ٕ٘بييس. 148.5ضفشٝ ٚ ػسز  Azimثٝ اِٚيٗ ؾشٖٛ  Tabثب اؾشفبزٜ اظ وّيس  .12

 فكبض زازٜ سب سٕبٔي ٔمبزيط ضزيف زْٚ ٔحبؾجٝ قٛ٘س. Tabيب  Enterوّيس  Azimuthٖ زازٜ ثؼس اظ ٚاضز وطز٘ىشٝ: 

 ٚاضز ٕ٘بييس. 3ٔمبزيط ٔٛخٛز زض خسَٚ ظيط ضا زض لؿٕز ٞبي ٔٙبؾت ٚاضز ٕ٘بييس. ايٗ اَلاػبر ضا اظ ضزيف  .13

Azimuth Inclination Measured Depth Row 
51.0 0.10 100 3 
49.0 0.25 150 4 
26.0 0.20 200 5 
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 وبُٔ ٔي وٙيس ثٝ َٛض ذٛز وبض سٕبٔي ٔمبزيط ضٚي  ثطٌٝ وبض ٔحبؾجٝ ٚ ٔٙظٛض ٔي ٌطز٘س. Survey Editorضزيفي ضا زض ٘ىشٝ: ٞط ظٔبٖ وٝ قٕب 

 

 ضا ا٘شربة ٕ٘بييس. Saveضفشٝ ٚ ٌعيٙٝ  Fileثطاي شذيطٜ ايٗ اَلاػبر ثٝ ٔٙٛي  .14

 Well Designآٔٛظـ 
 ٕ٘بيي وّي

  وّيبر آٔٛظـثط ٍ٘بٞي اخٕبِي 

 وطزٖ ديف اظ قطٚع 

  ٖثبظ وطزWell Design 

 َٜطاح ضيعي چب 

 ظزٖ ثٝ اٞساف ثب اؾشفبزٜ اظ يه دطٚفيُ اؾشب٘ساضز 

  ٚ اٞساف ؾبظ٘س ثٝ َطحايبفٝ وطزٖ ِِٛٝ خساضي 

 وّيبر آٔٛظـٍ٘بٞي اخٕبِي ثط  -1ثرف 

Well Design َطح چبٜ ٛا٘يس َطح چبٜ ديكٟٙبزي ضا ايدبز ٕ٘بييس. زض ايٗ آٔٛظـ ثط٘بٔٝ اي اؾز وٝ قٕب ٔي سٛا٘يس ثب اؾشفبزٜ اظ آٖ ٔي س
 Plan View, Vertical Sectionايدبز ٔي وٙيٓ. ٕٞچٙيٗ ذٛاٞيس آٔٛذز وٝ چٍٛ٘ٝ يه  Schlumbergerديكٟٙبزي ضا، ثٝ ؾفبضـ 

View  يه ٚWall Map   يب Drilling Map (  وٝ سطويتPlan View  ٚVertical Section view  ٖثطاي چبٜ ديكٟٙبزيشب )ٔي ثبقس
 ايدبز ٕ٘بييس.

 ديف اظ قطٚع وطزٖ -2ثرف 

 ضا ايدبز وطزٜ ايس. DataBrowserٚ ؾّؿّٝ ٔطاست ٔطثٌٛ ثٝ  Field, Structureزض ايٗ ثرف اظ آٔٛظـ فطو ضا ثط آٖ ٌصاقشيٓ وٝ قٕب 
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 Well Designثبظ وطزٖ  -3ثرف

 وّيه ٕ٘بييس. قسٜ ٚ ثط ضٚي آيىٗ  Start >      > Well Designٚاضز ٔؿيط  Well Designثطاي ثبظ وطزٖ  .1

 ضا ثطاي اِٚيٗ ثبض ثبظ ٔي وٙيس ٞيچ وبضثطٌي زض آٖ ٚخٛز ٘ساضز. Well Designٚلشي وٝ ٘ىشٝ: 

ٕ٘بيف زازٜ  Select Tie-In Pointضا ا٘شربة وٙيس. دٙدطٜ  Newٌعيٙٝ  Fileوّيه ٕ٘بييس يب اظ ٔٙٛي  ثط ضٚي آيىٗ  .2
 ٔي قٛز.

 

 ٕ٘بيف زازٜ ٔي قٛز. Select Tie-In Borehole، وّيه ٕ٘بييس. دٙدطٜ ثط ضٚي زوٕٝ خؿشدٛ  .3

 دبيٍبٜ زازٜ دطٚغٜ ضا ثؿٍ زٞيس. +ثب وّيه ثط ضٚي ػلأز  .4

 ثؿٍ زٞيس.  Zeusقبذٝ ضا ثٝ ٔيساٖ  +ثب وّيه ثط ضٚي ػلأز  .5

 ػٙٛاٖ ٕ٘بيف زازٜ ٔي قٛز.زض لؿٕز  B-13ثؿٍ زٞيس ،   W-13 قبذٝ ضا ثٝ +ثب وّيه ثط ضٚي ػلأز  .6
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 Boreholeزض  B-13 ثبظ ٌطزيس. زض ايٗ ِحظٝ ثبيس ػٙٛاٖ Set Tie-in Pointوّيه ٕ٘بييس سب ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .7
 ٕ٘بيف زازٜ قٛز.

 

 ٕ٘بيف زازٜ ٔي قٛز. Save Asوّيه وٙيس. دٙدطٜ  OKثط ضٚي زوٕٝ  .8

 ضا سبيخ ٕ٘بييس. WD_Tutorial #1زض لؿٕز ػٙٛاٖ  .9

12. Execute  ٕٝٔٛضز ٘ظطسبٖ ضا ا٘شربة وٙيس. ثط ضٚي زوOK  وّيه ٕ٘بييس. ثٝ دٙدطٜ انّي Well Design .ثبظ ذٛاٞيس ٌكز 
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 ٘ىشٝ: ٕٔىٗ قىُ ثبلا ضا  ثؿشٝ ثٝ چيسٔبٖ ؾيؿشٓ يب ا٘ساظٜ دٙدطٜ ،ثط٘بٔٝ ثٝ ٌٛ٘ٝ اي ٔشفبٚر زض ؾيؿشٓ سبٖ ثجٙيس قٛز.

 َطاح ضيعي چبٜ -4ثرف 

ٞب ضا سٙظيٓ ٕ٘بييس. ثطاي آقٙبي ثب ٘حٜٛ ايٗ سٙظيٕبر ثٝ ثرف optionثؼًي اظ ٚع ثٝ ؾبذز يه چبٜ وٙيس. قبيس ثرٛاٞيس ديف اظ آٖ وٝ قط
 ٔطاخؼٝ فطٔبييس. Survey Editorآٔٛظقي 

اض ٚاحس زض ثبلاي لجُ اظ ايٙىٝ قطٚع ثٝ سبيخ ٞط ػسزي زض وبضثطي وٙيس ُٕٔئٗ قٛيس وٝ زض حبَ وبض ثب ؾيؿشٓ نحيحي ٔي ثبقيس. ثٝ ٘ٛاض اثع

ثٛز ، قٕب زض حبَ وبض ثب ؾيؿشٓ نحيح زض ايٗ ثرف آٔٛظقي ٞؿشيس زض غيط ايٗ نٛضر ثب وّيه ثط ضٚي زوٕٝ  Englishوبضثطي ٍ٘بٜ وٙيس اٌط 
ضا  Englishخٟز زاض ٔٛخٛز زض ؾٕز ضاؾز  فيّس ؾيؿشٓ ٚاحس؛ ِيؿز وكٛيي ثطاي قٕب ٌكٛزٜ ٔي قٛز وٝ ٔي سٛا٘يس اظ آٖ ِيؿز ؾيؿشٓ ٚاحس 

 ا٘شربة ٕ٘بييس.

 ٔي سٛا٘يس َطح ضيعي چبٜ ضا قطٚع ٕ٘بييس. حبَ

 Wellسؼطيف ٕ٘بييس. اظ ٘ٛاض اثعاض  ft 1148ضا زاضيس ، ػٕك ا٘ساظٜ ٌيطي قسٜ ثرف ػٕٛزي حفطٜ ضا  tie-inقٕب ٘مُٝ وٝ  حُ .1

Design Editor  ٗثط ضٚي آيىHold Station   ٜوّيه وٙيس. دٙدطHold Dialog زٜ ٔي قٛز.ٕ٘بيف زا 
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 )ديف فطو( ا٘شربة قسٜ ثبقس. MDوٝ زوٕٝ  ثطضؾي وٙيس .2

 KOPآٖ  commentوّيه ٕ٘بييس. ايٗ وبض ضزيف زيٍطي ضا ثٝ ثطٌٝ وبض قٕب ايبفٝ ٔي وٙس وٝ زض لؿٕز  OKثط ضٚي زوٕٝ  .3

(Kick-off Point)  زضج ٌطزيسٜ اؾز. لؿٕزMD (Measured Depth)  ٜكرم ٔي ٔزض ايٗ ضزيف ثٝ نٛضر ا٘شربة قس
 ثبقس.

 

ضا ثفكبضيس. ثب ايٗ وبض ٔمبزيط زيٍط وبضثطي ٔحبؾجٝ ٚ ٔٙظٛض ٔي ٌطز٘س )  tabضا سبيخ وطزٜ ٚ وّيس  1148.00ٔمساض  MDزض لؿٕز  .4

 ٔي قٛز.(. ft 1148.00ثطاثط  TVDٔثلا 
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 ُ اؾشب٘ساضزٚفيثٝ اٞساف ثب اؾشفبزٜ اظ يه دط ظزٖ -5ثرف 
يه دطٚفيُ اؾشب٘ساضز ٔٙحٙي قىُ ضا ذٛاٞيس آٔٛذز. زض ايٗ ٔٛضز يه چبٜ ثٝ  اظ ديف سؼييٗ قسٜ ثب اؾشفبزٜ اظ٘حٜٛ ظزٖ ثٝ اٞساف زض ايٗ زضؼ 

 زض آٔسٜ اؾز. 3D-Sقىُ 

 Standardوّيه ٕ٘بييس. دٙدطٜ   Standard Profilesثط ضٚي آيىٗ  Well Design Editorاظ ٘ٛاض اثعاض  .1

Profiles .ٕ٘بيف زازٜ ٔي قٛز 

ٞط ظٔبٖ وٝ ثرف  End Curve Before Targetچه ثبوؽ  ضا ا٘شربة ٕ٘بييس. Curve, Hold, Curve (S-3D)زوٕٝ  .2
S-2D   يب S-3D ٜاظ دٙدطStandard Profiles .ا٘شربة قٛ٘س فؼبَ ٔي ٌطزز. ٕٞب٘ٙس قىُ ٘كبٖ زازٜ قسٜ زض ظيط 
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 ٕ٘بيف زازٜ ٔي قٛز. Targetsدطٜ وّيه ٕ٘بييس. دٙ OKثط ضٚي زوٕٝ Curve, Hold, Curve (S-3D)ثطاي سبييس حبِز  .3

 

فٝ ٕ٘بييس. قٕب ٔي سٛا٘يس ثطاي ظزٖ ثٝ ٔطوع ٘ىشٝ: زض ايٗ دٙدطٜ ِيؿشي اظ اٞساف ٕ٘بيف زازٜ ٔي قٛز ٚ قٕب ٔي سٛا٘يس اٞسافي ضا ثٝ آٖ ايب

  .ٚاضز وٙيس X-Offset  ٚY-Offsetثٝ ٚؾيّٝ ٔمبزيط ٔٙبؾت  ٞسف ٔرشهبسي

These values position the point  at which the proposal will pass through the target relative to 
the target center and in un-rotated coordinates. 

 ثٙب ثط ايٗ آٟ٘ب ضا ثطاي ظزٖ ثٝ ٔطوع ٞسف ا٘شربة ٕ٘بييس.ثبلي ثٕب٘ٙس.  0ايٗ ٔمبزيط ضا سغييط ٘سٞيس. آٟ٘ب ثبيس زض 
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آٖ إَيٙبٖ حبنُ وٙيس. ثٝ ػٙٛاٖ  نحزضا ز٘جبَ وٙيس ٕٔىٗ اؾز ثرٛاٞيس خعئيبر ٞسف ضا ثطضؾي ٕ٘بييس سب اظ  ٘ىشٝ: ديف اظ آ٘ىٝ ازأٝ آٔٛظـ

 ٘ؿجز ثٝ ؾُح ٔجٙبي وٝ زض ثبلاي وبضثطي ٌٛقٝ ؾٕز ضاؾز لطاض زاضز ٔحبؾجٝ ٔي قٛز.TVD ٔثبَ ، سٛخٝ وٙيس وٝ 

 آٖ ضا ا٘شربة ٕ٘بييس. Target #1ثب وّيه وطزٖ ثط ضٚي  .4

 . ٕٞب٘ٙس قىُ ظيطS-3Dوّيه ٕ٘بييس. خعئيبر ٞسف ثٝ َٛض ذٛزوبض زض وبضثطي ثبضٌعاضي ٔي قٛز زض يه دطٚفيُ  OKي زوٕٝ ثط ضٚ .5

 

 ٘ىشٝ: ثٝ ذبَط زاقشٝ ؾَّٛ ٞبي وٝ ثب ضً٘ ظضز دط قسٜ ا٘س آيشٓ ٞبي ٞؿشٙس وٝ ٔي سٛاٖ ٚاضز يب انلاح وطز.

ضا ٚاضز وطزٜ  2.50ٔمساض  EOC #1اظ ضزيف  DLSانبثز لطاض زٞيٓ. زض ؾشٖٛ زض ايٗ آٔٛظـ ٔي ذٛاٞيٓ ٞسف ضا ثٝ َٛض افمي ٔٛضز  .6

 ضا ثفكبضيس. tabٚ وّيس 

 ضا ثفكبضيس. tabضا ٚاضز وطزٜ ٚ وّيس  5ٔمساض   Target #1اظ ضزيف  DLSزض ؾشٖٛ  .7
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 ذبِي ثٍصاضيس. 5ضا زض ضزيف  Inclination  ٚAzimuth٘ىشٝ: ؾشٖٛ ٞبي 

 ٕ٘بيف زازٜ ٔي قٛز. Standard Profilesوّيه ٕ٘بييس. دٙدطٜ  Standard Profileثط ضٚي آيىٗ  .8

ثرف افمي چبٜ ضا سب ضؾيسٖ ثٝ ٞسف ضا ا٘شربة ٕ٘بييس. ايٗ وبض قٕب ضا لبزض ذٛاٞس ؾبذز  Hold or Curve to Targetزوٕٝ  .9
 ثؼسي ٍٟ٘ساضيس.
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 ٕ٘بيف زازٜ ٔي قٛز.  Targetsوّيه وٙيس. دٙدطٜ  OKثط ضٚي زوٕٝ  .12

 

 آٖ ضا ا٘شربة ٕ٘بييس. Target #2يه ثط ضٚي ػٙٛاٖ ثب وّ .11

 وّيه ٕ٘بييس. خعئيبر ٞسف ثٝ َٛض ذٛزوبض زض وبضثطي ثبضٌعاضي ٔي قٛ٘س. OKثط ضٚي زوٕٝ  .12

 

 ضا ثفكبضيس. ايٗ وبض ٔمبزيط زيٍط زض وبضثطي ضا ايدبز ٔي وٙس. tabٚاضز وطزٜ ٚ وّيس  0.0ضا  DLSٔمساض  Target #2ثطاي  .13
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 حفبضي ذٛاٞس قس. Target #2زيٍطي ضا ايبفٝ ٕ٘بييس سب ُٕٔئٗ قٛيس وٝ وُ  holdبظ ذٛاٞيس زاقز وٝ ثرف قٕب ٘ي٘ىشٝ: 

 ٕ٘بيف زازٜ ٔي قٛز. Hold Dialogوّيه ٕ٘بييس. دٙدطٜ   Hold Stationثط ضٚي آيىٗ  .14

 ضا ا٘شربة ٕ٘بييس. MDزوٕٝ  .15

 وّيه وٙيس سب ثٝ وبضثطي ثطٌطزيس. OKثط ضٚي زوٕٝ  .16

 سبيخ ٕ٘بييس. MDضا ثطاي ؾشٖٛ  14089.33ٔمساض  KOPهبني زض ضزيف اذش .17

 ضا ثفكبضيس. ثب ايٗ وبض ٔمبزيط زيٍط زض وبضثطي ٔٙظٛض ٔي قٛز. tabوّيس  .18

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   126 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

 وّيه وٙيس. ضا ا٘شربة ٕ٘بييس يب ثط ضٚي آيىٗ  Saveضفشٝ ٚ ٌعيٙٝ  Fileثطاي شذيطٜ ايٗ َطح ثٝ ٔٙٛي  .19

 ٚ ؾبظ٘س ثٝ َطح ِِٛٝ خساضي ٘كبٍ٘طٞبي ايبفٝ وطزٖ  -6ثرف
ؼ زض ايٗ زضؼ ٘حٜٛ ايبفٝ وطزٖ ٘كبٍ٘طٞبي ؾبظ٘س ٚ ِِٛٝ خساضي ضا ثٝ َطح سبٖ ذٛاٞيس آٔٛذز. ايٗ ٘كبٍ٘طٞب زض ذطٚخي ٌطافيىي اي وٝ زض زض

  ثؼسي ايدبز ذٛاٞيس وطز ، ظبٞط ذٛاٞٙس قس.

وٝ زض اِٚيٗ ؾشٖٛ وبضثطي ثٝ  curve commentچٙس يس زاقز وٝ لجُ اظ ايٙىٝ ٘كبٍ٘طٞبي ِِٛٝ خساضي ٚ ؾبظ٘س ضا ايبفٝ وٙيس، ٘يبظ ذٛاٞ٘ىشٝ: 
 ٘ٛيؿي وٙيس. ثبظزضج ٌطزيسٜ ا٘س ضا  Comment٘بْ 

www.Ir سبيخ ٕ٘بييس. EOC #1 (3D-S)ضا ثٝ خبي  End of Buildوّيه وطزٜ ٚ ػجبضر  3زض ضزيف  Commentثط ضٚي ؾَّٛ  .1
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 .ثؼسي ضا ثبظ ٘ٛيؿي وٙيس commentضا فكبض زٞيس ٚ  tabوّيس  .2

ضا  tabسبيخ ٕ٘بييس. وّيس  KOP #2ضا ثٝ خبي Second Build وّيه وطزٜ ٚ ػجبضر  4زض ضزيف  Commentثط ضٚي ؾَّٛ  .3
 ثفكبضيس.

ضا  tabسبيخ ٕ٘بييس. وّيس  KOPضا ثٝ خبي  End Of Holdوّيه وطزٜ ٚ ػجبضر  7زض ضزيف  Commentثط ضٚي ؾَّٛ  .4
 ثفكبضيس.
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 ؾبظ٘س ٚ ِِٛٝ خساضيشبٖ ، ضزيفي ضا ا٘شربة ٕ٘بييس وٝ زٚؾز زاضيس ٘كبٍ٘ط ضا ثؼس اظ آٖ ٚاضز وٙيس.٘ىشٝ: ثطاي ٚاضز وطزٖ ٘كبٍ٘ط ٞبي 

لطاض  2ٚ  1ؾَّٛ ٔٛخٛز زض ضزيف زْٚ اظ ؾشٖٛ اَٚ ضا ا٘شربة ٕ٘بييس. ايٗ وبض قٕب ضا لبزض ذٛاٞس ؾبذز ٘ب ٘كبٍ٘ط ضا ثيٗ ضزيف ٞبي  .5
 زٞيس.

 ٕ٘بيف زازٜ ٔي قٛز. Insert Stationٕ٘بييس. دٙدطٜ  وّيه  Insert Row/Stationثط ضٚي آيىٗ  .6
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 ضا ا٘شربة ٕ٘بييس. Markerزوٕٝ  .7

 ٕ٘بيف زازٜ ٔي قٛز. Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  OKثط ضٚي زوٕٝ  .8

 

 ضا ا٘شربة ٕ٘بييس. TVDزوٕٝ  Marker Atزض ثرف  .9

 ضا ا٘شربة ٕ٘بييس. Markerزوٕٝ  Marker Typeزض ثرف  .12
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 وّيه ٕ٘بييس. ثٝ وبضثطي ثبظ ٔي ٌطزيس. OK ثط ضٚي زوٕٝ .11

ضا ثطاي ػٕك  ft 110، ٔمساض TVD( آٖ ضا ٚاضز ذٛاٞيٓ وطز. زض ضزيف زْٚ اظ ؾشٖٛ commentٞٓ اوٖٙٛ ػٕك ٘كبٍ٘ط ٚ سٛييح ) .12
 ثؿشط زضيب سبيخ وٙيس.

 ضا زضآٖ سبيخ ٕ٘بييس. Sea Bedضا زض ضزيف زْٚ ا٘شربة وطزٜ ٚ ػجبضر  Commentؾَّٛ  .13
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 وطزٖ ٘كبٍ٘طٞب ثطاي ِِٛٝ خساضي ٚاضز

 ايبفٝ ٔي قٛز. 3ٚ  2. ٘كبٍ٘ط ِِٛٝ خساضي ثيٗ ضزيف ٞبي ؾشٖٛ اَٚ ضا ا٘شربة وٙيس اظ ؾَّٛ ٔٛخٛز زض ضزيف ؾْٛ .1

 ٕ٘بيف زازٜ ٔي قٛز. Insert Stationوّيه ٕ٘بييس. دٙدطٜ   Insert Row/Stationثط ضٚي آيىٗ  .2

 

 ضا ا٘شربة ٕ٘بييس. Markerزوٕٝ  .3

 ٕ٘بيف زازٜ ٔي قٛز. Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  OKي زوٕٝ ثط ضٚ .4

 ضا ا٘شربة ٕ٘بييس. MDزوٕٝ  Marker Atزض ثرف  .5

 ضا ا٘شربة ٕ٘بييس. Casing Point زوٕٝ  Marker Typeزض ثرف  .6
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 ثٝ وبضثطي ثبظ ٔي ٌطزيس. وّيه ٕ٘بييس سب يٕٗ لجَٛ سٙظيٕبر OKثط ضٚي زوٕٝ  .7

ضا  Casing Point "20ٔمساض  Commentاظ ؾشٖٛ  4ضا سبيخ ٕ٘بييس. زض ضزيف  ft 500ٔمساض  MDزض ضزيف ؾْٛ اظ ؾشٖٛ  .8
 سبيخ ٕ٘بييس. KOPثدبي 

 

 ثطاي ايدبز ٘كبٍ٘طٞبي ِِٛٝ خساضي اظ ٔطاحُ ظيط ديطٚي ٕ٘بييس.

 قٛز.ايبفٝ ٔي  4ٚ  3ضا ا٘شربة وٙيس. ٘كبٍ٘ط ِِٛٝ خساضي ثيٗ ضزيف ٞبي  1، ؾشٖٛ 4ؾَّٛ ٔٛخٛز زض ضزيف  .9

 ٕ٘بيف زازٜ ٔي قٛز. Insert Stationوّيه ٕ٘بييس. دٙدطٜ   Insert Row/Stationثط ضٚي آيىٗ  .12

 ضا ا٘شربة ٕ٘بييس. Markerزوٕٝ  .11

 ٕ٘بيف زازٜ ٔي قٛز. Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  OKثط ضٚي زوٕٝ  .12

 ضا ا٘شربة ٕ٘بييس. MDزوٕٝ  Marker Atزض ثرف  .13

 ضا ا٘شربة ٕ٘بييس. Casing Point زوٕٝ  Marker Typeزض ثرف  .14

 وّيه ٕ٘بييس سب يٕٗ لجَٛ سٙظيٕبر ثٝ وبضثطي ثبظ ٔي ٌطزيس. OKثط ضٚي زوٕٝ  .15

  Casing"3/8 13 ٔمساض  Commentاظ ؾشٖٛ  4ضا سبيخ ٕ٘بييس. زض ضزيف  ft 1100.00ٔمساض  MDاظ ؾشٖٛ  4زض ضزيف  .16

Point  .ضا سبيخ ٕ٘بييس 
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 ايبفٝ ٔي قٛز. 8ٚ  7ضا ا٘شربة وٙيس. ٘كبٍ٘ط ِِٛٝ خساضي ثيٗ ضزيف ٞبي  1، ؾشٖٛ 8ؾَّٛ ٔٛخٛز زض ضزيف  .17

٘كبٍ٘ط  وّيه ٕ٘بييس. يه دٙدطٜ ٔحبٚضٜ اي ٕ٘بيف زازٜ ٔي قٛز وٝ ٔٛلؼيز  Insert Row/Stationثط ضٚي آيىٗ  .18

 ٕ٘بيف زازٜ ٔي قٛز. Insert Stationدٙدطٜ وّيه ٕ٘بييس.   Yesضا اظ قٕب ٔي دطؾس ، ثط ضٚي زوٕٝ 

 ضا ا٘شربة ٕ٘بييس. Markerزوٕٝ  .19

 ٕ٘بيف زازٜ ٔي قٛز. Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  OKثط ضٚي زوٕٝ  .22

 ضا ا٘شربة ٕ٘بييس. MDزوٕٝ  Marker Atزض ثرف  .21

 ضا ا٘شربة ٕ٘بييس. Casing Point زوٕٝ  Marker Typeزض ثرف  .22

 ظ ٔي ٌطزيس.وّيه ٕ٘بييس سب يٕٗ لجَٛ سٙظيٕبر ثٝ وبضثطي ثب OKثط ضٚي زوٕٝ  .23

  Casing "5/8 9  ػجبضر Commentاظ ؾشٖٛ  8ضا سبيخ ٕ٘بييس. زض ضزيف  ft 10500.00ٔمساض  MDاظ ؾشٖٛ  8زض ضزيف  .24

Point  .ضا سبيخ ٕ٘بييس 
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 ٞب TVD٘كبٍ٘طٞبي ؾبظ٘س ثطحؿت 

 MSL (Mean Seaضا ثٝ  (Elevation Referenceؾُح ٔجٙب ) لاظْ اؾز زض ايٗ ٔثبَ ديف اظ آ٘ىٝ ٘كبٍ٘طٞبي ؾبظ٘س ضا سؼطيف وٙيس

Level) .سغييط زٞيس 

 وّيه ٕ٘بييس. Elevation Refثط ضٚي زوٕٝ خٟز زاض ٔٛخٛز زض ؾٕز ضاؾز فيّس  .1

 ضا ا٘شربة ٕ٘بييس. Field: MSLاظ ِيؿز وكٛيي  .2

 

 ضا ا٘شربة ٕ٘بييس. 7، اِٚيٗ ؾَّٛ ضزيف  7ٚ  6ثطاي ايبفٝ وطزٖ ٘كبٍ٘ط ؾبظ٘س ثيٗ ضزيف  .3

دطؾكي ثطاي  وّيه ٕ٘بييس. يه دٙدطٜ ٔحبٚضٜ اي ٕ٘بيف زازٜ ٔي قٛز وٝ  Insert Row/Stationثط ضٚي آيىٗ  .4
 لؼيز ٘كبٍ٘ط ضا اظ قٕب ٔي دطؾس.ٔٛ سبييس

 ٕ٘بيف زازٜ ٔي قٛز.  Marker Dialogوّيه ٕ٘بييس. دٙدطٜ   Yesثط ضٚي زوٕٝ  .5

 ضا ا٘شربة ٕ٘بييس. TVDزوٕٝ  Marker Atزض ثرف  .6

 ضا ا٘شربة ٕ٘بييس.Formation Top/Bottom زوٕٝ  Marker Typeزض ثرف  .7

 وّيه ٕ٘بييس سب يٕٗ لجَٛ سٙظيٕبر ثٝ وبضثطي ثبظ ٔي ٌطزيس. OKثط ضٚي زوٕٝ  .8
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ثٝ خبي ضا   Top Alpha ػجبضر Commentضا سبيخ ٕ٘بييس. زض ؾشٖٛ  ft 5845.30ٔمساض  TVDاظ ؾشٖٛ  7زض ضزيف  .9

Formation .سبيخ ٕ٘بييس 

 

 بي ؾبظ٘س اظ ٔطاحُ ظيط ديطٚي ٕ٘بييس.ثطاي ايدبز ٘كبٍ٘طٞ

 ايبفٝ ٔي قٛز. 8ٚ  7ضا ا٘شربة وٙيس. ٘كبٍ٘ط ؾبظ٘س ثيٗ ضزيف ٞبي  1، ؾشٖٛ 8ؾَّٛ ٔٛخٛز زض ضزيف  .12

وّيه ٕ٘بييس. يه دٙدطٜ ٔحبٚضٜ اي ٕ٘بيف زازٜ ٔي قٛز وٝ دطؾكي ثطاي   Insert Row/Stationثط ضٚي آيىٗ  .11
 دطؾس. سبييس ٔٛلؼيز ٘كبٍ٘ط ضا اظ قٕب ٔي

 ٕ٘بيف زازٜ ٔي قٛز.  Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  Question Dialogزض دٙدطٜ   Yesثط ضٚي زوٕٝ  .12

 ضا ا٘شربة ٕ٘بييس. TVDزوٕٝ  Marker Atزض ثرف  .13

 ضا ا٘شربة ٕ٘بييس.Formation Top/Bottom زوٕٝ  Marker Typeزض ثرف  .14

 ثٝ وبضثطي ثبظ ٔي ٌطزيس.وّيه ٕ٘بييس سب يٕٗ لجَٛ سٙظيٕبر  OKثط ضٚي زوٕٝ  .15

ضا ثٝ Top Beta  ػجبضر، 8اظ ضزيف  Commentضا سبيخ ٕ٘بييس. زض ؾشٖٛ  ft 5845.30ٔمساض  TVDاظ ؾشٖٛ  8زض ضزيف  .16
 سبيخ ٕ٘بييس. Formationخبي 

 ايبفٝ ٔي قٛز. 11ٚ  12ضا ا٘شربة وٙيس. ٘كبٍ٘ط ؾبظ٘س ثيٗ ضزيف ٞبي  1، ؾشٖٛ 11ؾَّٛ ٔٛخٛز زض ضزيف  .17

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   136 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

وّيه ٕ٘بييس. يه دٙدطٜ ٔحبٚضٜ اي ٕ٘بيف زازٜ ٔي قٛز وٝ دطؾكي ثطاي   Insert Row/Stationيىٗ ثط ضٚي آ .18
 سبييس ٔٛلؼيز ٘كبٍ٘ط ضا اظ قٕب ٔي دطؾس.

 ٕ٘بيف زازٜ ٔي قٛز.  Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  Question Dialogزض دٙدطٜ   Yesثط ضٚي زوٕٝ  .19

 بة ٕ٘بييس.ضا ا٘شر TVDزوٕٝ  Marker Atزض ثرف  .22

 ضا ا٘شربة ٕ٘بييس.Formation Top/Bottom زوٕٝ  Marker Typeزض ثرف  .21

 وّيه ٕ٘بييس سب يٕٗ لجَٛ سٙظيٕبر ثٝ وبضثطي ثبظ ٔي ٌطزيس. OKثط ضٚي زوٕٝ  .22

 Base of the ،ػجبضر  11اظ ضزيف  Commentضا سبيخ ٕ٘بييس. زض ؾشٖٛ  ft 9648.30ٔمساض  TVDاظ ؾشٖٛ  11زض ضزيف  .23

Cretaceous  ضا ثٝ خبيFormation .سبيخ ٕ٘بييس 

 

 Borehole:RKBوّيه ٕ٘بييس. اظ ِيؿز وكٛيي  Elevation Refثط ضٚي زوٕٝ خٟز زاض ٔٛخٛز زض ؾٕز ضاؾز فيّس  .24

(Rotary Kelly Bushing) .ضا ا٘شربة ٕ٘بييس 

 ٔي قٛز. ٚاضز 12ٚ  11ضا ا٘شربة وٙيس. ٘كبٍ٘ط ؾبظ٘س ثيٗ ضزيف ٞبي  1، ؾشٖٛ 12ؾَّٛ ٔٛخٛز زض ضزيف  .25
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وّيه ٕ٘بييس. يه دٙدطٜ ٔحبٚضٜ اي ٕ٘بيف زازٜ ٔي قٛز وٝ دطؾكي ثطاي   Insert Row/Stationثط ضٚي آيىٗ  .26
 سبييس ٔٛلؼيز ٘كبٍ٘ط ضا اظ قٕب ٔي دطؾس.

 ٕ٘بيف زازٜ ٔي قٛز.  Marker Dialogوّيه ٕ٘بييس. دٙدطٜ  Question Dialogزض دٙدطٜ   Yesثط ضٚي زوٕٝ  .27

 ضا ا٘شربة ٕ٘بييس. TVDزوٕٝ  Marker Atزض ثرف  .28

 ضا ا٘شربة ٕ٘بييس.Formation Top/Bottom زوٕٝ  Marker Typeزض ثرف  .29

ضا Top Delta ،ػجبضر  12اظ ضزيف  Commentضا سبيخ ٕ٘بييس. زض ؾشٖٛ  ft 10700.30ٔمساض  TVDاظ ؾشٖٛ  12زض ضزيف  .32

 سبيخ ٕ٘بييس. Formationثٝ خبي 

 س.وٙيSave سغييطار وبضثطي ضا   .31

 Close Approachآٔٛظـ 
 آ٘چٝ زض ايٗ ثرف ٔي ذٛا٘يس

 ٍ٘بٞي اخٕبِي 

 ديف اظ قطٚع 

  ٖثبظوطزClose Approach 

  ا٘شربةSubject Well 

  ا٘شربةOffset Well ٞب 

  اخطائ يهProximity Analysis 

 ٝايدبز يه ٌعاضـ ذلان 

 ايدبز يه ٌعاضـ خبٔغ 

 ديف اظ قطٚع
( سٛييح Well Design) َطاحي چبٜوٝ زض آٔٛظـ  proposed well  ،Tutorial #1زاضيس ثٝ ٘يبظ  subject wellثطاي ايٗ آٔٛظقي، 

 Surveyٞبي ٞؿشٙس وٝ زض آٔٛظـ surveyٔمبيؿٝ ٔي وٙيس زض ٔمبثُ  proposed wellٞبي وٝ قٕب ثب offset well زازٜ قسٜ اؾز. 

Editor  چٝ ؾطيغ سط ثبيس ايٗ وبض ضا ا٘دبْ زٞيس. زض نٛضسي وٝ ثب ٞٙٛظ ٘رٛا٘سٜ ايس ٞط ٚاضز وطزيس. اٌط زٚ ثرف آٔٛظقي فٛق ضاWell Design  ٚ

Survey Editor  آقٙبيي وبُٔ زاضيس ٚ ٔي ذٛاٞيس ٔؿشميٕب ٚاضز ايٗ ثرف آٔٛظقي قٛيس. ٔي سٛا٘يس فيّس وّي اؾشفبزٜ قسٜ زض ايٗ ثرف آٔٛظقي

ثيبثيس وٝ لاظْ اؾز آٖ ضا ثب اؾشفبزٜ  drilling office\doc\PowerPlan\Tutorials\data\zeus.pbf ثط٘بٔٝ زض ٔؿيط  CDثط ضٚي  ضا
 ثبضٌعاضي ٕ٘بييس. DataBrowserاظ 

 well proposalضا ثطاي  tool error model  ٚsurvey toolثبيس  ٕ٘بييس  anticollision analysis ثٝ ا٘دبْ ديف اظ آ٘ىٝ قطٚع
(Tutorial #1.ٔكرم ٕ٘بييس ) 

 ظ وٙيس.ضا ثب Well Designثط٘بٔٝ  .1

 ضا زض ثط٘بٔٝ ثبضٌعاضي وٙيس. Zeus >A. Structure > W-13 > B-13 > Plan > Tutorial #1ٔؿيط  .2

ضا   < Computation Methods Preferencesضفشٝ ٚ ٌعيٙٝ  Optionsثٝ ٔٙٛي  Well Designزض دٙدطٜ انّي  .3

 زٜ ٔي قٛز.ٕ٘بيف زا Directional Survey Computation Methodsا٘شربة ٕ٘بييس. دٙدطٜ 
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 وّيه ٕ٘بييس. Survey Tool Error Modelثط ضٚي زوٕٝ خٟز زاض ٔٛخٛز زض ؾٕز ضاؾز فيّس  .4

 ضا ا٘شربة ٕ٘بييس. Wolf & deWardtاظ ِيؿز وكٛيي ثبظ قسٜ ٌعيٙٝ  .5

 وّيه ٕ٘بييس. OKثط ضٚي زوٕٝ  .6

 بي نفحٝ ثطٚيس.ثٝ ا٘شٟ scroll barثطٚيس. قبيس لاظْ ثبقس ثب اؾشفبزٜ اظ  Survey Toolؾشٖٛ  ثٝ .7

 WDW_GOOD زاثُ وّيه ٕ٘بييس. اظ ِيؿز وكٛي ثبظ قسٜ ٌعيٙٝ  Survey Toolثط ضٚي ؾَّٛ ٔٛخٛز زض ضزيف اَٚ اظ ؾشٖٛ  .8

GYRO (Wolf & deWardt.ضا ا٘شربة ٕ٘بييس ) 

 

 ثؼس اظ ا٘شربة ايٗ اثعاض، سٕبٔي ؾَّٛ ٞبي ظيطي آٖ ٘يع ثب ٕٞيٗ اثعاض دط ٔي قٛ٘س. .9

 ذبضج قٛيس. Well Designوّيه وطزٜ ٚ ؾذؽ اظ ثط٘بٔٝ   Saveثط ضٚي آيىٗ  .12

 Close Approachثبظ وطزٖ  -1ثرف 

 ثطٚيس سب ثط٘بٔٝ ثبظ قٛز. Start >   > Close Approachثٝ ٔؿيط  .1

 ( ٌفشٝ ٔي قٛز.analysis windowدٙدطٜ سدعٜ ٚ سحّيُ ) Close Approach٘ىشٝ: زض ايٗ آٔٛظـ ثٝ دٙدطٜ انّي 
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 Subject Wellا٘شربة  -2ثرف

 ٔب يىؿبٖ ٔي ثبقٙس.  new well  ٚsubject wellزض ايٗ ٔطحّٝ اظ آٔٛظـ  ٔي ثبقس. proximity  ،subject wellٔطخغ سٕبْ ٔحبؾجبر 

 subject surveyٔي سٛا٘س ثٝ ػٙٛاٖ  planيب  surveyثّىٝ ٞط سٟٙب ثٝ چبٜ ٞبي َطح ضيعي قسٜ ٔحسٚز ٕ٘ي قٛز.  subject well٘ىشٝ: 
 قٛز. ا٘شربة

 ضا ذٛاٞيس آٔٛذز. subject wellثب ديطٚي اظ ٔطاحُ ظيط ٘حٜٛ ا٘شربة 

ٕ٘بيف زازٜ  Select Trajectoryوّيه ٕ٘بييس. دٙدطٜ  ثط ضٚي زوٕٝ خؿشدٛ . Subject Surveyسؼييٗ ٔحُ فيّس  .1
 ٔي قٛز.

زض فيّس  ثؿٍ زٞيس. Zeus > A. Structure > W-13 > B-13 > Plan > Tutorial #1دبيٍبٜ زازٜ دطٚغٜ ضا زض ٔؿيط  .2
 ٕ٘بيف زازٜ ٔي قٛز. Tutorial #1ػٙٛاٖ اي دٙدطٜ 

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   142 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

ٔي ثبقس وٝ  Tutorial #1چبٜ َطح ضيعي قسٜ  Surveyثبظٌطزيس.  analysis windowثط ضٚي زوٕٝ وّيه وٙيس سب يٕٗ سبييس سٙظيٕبر ثٝ 
 ٕ٘بيف زازٜ ٔي قٛز. Subject Surveyزض فيّس 

 ٞب Offset Wellا٘شربة  -3ثرف
 subject wellثب خعئيبر وبُٔ ٘ؿجز ثٝ  proximity analysis ٔي ذٛاٞيسوٝ قٕب  ٔي قٛزاظ چبٜ ٞبي ا٘دبْ ٞب Offset Well ٌعيٙف

 ٞب ضا اظ قبذٝ دبيٍبٜ زازٜ دطٚغٜ ا٘شربة وٙيس.Offset Wellٞب ٔي سٛا٘يس ثٝ َٛض زؾشي Offset Wellثطاي ا٘شربة  ا٘دبْ قٛز. ،ربة قسٜشا٘

 ٓ زاز.يٞب ضا قطح ذٛاOffset Wellٞ٘حٜٛ ا٘شربة زؾشي زض ازأٝ 

 ثبظزيس وٙيس. Zeusٞبي ٔٛخٛز زض فيّس surveyثب ديطٚي اظ زؾشٛاِؼُٕ ظيط ٔي سٛا٘يس ٕٞٝ 

 ضا ا٘شربة ٕ٘بييس. Tutorial #1ؾٕز چخ  checkboxثؿٍ زٞيس،  Planدبيٍبٜ زازٜ دطٚغٜ ضا ثٝ قبذٝ  .1
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چه ثبوؽ ٞبي زيٍط دطٚغٜ ٘يع سغييط ٔي يبثٙس. زض خسَٚ ظيط ٔرشهطا سٛييحبسي دطأٖٛ ايٗ چه  Tutorial #1ثٝ ٔحى ا٘شربة چه ثبوؽ 
 ثبوؽ ٞب زضج ٌطزيسٜ اؾز.

 
 ٚخٛز زاضز ثٝ حؿبة آٚضزٜ ٕ٘ي قٛ٘س. checkboxآيشٓ ٚ ظيط آيشٓ ٞبي وٝ زض ؾٕز چخ قبٖ ايٗ 

 
 ٜ ٔي قٛز. ايٗ آيشٓ قبُٔ ظيط آيشٓ ٞبي زيٍطي ٕ٘ي ثبقس.زاضز ثٝ حؿبة آٚضز ضا checkboxايٗ  آيشٕي وٝ زض ؾٕز چخ ذٛز

 
يشٓ قبُٔ ظيط آيز ٞبي وٝ، آٟ٘ب ٘يع قٕبَ ظيط زاضز ثٝ حؿبة آٚضزٜ ٔي قٛز. ايٗ آ ضا checkboxايٗ  آيشٕي وٝ زض ؾٕز چخ ذٛز

 آيشٓ ٔي ثبقٙس.
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 Proximity Analysisاخطاي يه  -6ثرف

 ثطٚيس. analysis windowزض  Compute Proximityثٝ ثرف  .1

 

 وّيه ٕ٘بييس. Methodثط ضٚي زوٕٝ خٟز زاض ،زض ؾٕز ضاؾز فيّس  .2

 ضا ا٘شربة ٕ٘بييس. Normal Planeاظ ِيؿز وكٛيي ثبظ قسٜ ٌعيٙٝ  .3

 ضا ثطاي آٖ سبيخ ٕ٘بييس. 50ضفشٝ ٚ ٔمساض  Intervalثٝ فيّس Tab ثب اؾشفبزٜ اظ وّيس  .4

ٚاضز وطزٖ ٔمساض ثعضٌشط اظ نفط  .ا٘دبْ ٔي قٛز ؾىٗ قسٜزض چبٜ  surveyٔحبؾجبر زض ٞط ٔٛلؼيز  قسنفط ثب interval) فبنّٝ ) ٘ىشٝ: اٌط ٔمساض

زض ٔٛلؼيز ٞب  proximitie .ازأٝ ٔي يبثس(  TVDسب  ٚ ايٗ فبنّٝ اظ ؾُح قطٚع قسٜ )ثبػث ٔي قٛز وٝ ٔٛلؼيز ٞبي زض آٖ فبنّٝ لطاض ثٍيط٘س 
 س ٔحبؾجٝ ٔي قٛ٘س.ٌطفشٝ ا٘ٞبي وٝ لطاض 

 دٙدطٜ اي ثٝ ٕ٘بيف زض ٔي آيس وٝ اظ قٕب ٔي ذٛاٞس اَلاػبر ٌعاضـ ضا سبييس ٕ٘بييس.وّيه ٕ٘بييس.  Runضٚي زوٕٝ  .5

 ثٝ  دٙدطٜ انّي ثبظ ٌطزيس.وّيه ٕ٘بييس سب يٕٗ سبييس اَلاػبر  Yesثط ضٚي زوٕٝ  .6
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 ايدبز يه ذلانٝ ٌعاضـ -5ثرف
 Reportضا ا٘شربة ٕ٘بييس. دٙدطٜ  Summary Reportٙٝ ٌعي Close Approachزض دٙدطٜ انّي   Outputاظ ٔٙٛي  .1

Logos .ٕ٘بيف زازٜ ٔي قٛز 

 

ٞبي ٔٛخٛز ثٝ ٕ٘بيف زض آيس.  Logoوّيه ٕ٘بييس. سب ِيؿشي اظ  Left Logoثط ضٚي زوٕٝ خٟز زاض ٔٛخٛز زض ؾٕز ضاؾز فيّس  .2

Logo  زض ؾٕز چخ ثبلاي نفحٝ وٝ زض ايٙدب ا٘شربة ٔي ٕ٘بييس ثؼساSummary Report .ٕ٘بيف زازٜ ٔي قٛز 

ٞبي ٔٛخٛز ثٝ ٕ٘بيف زض آيس.  Logoوّيه ٕ٘بييس. سب ِيؿشي اظ  Right Logoثط ضٚي زوٕٝ خٟز زاض ٔٛخٛز زض ؾٕز ضاؾز فيّس  .3

Logo  ٝوٝ زض ايٙدب ا٘شربة ٔي ٕ٘بييس ثؼسا زض ؾٕز ضاؾز ثبلاي نفحSummary Report .ٕ٘بيف زازٜ ٔي قٛز 

 ٞب ٌعاضقشبٖ ضا ثجيٙيس.Logoسب يٕٗ دصيطـ ايٗ ثط ضٚي زوٕٝ  وّيه ٕ٘بييس  .4

 ٞب زض ثبلاي آٖ ٕ٘بيف زازٜ ٕ٘ي قٛ٘س.Logoوّيه وٙيس ثبظ ٞٓ ٌعاضـ ايدبز ذٛاٞس قس فمٍ  Cancel٘ىشٝ: اٌط قٕب ثط ضٚي زوٕٝ 
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 بييس.ٔطاخؼٝ ٕ٘ Close Approach Help Project٘ىشٝ: ثطاي ثسؾز آٚضزٖ اَلاػبسي خبٔغ اظ ايٗ ذلانٝ ٌعاضـ ثٝ 

 ثجٙسيس. دٙدطٜ ٌعاضـ ضا ثب وّيه ثط ضٚي  .5

 

 ٘ىشٝ: سٛخٝ وٙيس وٝ ٍٞٙبْ ثؿشٗ دٙدطٜ ٌعاضـ اقشجبٞب دٙدطٜ ثط٘بٔٝ ضا ٘جٙسيس.

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   145 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 ايدبز ٌعاضـ ٔفهُ -6ثرف

ؾي ثطض Summary Reportقٕب ٔي سٛا٘يس سؼساز چبٜ ٞبيي وٝ ثط اؾبؼ يبفشٝ ٞبي ٔٛخٛز  زض  Detailed Reportلجُ اظ ايدبز يه 
 ٔي ثبقس ثطزاضيس. FLOWوٝ زض ذلانٝ ٌعاضـ ثٝ حبِز  offset surveyٞب ضا اظ قبذٝ دبيٍبٜ زازٜ  surveyايٗ  ذٛاٞيس وطز ضا وبٞف زٞيس.

ٞب  surveyثطاي ثطزاقشٗ ايٗ ثطضؾي ايٗ چبٜ ٞب زض ٌعاضقي ثب خعئيبر وبُٔ ثؿيبض ذؿشٝ وٙٙسٜ اؾز ظيطا ٞيچ اَلاػبر ٔفيسي فطاٞٓ ٕ٘ي وٙٙس. 
ثطاي وٕه ٌطفشٗ زض اي ذهٛل ثٝ ضا اظ حبِز ا٘شربة ذبضج وٙيس.  applicable surveyاظ ٌعاضـ، چه ثبوؽ ٞبي ٔٛخٛز زض ؾٕز چخ ٞط 

 ٔطاخٝ فطٔبييس. 3ثرف آٔٛظقي قٕبض

اٞس اَلاػبر وّيه ٕ٘بييس. دٙدطٜ اي ثٝ ٕ٘بيف زض ٔي آيس وٝ اظ قٕب ٔي ذٛ Runضٚي زوٕٝ ثؼس اظ ايٙىٝ ا٘شربثشبٖ ضا سهحيح وطزيس  .1
 ٌعاضـ ضا سبييس ٕ٘بييس.

 وّيه ٕ٘بييس سب يٕٗ سبييس اَلاػبر ثٝ  دٙدطٜ انّي ثبظ ٌطزيس. Yesثط ضٚي زوٕٝ  .2

 Outputضا ا٘شربة ٕ٘بييس. دٙدطٜ  Preferencesضفشٝ ٚ ٌعيٙٝ  Outputثٝ ٔٙٛي  Close Approachزض دٙدطٜ  .3

Preferences .ٕ٘بيف زازٜ ٔي قٛز 
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ثب ايٗ وبض ٔي سٛا٘يس ثط ضٚي لؿٕز ٞبي اظ  ثطٚيس. Display only data within depth rangeف زض ايٗ دٙدطٜ ثٝ ثر .4
 چبٜ وٝ ٔي ذٛاٞيس سٕطوع وٙيس.

 فؼبَ ٔي قٛ٘س. Top  ٚBottomضا ا٘شربة ٕ٘بييس. فيّس ٞبي TVDزوٕٝ  .5

 وٙيس.ضا ثطاي آٖ سبيخ  1550ثطٚيس ٔمساض  Bottomضا زٚثبض فكبض زٞيس سب ثٝ لؿٕز  tabوّيس  .6

 ثبظ ٌطزيس. analysis windowوّيه ٕ٘بييس سب يٕٗ سبييس اَلاػبر ثٝ  OK ثط ضٚي زوٕٝ  .7

 ضا ا٘شربة ٕ٘بييس. Detailed Reportٌعيٙٝ  Outputاظ ٔٙٛي  Detailed Reportثطاي ايدبز  .8
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 Hydraulicsآٔٛظـ 
 ٕ٘بيي وّي

 ٍ٘بٞي اخٕبِي ثط ٔجب٘ي آٔٛظـ 

  ٖثبظ وطزHydraulics 

 ػبر ٚاضز وطزٖ اَلاHydraulics 

  ٚاضزوطزٖ دبضأشط ٞبيHydraulics 

 ثطضؾي ذطٚخي 

 حُ ٔؿبئُ ٚ ٌطفشٗ ذطٚخي چبدي 

 Examining the Swab and Surge Feature 

 Power Drive  ٚMotor Runs 

 PT Rheology (ٜػّٓ خطيبٖ ٚ سغييط قىُ ٔبز) 

 ايدبز ٌعاضقبر ٚ َطح ٞب 

 ٍ٘بٞي اخٕبِي ثط ٔجب٘ي آٔٛظـ -1ثرف 

َطاحي قسٜ اؾز. زض قطٚع وبض ثط٘بٔٝ لاظْ اؾز آيشٓ ٞبي  Hydraulicsآٔٛظقي ثٝ ٔٙظٛض ديف ثطز قٕب زض اخطاي ٔطاحُ اِٚيٝ ايٗ ثرف 
وٝ زض  BHA  ٚwell geometryضا زض ثط٘بٔٝ ثبضٌعاضي وٙيس. زض ايٗ ثرف آٔٛظـ اظ  BHA  ،Survey  ٚWell Geometryاَلاػبسي 

ايدبز وطزيس ٔٛضز  Well Designٞبيي وٝ زض ظٔبٖ آٔٛظـ  surveyس اؾشفبزٜ ٔي وٙيٓ ٕٞچٙيٗ َطاحي وطزي BHA Editorظٔبٖ آٔٛظـ 
ٞؿشيس  ٔي  Hydraulicsسؿٍّ وبفي ضا زاضيس ٚ سٟٙب ذٛاٞبٖ فطاٌيطي  Well Design  ٚBHA Editorاؾشفبزٜ لطاض ٔي زٞيٓ. اٌط قٕب ثط 

 drillingثط٘بٔٝ زض ٔؿيط   CDٚي سٛا٘يس فيّس وّي اؾشفبزٜ قسٜ زض ايٗ ثرف آٔٛظقي ضا ثط ض

office\doc\PowerPlan\Tutorials\data\zeus.pbf  ثيبثيس وٝ لاظْ اؾز آٖ ضا ثب اؾشفبزٜ اظDataBrowser .ثبضٌعاضي ٕ٘بييس 

ٔي قٛز. زض  Mud Rheology, Bit/Flow, Rig, Tools/Misc  ٚ  Cuttingsٕٞچٙيٗ ايٗ آٔٛظـ قبُٔ ٚاضز وطزٖ اَلاػبر ثطاي 

 viewing the output, performing sensitivity studies, generating reports, and customizing theقبُٔ  آذط

graphs .ثطاي اضائٝ اؾز 

 ٔثبَ ثٝ وبض ضفشٝ زض ؾطاؾط ايٗ ثرف آٔٛظقي سلاقي ثطاي دبؾد ثٝ ٔكىلار ٚالؼي يه چبٜ حميمي ٔي ثبقس. ؾؼي قسٜ ضٚقي ُٔبثك آ٘چٝ ثط٘بٔٝ

Hydraulics  ٔي سٛا٘س ثطاي حُ چٙيٗ ٔؿبئّي اؾشفبزٜ وٙس ديكٟٙبز قٛز. زض ايٗ ٔثبَ اظ ؾيؿشٓ ٚاحسEnglish .اؾشفبزٜ ٕ٘بييس 

 Hydraulicsثبظوطزٖ  -2ثرف
 اظ ٔطاحُ ظيط ديطٚي وٙيس. Hydraulicsضا ذٛاٞيس آٔٛذز. ثطاي ثبظوطزٖ ثط٘بٔٝ  Hydraulicsزض ايٗ زضؼ ، ٘حٜٛ ثبظوطزٖ 

ٕ٘بيف زازٜ  Hydraulics Inputsضا ا٘شربة ٕ٘بييس. دٙدطٜ  Schlumberger >     > Hydraulicsٔؿيط  Startاظ ٔٙٛي   .1
 ٔي قٛز.

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   148 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

 Hydraulicsٚاضز وطزٖ اَلاػبر  -2ثرف 
 سؼطيف اِٚيٝ ٔؿئّٝ

ٞيس فطو وٙيٓ زض ثرف ضا ٔٛضز ثطضؾي لطاض زٞيٓ. اخبظٜ ز ft 14089.33زض ػٕك ا٘ساظٜ ٌيطي قسٜ  Tutorial #1لهس زاضيٓ ثرف افمي چبٜ 
8.5 inch  ٔكىُ سٕيع وطزٖ حفطٜ چبٜ اظ وٙسٜ ٞبي حفبضي ضا زاضيٓ. ٞسف ٔب ديسا  وطزٖ زثي دٕخ ٚ سطويجي اظBHA  ٓٔي ثبقس وٝ ػّي اِطل

ٔي وٙيٓ ثيكشطيٗ  ٔحسٚزيز ٞبي وٝ زض دٕخ ٞب ٚ ٘طذٟبي فكبض سدٟيعار ؾطچبٞي  ٚخٛز زاضز لبزض ثبقٙس چبٜ ضا سٕيع وٙٙس. ثطاي ضاحشي وبض فطو

 ٔي ثبقس. psi 4222فكبضي وٝ سدٟيعار ؾطچبٞي ٔي سٛا٘ٙس سحُٕ وٙٙس ثطاثط 

 BHA, Survey  ٚWell Geometryثبضٌعاضي فبيُ ٞبي 

 ٕ٘بيف زازٜ ٔي قٛز. Select BHAوّيه ٕ٘بييس. دٙدطٜ   ثط ضٚي زوٕٝ خؿشدٛ BHAزض ؾٕز ضاؾز  فيّس  .1

 ثؿٍ زٞيس. Zeus > A. Structure > W-13 > B-13 > Planط دبيٍبٜ زازٜ دطٚغٜ ضا ثب ا٘شربة ٔؿي .2

 ضا ا٘شربة ٕ٘بييس. BHA (Horizontal)آيشٓ  .3

 وّيه ٕ٘بييس. ايٗ وبض اَلاػبر ضا ثبضٌعاضي وطزٜ ٚ ٘بْ ٚ ََٛ ضا ٕ٘بيف ٔي زٞس. OKثط ضٚي زوٕٝ  .4
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ٕ٘بيف  Select Well Geometryوّيه ٕ٘بييس. دٙدطٜ   ثط ضٚي زوٕٝ خؿشدٛ Well Geomزض ؾٕز ضاؾز  فيّس  .5
 زازٜ ٔي قٛز.

 ثؿٍ زٞيس. Zeus > A. Structure > W-13 > B-13 > Planدبيٍبٜ زازٜ دطٚغٜ ضا ثب ا٘شربة ٔؿيط  .6

 ضا ا٘شربة ٕ٘بييس. Well Geometry #1آيشٓ  .7

 وّيه ٕ٘بييس. ايٗ وبض اَلاػبر ضا ثبضٌعاضي وطزٜ ٚ ٘بْ ٚ ََٛ ضا ٕ٘بيف ٔي زٞس. OKثط ضٚي زوٕٝ  .8

 ٕ٘بيف زازٜ ٔي قٛز. Select Surveyوّيه ٕ٘بييس. دٙدطٜ   ثط ضٚي زوٕٝ خؿشدٛ Well Geomز ضاؾز  فيّس زض ؾٕ .9

 ثؿٍ زٞيس. Zeus > A. Structure > W-13 > B-13 > Planدبيٍبٜ زازٜ دطٚغٜ ضا ثب ا٘شربة ٔؿيط  .12

 ضا ا٘شربة ٕ٘بييس. Tutorial #1آيشٓ  .11

ضا  Bit Depthضا ثبضٌعاضي وطزٜ ٚ ٘بْ ٚ ََٛ ضا ٕ٘بيف ٔي زٞس ٚ survey ػبر وّيه ٕ٘بييس. ايٗ وبض اَلا OKثط ضٚي زوٕٝ  .12

 سٙظيٓ ٔي وٙس. surveyثطاي ػٕيك سطيٗ 
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 Hydraulicsٚاضز وطزٖ دبضأشط ٞبي  -4ثرف

ثٝ  ٔٙبؾت ضا ثبضٌصاضي وطزيس ٘ٛثز ثٝ ٚاضز وطزٖ دبضأشط ٞبي ٔطثٌٛ BHA, wellbore geometry  ٚsurveyحبَ وٝ فبيُ ٞبي 
hydraulic  ٔي ضؾس. زض ايٗ ثرف ٘حٜٛ ٚاضز وطزٖ دبضأشط ٞبي ٞيسضِٚيه ضا ثطايMud Rheology, Rig Equipment, Tools/Bit 

Nozzles, Motor  ٚCutting .ٞب ذٛاٞيس آٔٛذز 

 Rheologyٚاضز وطزٖ اَلاػبر زض نفحٝ 
وّيه ٕ٘بييس. اظ ِيؿز وكٛي ثبظ قسٜ  Modelّس ثطٚيس. ثط ضٚي زوٕٝ خٟز زاض ٔٛخٛز زض ؾٕز ضاؾز في Settingsثٝ ثرف  .1

 ضا ا٘شربة ٕ٘بييس. Herschel-Bulkleyٌعيٙٝ 

 ضا ٚاضز ٕ٘بييس. lbm/gal 10ٔمساض  Mud Weightثطٚيس. زض فيّس  Propertiesثٝ ثرف  .2

 ا٘شربة قسٜ ثبقس. Use Fann Dataثبيس زلز وٙيس وٝ چه ثبوؽ  .3

 ٞبي ٔطثَٛٝ ٚاضز ٕ٘بييس.ٔمبزيط ِيؿز قسٜ زض لؿٕز ظيط ضا زض فيّس  .4

 

Fann 3 6 

Fann 6 8 

Fann 100 23 

Fann 200 31 

Fann 300 37 

Fann 600 51 
 

 ضا ثفكبضيس. tabوّيس  Fann 600ثؼس اظ ٚاضز وطزٖ ٔمساض  .5

 Consistency Index, Flow Behavior Index  ٚYield Pointؾٝ دبضأشط Herschel-Bulkley زض ٔسَ   tab٘ىشٝ: فكطزٖ وّيس 
 ضا ثطاي ٌُ ايدبز ٔي وٙس. ايٗ ٔمبزيط غيط لبثُ ٚيطاؾز ٔي ثبقٙس.

 ضا ٘كبٖ ٔي زٞس. Rheologyسهٛيط ظيط نفحٝ سىٕيُ قسٜ 
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 Bit/Flowٚاضز وطزٖ اَلاػبر زض نفحٝ 

 ضا ا٘شربة ٕ٘بييس.  Bit/Flowظثب٘ٝ  .1

 سبيخ ٕ٘بييس.  Pump Flowrateضا ثطاي ثرف    (gal/min) 450ثطٚيس. ٔمساض  Pump/Flowثٝ ثرف  .2

 سبيخ ٕ٘بييس.  Plot: Min Flowضا ثطاي ثرف    (gal/min) 300ٔمساض  .3
 سبيخ ٕ٘بييس.  Plot: Max Flowضا ثطاي ثرف    (gal/min) 800ٔمساض  .4

 ECDثطاي ا٘شربة ٔحسٚزٜ اي اؾشفبزٜ ٔي قٛ٘س وٝ زض آٖ ٔٙحٙي ٞبي افز فكبض ٚ  Plot: Min Flow  ٚPlot: Max Flow٘ىشٝ: ٔمبزيط 

(Equivalent Circulating Density) .ٕ٘بيف زازٜ ٔي قٛ٘س 

ضا حفظ  Max Pump Pressureثطاي  Pump Stroke Volume  ٚ4222 psiثطاي  bbl 0.123ٔمبزيط ديف فطو  .5
 ٕ٘بييٓ.

 ا٘شربة ٕ٘بييس. Options > Flowrate Sensitivity Analysisٔؿيط  Hydraulicsاظ دٙدطٜ  .6

زض فيّس ٞبي ٔطثَٛٝ ٚاضز ٕ٘بييس. أب زض  Sensitivity ،Min Flow    ٚMax Flowٝ ثٝ قٕب اخبظٜ ٔي زٞس سب ٔمبزيط ا٘شربة ايٗ ٌعيٙ٘ىشٝ: 
زثي خطيبٖ سٙظيٓ ٔي قٛ٘س ٍ٘ٝ  َجمٝ ثٙسيايٗ ٔثبَ اخبظٜ زٞيس ايٗ ٔمبزيط ثٝ نٛضر ديف فطو ثطاي ايٗ دبضأشط ٞب وٝ ثٝ َٛض ذٛزوبض ثطاي 

 زاضيٓ.
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7. Nozzles (3 x 15)  ثطايBHA (Horizontal)  ٚ ثٝ َٛض ذٛزوبض اظ دبيٍبٜ زازٜ ثبضٌعاضي ٔي قٛزTotal Flow Area 
 ٘كبٖ زازٜ قسٜ اؾز. ايٗ ٔٛاضز ضا ثٝ ٕٞيٗ نٛضر ضٞب وٙيس.

لطاض زاضز اخبظٜ زٞيس ثٝ ٕٞيٗ نٛضر ثبلي ثٕب٘س. ثؼسا زٚثبضٜ ثٝ ايٗ لؿٕز  Noneضا ثط ضٚي  Nozzle Optimizationضٚـ  .8
 اٞيٓ ٌكز.ثبظ ذٛ

 ثط اؾبؼ ؾبيع حفطٜ يب ٘طخ ثسٜ ٔٛسٛض ٔي ثبقس. Plot Min  ٚMax Flow٘ىشٝ: ٔمبزيط ديف فطو ثطاي 

 

 Rigٚاضز وطزٖ اَلاػبر زض نفحٝ 
 ضا ا٘شربة وٙيس. Rigظثب٘ٝ  .1

 3ٛيي وّيه ٕ٘بييس. اظ ِيؿز وك  Typeثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز فيّس  ثطٚيس. Surface Equipmentثٝ ثرف  .2
 ضا ا٘شربة ٕ٘بييس.
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 ٘ىشٝ: ٞط ٌبٜ ايٗ ا٘شربة سغييط وٙس ََٛ ٚ لُط سدٟيعار ؾط چبٞي ٘كبٖ زازٜ قسٜ سغييط ٔي وٙٙس.

 دٛقيسٜ قسٜ اؾز. RKB٘ساضيٓ ٚ چبٜ ثب  riser٘ىشٝ: ٕٞٝ ٚضٚزي ٞبي زيٍط زض ايٗ نفحٝ غيط فؼبَ ٔي ثبقٙس ظيطا 

 

 Tools/Miscنفحٝ ضز وطزٖ اَلاػبر زض ٚا
 ضا ا٘شربة ٕ٘بييس. Tools/Miscب٘ٝ ظث .1

 Ignore Eccentricityچه ثبوؽ ثطٚيس.ايٗ ثرف زض دبييٗ ، ؾٕز چخ نفحٝ لطاض زاضز. سيه  Miscellaneousثٝ ثرف  .2
 ضا ثطزاضيس ثٙبثط ايٗ قبُٔ سبثيط ذبضج اظ ٔطوع ثٛزٖ ٔي قٛز.

ٞب ٔٛثط ECDي زض ؾٛضاخ چبٜ( ٔؼٕٛلازض اسلاف فكبض فًبي زاِيعي ٚ )ذبضج ٔطوع لطاض ٌطفشٗ ضقشٝ حفبض eccentricityزذيُ وطزٖ اثط ٘ىشٝ: 
 ٞؿشٙس.
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 سبيخ ٕ٘بييس. اي ٔمساض ػٕك قطٚع ثرف افمي زض َطح ضا ٘كبٖ ٔي زٞس.ضا  ft 12207ٔمساض  User ECD Depth (MD)زض  .3

 Tool Jointsچه ثبوؽ ايٗ ثرف زض دبييٗ ، ؾٕز ضاؾز نفحٝ لطاض زاضز. ُٕٔئٗ قٛيس وٝ  ثطٚيس. Tool Jointsثٝ ثرف  .4
 ا٘شربة قسٜ اؾز. 

 ٔي ثبقس. ft 31اظ يه ِِٛٝ  ft 1.5ضا سبيخ ٕ٘بييس. ايٗ ٔمساض ٔؼبزَ ٞط  %10ٔمساض  Fractional TJ lengthزض فيّس  .5

 ضا سيه ٘ع٘يس. Casing Protectorsچه ثبوؽ  .6

اؾشفبزٜ  Non-Catalog Tool Pressure Dropٚخٛز ٘ساضز ، اظ ثرف  BHAزض  Non Catalogثٝ زِيُ آ٘ىٝ ٞيچ اثعاض  ٘ىشٝ: 
 ٕ٘ي وٙيٓ.

 

 Motorٚاضز وطزٖ اَلاػبر زض نفحٝ 

 ضا ا٘شربة ٕ٘بييس. Motorظثب٘ٝ  .1
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آٖ زض ظيط ايٗ لؿٕز ٕ٘بيف  flow rangeا٘شربة قسٜ ٚ  Type Motorثٛزٜ وٝ زض لؿٕز  A675M4570XPزاضاي ٔٛسٛض  BHA٘ىشٝ: 
 زازٜ ٔي قٛز.

 ضا فؼبَ ٔي وٙس. Delta Pضا ا٘شربة ٕ٘بييس. ايٗ وبض فيّس ٔشٗ  Delta Pزوٕٝ  ثطٚيس . Delta Pثٝ لؿٕز  .2

 ضا سبيخ ٕ٘بييس. psi 250ٔمساض  Delta Pزض فيّس ٔشٗ  .3

 ضا ٚاضز ٕ٘بييس. wear % 5ٔمساض  Wear%ثطٚيس. زض فيّس  Motor Specificationsثٝ ثرف  .4

 .ضا سبيخ ٕ٘بييس (in 32/) 12ٔمساض  Rotor Nozzleزض فيّس  .5

 ضا سبيخ ٕ٘بييس. (%) 5ٔمساض   Motor Bearing Flowزض فيّس  .6

 زض دبيٍبٜ زازٜ ،ثبضٌعاضي ٔي قٛز. BHA (Horizontal)ثٝ َٛض ذٛزوبض اظ  Bit Type٘ىشٝ: 
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 Cuttingsٚاضز وطزٖ اَلاػبر نفحٝ 

 ضا ا٘شربة ٕ٘بييس. Cuttingsظثب٘ٝ  .1

ٞبي لبثُ ٚيطايف فؼبَ ٔي قٛ٘س وٝ ثب ٔمبزيط ديف فطو دط قسٜ  ضا ا٘شربة ٕ٘بييس.  حبَ لؿٕز Hole Cleaningچه ثبوؽ  .2
 ا٘س.

 ٚاضز ٕ٘بييس. RPMضا ثطاي  50 .3

4. 150 ft/hr  ضا ثطايRate of Penetration .ٚاضز ٕ٘بييس 

 ثميٝ ٔٛاضز ديف فطو زيٍط ضا حفظ ٕ٘بييس. .5

 غيط فؼبَ ٔي ثبقس. Boostline Rate٘ساضيٓ فيّس  riser٘ىشٝ: ثٝ ػّز آ٘ىٝ ٞيچ 
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ّس ٞب ٘ىشٝ: لؿٕز ٞبي وٝ فؼبَ ٘كس٘س ثٝ ػّز وطن قسٜ ثٛزٖ ٘طْ افعاض ٔي ثبقس. زض نٛضسي وٝ اظ ٘ؿرٝ انّي ثط٘بٔٝ اؾشفبزٜ وٙيس سٕبٔي ايٗ في
 فؼبَ ٔي قٛ٘س.

 آٔٛظـ زازٜ ٔي قٛز. 6زض ثرف  Swab/Surge٘ىشٝ: نفحٝ 

 Hydraulicsاخطائ 
 ثٟشطيٗ ضاٜ اؾز. Run Plots. ثطاي ُٔبِؼبر حؿبؾيز اؾشفبزٜ اظ Run Plots  ٚRun Reportزٚ ٌعيٙٝ ثطاي اخطا ٚخٛز زاضز: 

 دٙدطٜ ديبْ ظيط ٕ٘بيف زازٜ ٔي قٛز. وّيه ٕ٘بييس. Hydraulics Inputزض ؾٕز ضاؾز دٙدطٜ   Run Plotsثط ضٚي  .1

 

 

 وّيه ٕ٘بيس سب وبض ازأٝ يبثس. OKثط ضٚي زوٕٝ  .2

  ثطضؾي ذطٚخي -4ثرف
 غييط ي زض ذطٚخي ٞب ايدبز ٕ٘بييس سٟٙب  آٟ٘ب ضا ٔكبٞسٜ وٙيس.زض اثشسا ثسٖٚ ايٙىٝ س
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 ٔكبٞسٜ افز فكبض ذطٚخي 

 

 green curveضا ٘كبٖ ٔي زٞس.  Rig Equipmentسؼييٗ قسٜ زض  pump flowratesزض ٔمبثُ ٘طخ  pressure drops ٕ٘بايٗ 

 Surfaceديف فطو )ٔٙحٙي آثي ضً٘(  blue curveس. ( ضا ٘كبٖ ٔي زStandpipe Pressureٞيب )وّي )ٔٙحٙي ؾجع ضً٘( افز فكبض 

Equipment Pressure Loss  .)ٔي ثبقس )وٝ ثب زوٕٝ ا٘شربة قسٜ )دط قسٜ( زض ثرف دبييٗ ٕ٘ٛزاض ٘كبٖ زازٜ قسٜ اؾزblack dashed 

line  شربة قسٜ اؾز.ا٘وٝ اذيطا  ٘طخ خطيبٖ)ذٍ چيٗ ٔكىي ضً٘( ٘كبٖ زٞٙسٜ ٔٛلؼيز افز فكبض ٚ ٘طخ خطيبٖ دٕخ ُٔبثك vertical 

dashed red lines  )ً٘ٔحسٚزٜ ٘كبٖ زٞٙسٜ )ذٍ چيٗ ٞبي ػٕٛزي لطٔع ضflowrate ٘ؿجز ثٝ سٙظيٕبر خطيبٖ ٘بظَ ٔٛسٛض  قسٜ سؼطيف

 ٔي ثبقس وٝ ٔبوؿيٕٓ فكبض ضا ٘كبٖ ٔي زٞس. horizontal dashed magenta lineٚ آذطيٗ ذٍ  ٔي ثبقس.

 ,Tools٘طخ ٞبي خطيبٖ زض ؾٕز ضاؾز  ٕ٘بيف زازٜ قسٜ اؾز. pump flowrateفكبض ثطاي قسر خطيبٖ ِٔٛفٝ ثطزاض افز ظيط ٌطاف ، 

Motor  ٚBit .ثبظسبة اسلاف فكبض خطيبٖ ٚالؼي ٔيبٖ  ٞط خعء ضا ٘كبٖ ٔي زٞس 
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ٚ  427.5طاثط ث Bit flowrateضا ٘كبٖ ٔي زٞس. سٛخٝ زاقشٝ ثبقيس وٝ  gal/min 450ٔمساض  Pump Flowrateظٔب٘ي وٝ  ٘ىشٝ: 

Motor flowrate  72ثطاثط gal/min  وٕشط اظpump flowrate .ايٗثسيٟي اؾز  ٔي ثبقٙس motor nozzle  ٚmotor 

bearing flow .زض نفحٝ ٚضٚزي اَلاػبر ٔٛسٛض سؼييٗ قسٜ ا٘س 

 ٔكبٞسٜ اسلاف فكبض زضٖٚ ِِٛٝ حفبضي

 ٘شربة قٛز.زض دبييٗ ٌطاف وّيه ٕ٘بييس سب ا Drillstringثط ضٚي زوٕٝ 

 

 ٔٙحٙي آثي ضً٘ سغييط ٚيؼيز ٔي زٞس. ايٗ وبض ثبظ سبة وٙٙسٜ ايٗ حميمز اؾز وٝ اسلاف فكبض ِِٛٝ حفبضي ؾٟٓ ػٕسٜ اي زض اسلاف وّي زاضز.

ٛا٘يس زيٍط َطح ٞب اسلاف فكبض زضٖٚ ِِٛٝ ٞبي حفبضي قبُٔ اسلافبر اسهبَ اثعاض زضٚ٘ي وٝ ثٝ َٛض خساٌب٘ٝ ٘كبٖ زازٜ ٔي قٛ٘س ٕ٘ي قٛز. ٔي س٘ىشٝ: 
 زوٕٝ ٔٛضز ٘ظط ايدبز ٕ٘بييس. ضا ثب وّيه ثط ضٚي 
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ِِٛٝ ٞبي حفبضي ) ايٗ لؿٕز قبُٔ ٔٛسٛض، ٘بظَ ٞبي ٔشٝ يب اثعاض  ػجبضسٙس اظ، ٘شبيح ػسزي، ؾٟبْ زاضاٖ انّي  زض افز فكبض وّي ثب سٛخٝ ثٝ

MWD/LWD  ٞبي ٔشٝ.ٚ ٘بظَ وٝ ثٝ َٛض خساٌب٘ٝ ِيؿز ٔي قٛ٘س ٕ٘ي قٛز( ، ٔٛسٛض 

اٌط ايٗ ٔمساض  يب ثسٖٚ ايٗ اثطار سٟٙب ثب وّيه وطزٖ ثط ضٚي خؼجٝ ٔٙبؾت ٔكبٞسٜ وٙيس.ضا ثب اثطار اسهبَ ٞبي اثعاض ٚ وٙسٜ ٞب  قٕب ٔي سٛا٘يس فكبض
 ( ٘جبقس، اظ ِيؿز حصف ٔي قٛز.grayed outلبثُ ٔلاحظٝ)

 pump، وٝ ثٙب ثط سغييطار اظ ؾجع ثٝ لطٔع سغييط ٔي وٙٙس اسط ثطٚ٘س ٚ لشي اظ ٞط حسٚزي فطزض ؾٕز ضاؾز ٌطاف ؾٝ قبذم ٚخٛز زاضز وٝ 

flowrate .ٚضٚزي ٞبي زيٍط ٔي ثبقس ٚ 

 ECDٔكبٞسٜ ذطٚخي 
 ضا ا٘شربة ٕ٘بييس. ECD (Equivalent Circulation Density)ظثب٘ٝ 
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ٔٙحٙي آثي ثٝ َٛض ديف فطو  .٘سىي ٚ ػسزي اضائٝ قسٜ إٞبٖ ٌٛ٘ٝ وٝ زض ايٗ دٙدطٜ ٔكبٞسٜ ٔي وٙيس ٘شبيح افز فكبض ثٝ نٛضر اَلاػبر ٌطافي

ECD ضا ( زض وفكه ِِٛٝ خساضيcasing shoe .٘كبٖ ٔي زٞس ) ٖقٕب ٔي سٛا٘يس ثب وّيه ثط ضٚي ػٕك ٔٛضز ٘ظطسبECD .زض   ضا ضؾٓ ٕ٘بييس
ً( ٘كبٖ زٞٙسٜ ٔٛلؼيز افز فكبض ٚ ٘طخ )ذٍ چيٗ ٔكىي ض٘ black dashed line،  ( Pressure Drop دٙدطٜايٙدب ٘يع ٔب٘ٙس دٙدطٜ لجّي )

)ذٍ چيٗ ٞبي ػٕٛزي لطٔع ضً٘( ٘كبٖ زٞٙسٜ  vertical dashed red linesخطيبٖ دٕخ ٔشٙبظط ثب ٘طخ خطيبٖ وٝ اذيطا ا٘شربة قسٜ اؾز. 
 سؼطيف قسٜ ٘ؿجز ثٝ سٙظيٕبر خطيبٖ ٘بظَ ٔٛسٛض ٔي ثبقس. flowrateٔحسٚزٜ 

 ( ٔي ثبقٙس.pump flowrate٘طخ خطيبٖ وٙٛ٘ي دٕخ )ٔمسيط ػسزي ٘كبٖ زازٜ قسٜ ، ثطاي 

زض ايٗ ػٕك  ثبقس. ft 12207زض ػٕك  ( ٘جبقس ثّىcasing shoeٝوفكه ِِٛٝ خساضي ) زض ثرف ٚالؼب ECDٔيعاٖ  فطو وٙيس يؼيف سطيٗ

ECD ( سهحيح قسٜ ذطزٜ ٞبcutting ثطاثط )10.784 lbm/gal .ثب سغييط  قٕب ٔي سٛا٘يس ػٕك ٔٛضز ٘ظطسبٖ ضا ٔي ثبقسAt depth  سغييط
ضا ثسٖٚ اثط ذطزٜ ٞب ثطضؾي ٕ٘بييس. ذٛاٞيس زيس وٝ  ايٗ ٔمساض سب   Cuttings   ،ECDٔي سٛا٘يس ثب غيط فؼبَ وطزٖ ا٘شربة چه ثبوؽ  زٞيس.

10.592 lbm/gal .سٙعَ  ٔي وٙس 

زض اثشسا افعايف ٘طخ خطيبٖ  قىُ ٔي قٛز Uسضي ل ECDفؼبَ ٔي قٛز )سيه ظزٜ ٔي قٛز(. َطح   ECDزض دٙدطٜ    cuttingsسٛخٝ: ٚلشي 
ECD (ضا وبٞف ٔي زٞس ظيطا اثط سؼّيكdiluting.ضٚي ذطزٜ ٞب ٔؿٍّ ٔي ثبقس )  چٖٛ خطيبٖ افعايف ٔي يبثس ، افعايف انُحىبن اظ اثط سؼّيك

 قطٚع ثٝ افعايف ٔي وٙس. ECDديكي ٔي ٌيطز ٚ 

 Volumetricsٔكبٞسٜ ذطٚخي 
 ا٘شربة ٕ٘بييس.ضا  Volumetricsظثب٘ٝ 
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سؼييٗ قسٜ زض  Pump Stroke Volume( ٔٛضز ٘يبظ ثطاي دٕذبغ ثيٗ ثرف ٞبي ٔؼّْٛ ثط اؾبؼ strokesايٗ دٙدطٜ ظٔبٖ ٚ سؼساز يطثبر )
 ( ضا ٘كبٖ ٔي زٞس.annular geometryٚ ٞٙسؾٝ زاِيع ) Rig Equipment ،BHAٚضٚزي 

 Motor Analysisٔكبٞسٜ ذطٚخي 
 ضا ا٘شربة ٕ٘بييس. Motor Analysisظثب٘ٝ 
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ٚاضز  Motorوٝ زض نفحٝ ٚضٚزي  Delta P (250.0 psi)ايٗ نفحٝ ٕ٘بيي وّي اظ ٔمبزيط ٔطثٌٛ ثٝ ٔشٛض ضا اضائٝ ٔي زٞس. ٔي سٛا٘يس ٕٞبٖ 

اخطا )ثؼسا زض ايٗ زض ثرف ُٔبِؼبر حؿبؾيز زض حبَ  Motor Analysisخعئيبر ثيكشط ايٗ نفحٝ ظٔب٘ي وٝ ثٝ ذطٚخي وطزيس ضا زض ايٙدب ثجيٙيس. 
 ثطٚيس. Hole Cleaningثرف آٔٛظقي سكطيح ٔي قٛز( ثطٌكشيس زازٜ ٔي قٛز. ٞٓ اوٖٙٛ ثٝ ذطٚخي 

 Critical Transport Rateٔكبٞسٜ 

 ضا ا٘شربة ٕ٘بييس. Critical Transport Rateظثب٘ٝ 
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٘كبٖ ٔي زٞس. ذٍ چيٗ  Rate of Penetration (ROP)ضا ثٝ ػٙٛاٖ سبثؼي اظ  Critical Transport Rate (CTR)قىُ ٌطافيىي ثبلا 

 ضا ٘كبٖ ٔي زٞس.  (gal/min 450)نٛضسي افمي زثي خطيبٖ وٙٛ٘ي دٕخ 

ٔي ثبقس. ثٙبثطايٗ قٕب  gal/min 493ثطاثط  Cuttings Input  ،CTRا٘شربة قسٜ زض ثطٌٝ  ROPٔمبزيط ػسزي ٘كبٖ ٔي زٞٙس وٝ ثٝ ػًبي 
  اي سٕيع وطزٖ حفطٜ زٚض ٕ٘ي ثبقيس.ٔٛضز ٘يبظ ثط minimum flowrateاظ 

اؾز.  HWDPٔي ثبقس وٝ ا٘شٟبي  11979 ft (Critical Measured Depth)ٔكىُ آفطيٗ سطيٗ ثرف حفطٜ زض ػٕك ا٘ساظٜ ٌيطي قسٜ 

 Cuttings٘كبٖ زازٜ قسٜ اؾز ٔي ثبقس.   80º Critical Inclination ٕٞبٖ َٛض وٝ سٛؾٍحفطٜ چبٜ  80ºزض ثرف ايٗ لؿٕز 

Concentration  ،1.6%  0.192ٔي ثبقس وٝ ثبػث افعايف lbm/gal  زضECD .ٔي قٛز 
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 حُ ٔؿبئُ ٚ ٌطفشٗ ذطٚخي چبدي -5ثرف

 ا٘دبْ ُٔبِؼبر حؿبؾيز

 سب وٖٙٛ چٝ چيع ٞبي ضا اظ ايٗ ٔثبَ ٔشٛخٝ قسٜ ايس؟ 

چبٜ وبفي ٕ٘ي ثبقس. زض ايٙدب ؾٝ چيع ٚخٛز زاضز  ذٛة ٔشٛخٝ قسيٓ وٝ زثي خطيبٖ دٕخ ثب سٛخٝ ثٝ ذٛال ٌُ ٚ ؾطػز ٘فٛش ٔشٝ ثطاي سٕيع وطزٖ
 وٝ ثبيس ثٝ آٟ٘ب ثٝ دطزاظيٓ.

 ٝوبٞف ؾطػز ٘فٛش ٔش( Rate of Penetration (ROP)) 

 افعايف زثي خطيبٖ دٕخ 

 ٝثٟيٝ ؾبظي ٘بظَ ٞبي ٔش 

بي ثؿيبض ٔشؼسزي ٕٔىٗ اؾز ثطاي زض زض ػُٕ ٕٔىٗ اؾز ٚيؼيز ذيّي ديچيسٜ سط اظ ٚيؼيشي ثبقس وٝ زض ايٗ ٔثبَ ثطضؾي ٔي وٙيٓ ٚ فبوشٛض ٞ
 ٘ظط ٌطفشٗ ايٗ ٔٛيٛع ٔٛضز ٘يبظ ثبقس.

 وبٞف ؾطػز ٘فٛش ٔشٝ

 ضا ا٘شربة ٕ٘بييس. Critical Transport Rateظثب٘ٝ  Hydraulics Resultsاظ دٙدطٜ  .1
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ثٝ ظيط  Critical Transport Rateثٝ ؾٕز چخ حطوز زٞيس. ايٗ وبض ضا سب ظٔب٘ي ا٘دبْ زٞيس وٝ  Rate of Penetrationوكٛي ِغع٘سٜ 
 ٔي ثبقس. Pump Flowrate (450 gal/min)ثيبيس. ايٗ ذٍ چيٗ ٘كبٖ زٞٙسٜ ذٍ چيٗ نٛضسي 

زض  Annular flow above CTRضا ثٝ ا٘ساظٜ وبفي ثٝ ؾٕز چخ وكيسيس ٘كبٍ٘ط  Rate of Penetrationٚلشي وٝ وكٛي ِغع٘سٜ ٘ىشٝ: 
 ييط ضً٘ ٔي زٞس.ؾٕز ضاؾز ٌطاف اظ ضً٘ لطٔع ثٝ ؾجع سغ

 زض حبَ حبيط ٘كب٘ٝ ٞبي وٝ ٔي سٛا٘يس سٛاؾٍ آٟ٘ب اظ سٕيع قسٖ حفطٜ إَيٙبٖ حبنُ وٙيس ثٝ قطح ظيط ٔي ثبقٙس:

  فيّسCritical Measured Depth  زض حبِزNone .ٔي ثبقس 

  فيّسCritical Inclination .ذبِي ٔي ثبقس 

  ٘كبٍ٘طAnnular Flow Above CTR .ؾجعضً٘ ٔي ثبقس 
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سبذيط زض افعايف زثي خطيب٘ي وٝ ثؼسا آٖ ضا أشحبٖ ذٛاٞيٓ وطز  ٕٔىٗ اؾز غيط لبثُ لجَٛ ثبقس. ٕٔىٗ اؾز وٕي ROP٘ىشٝ: ايٗ وبٞف قسيس 
 زاقشٝ ثبقيس.

 افعايف زثي خطيبٖ دٕخ
  150وّيه وطزٜ ٚ ٔمساض  Rate of Penetrationٞؿشيس. ثط ضٚي فيّس  Critical Transport Rateزض حبِي وٝ ٞٙٛظ زض دٙدطٜ ذطٚخي 

ٔمبزيط ػسزي ٚ وكٛيي ِغع٘سٜ  ثبظ ٌطزيس. Rate of Penetrationضا ثفكبضيس سب ثٝ ٔمساض لجّي  tabضا زض ايٗ فيّس سبيخ ٕ٘بييس ؾذؽ وّيس 

 ٚاضزٜ وطزٜ قٕب ثٝ ضٚظ ضؾب٘ي ٔي قٛ٘س. Rate of Penetration٘ؿجز ثٝ 

 وّيه ٕ٘بييس. Pressure Dropثط ضٚي ظثب٘ٝ  .1

 ضا ثفكبضيس. tabضا سبيخ وطزٜ ٚ زوٕٝ  500ػسز  Pump Flowrateض فيّس ز .2
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 ٘ىشٝ: ايٗ ٌطاف ٘كبٖ ٔي زٞس وٝ ٔٛسٛض ثٝ ذٛثي زض ٔحسٚزٜ ػّٕيبسي ، ػُٕ ٔي وٙس.

 

ً لطاض زاضز. ضؾيسٜ وٝ ثٝ ذٛثي زض ظيط ذٍ چيٗ نٛضسي ض٘ psi 3286 سبٖ افعايف يبفشٝ ٚ ثٝ  standpipeقٕب ٔي سٛا٘يس ثجيٙيس وٝ فكبض وُ 
ٕٞچٙيٗ ثبيس زضؾز ثبقس.  pump flowrate of 500 gal/min( ضا ٕ٘بيف ٔي زٞس. ثٙبثط ايٗ psi 4000ايٗ ذٍ چيٗ ثيكيٙٝ فكبض )

ؾجع ضً٘ ٔي قٛز وٝ ٔجيٗ ايٗ ٔٛيٛع اؾز وٝ حفطٜ قٕب ثب ايٗ زثي خطيبٖ دٕخ ثٝ ذٛثي دبن ٔي  Annular flow above CTR٘كبٍ٘ط 
 قٛز.

 ضا ثرٛا٘يس. ft 12207ثبيس  Atثطٚيس. زض فيّس  Computed ECD’sضا ا٘شربة ٕ٘بييس. ثٝ ثرف  ECDظثب٘ٝ  .3

اسلاف فكبض  ٞب ٘يع افعايف يبفشٝ ا٘س.ECDضا ثٝ ذٛز ٌطفشٝ ٚ  gal/min 500٘يع ثٝ ضٚظ قسٜ ٚ ٔمساض  Pump Flowrateٔمساض  ECDزض دٙدطٜ 

 0.008زض حميمز افعايف يبفشٗ خطيبٖ سٟٙب ثٝ ذبَط ايبفٝ قسٖ  ف لبثُ سٛخٟي ٕ٘ي يبثٙس.ٞب افعايECDزاِيعي ذيّي ظيبز ٕ٘ي ثبقس ثٙبثط ايٗ 

lbm/gal  ٝثECD at 12207 ft .ٔي ثبقس 
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 دبؾد زازٜ اؾز؟ Pump Flowrateثٝ سغييطار  Motor Analysisچُٛض 

 ضا ا٘شربة ٕ٘بييس. Motor Analysisظثب٘ٝ  .4

 

ٚ  Off Bottom Press. Drop)فيّس ٞبي  off-bottom  ٚon –bottomافز فكبض ٞبي ٕٞبٖ َٛض وٝ ا٘شظبض ٔي ضفز، اذشلاف ثيٗ 

On Bottom Press. Drop  72زض ٌٛقٝ دبييٗ ؾٕز ضاؾز( ذيّي ظيبز سغييط ٘ىطزٜ ا٘س )حسٚز psi).  اِجشٝ قبيس ثرٛاٞيسWOB (weight 

on bit) ثب فكبض  ثب ايٗ فطو وٝ وٕي ا٘حطاف وٕي افعايف زٞيسpump flowrate .خسيس زاقشٝ ثبقيس 

ضا فؼبَ ٔي وٙس، ؾذؽ ٔمساض  WOBوبض فيّس ٔشٗ ضا ا٘شربة وٙيس. ايٗ  WOBزوٕٝ  ثطٌطزيس. Hydraulics Inputثٝ دٙدطٜ  .5

49.6 Klbf  ضا زض ايٗ فيّس سبيخ ٕ٘بييس. ايٗ وبض ، اذشلاف ثيٗ افز فكبضon- and off-bottom  114زض حسٚز psi  افعايف
 ٔي زٞس.
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 psiسب  Standpipe Pressure (Total Pressure Drop)افز فكبض وّي وّيه ٕ٘بييس.  Pressure Dropظثب٘ٝ  ثط ضٚي .6

 افعايف يبفشٝ اؾز زض حبِي وٝ چبٜ ٞٙٛظ زاضاي ٔحسٚزيز ٔي ثبقس. 3222

ي وٛسبٜ ذيّ Type 3ضا سغييط زٞيس چطا وٝ ٕٔىٗ اؾز  Surface Equipmentزض ايٗ ٔطحّٝ ٕٔىٗ اؾز سهٕيٓ ثٍيطيس وٝ  .7

 ثٝ ٔطاست ٔٙبؾت سط ثبقس. Type 1ثبقس ٚ 

 ثبظ ٌطزيس. Hydraulics Inputsثسٖٚ ثؿشٗ دٙدطٜ ٘شبيح ، ثٝ دٙدطٜ  Surface Equipmentثطاي سغييط  .8

وطزٖ ثط ضٚي ٘ٛاض  ٘ىشٝ: اٌط ٕ٘ي سٛا٘يس ايٗ دٙدطٜ ضا ثجيٙيس ضٚـ ٞبي ظيبزي ثطاي ا٘دبْ ايٗ وبض ٚخٛز زاضز . قبيس يىي اظ ؾبزٜ سطيٗ ضاٜ ٞب وّيه

زؾز ضؾي  Hydraulics Inputsٚ وكيسٖ آٖ ثٝ َطفي اؾز وٝ ثشٛا٘يس ظيط آٖ ضا ثجيٙيس ٚ ثٝ دٙدطٜ  Hydraulics Resultsػٙٛاٖ دٙدطٜ 
 ديسا وٙيس.

 ضا ا٘شربة ٕ٘بييس. Type 1ضا ا٘شربة وطزٜ ٚ اظ ِيؿز وكٛيي  Rigظثب٘ٝ  .9

 

 آٖ ضا ثبظ ٌصاقشيس ثبظ ٌطزيس. 8زض ٔطحّٝ  وٝ Pressure Dropٞٓ اوٖٙٛ ثٝ دٙدطٜ ذطٚخي  .12

 زض ؾٕز ضاؾز ٌطاف وّيه وٙيس. Recomputeثط ضٚي  .11

 ثٟيٙٝ ؾبظي ٘بظَ ٞبي ٔشٝ

 ضا ا٘شربة ٕ٘بييس. Pressure Dropظثب٘ٝ  .1

ٙيس. ضا زض حبِز فؼبَ ضٞب و (Internal, External TJ)اسهبلار اثعاض . سب غيط فؼبَ قٛز ضا ثطزاضيس Cuttingsسيه چه ثبوؽ  .2

 ٔي ثبقس. psi 3215ٞٓ اوٖٙٛ افز فكبض وّي ثطاثط 
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 زض ٌٛقٝ ثبلا ؾٕز ضاؾز ثجٙسيس. ضا ثب وّيه ثط ضٚي  Hydraulics Resultsدٙدطٜ  .3

 ضا ا٘شربة ٕ٘بييس. Bit/Flowظثب٘ٝ  Hydraulics Inputاظ دٙدطٜ  .4

 ثطٚيس. Nozzle Optimizationثٝ ثرف  .5

ضا ا٘شربة Jet Impact Force وّيه ٕ٘بييس. اظ ِيؿز وكٛيي ثبظ قسٜ  Methodثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز فيّس  .6
 ٕ٘بييس.

 ضا سبيخ ٕ٘بييس. psi 3000ٔمساض  Planned Pump Pressزض فيّس  .7

 ٕ٘بيف زازٜ ٔي قٛز. Hydraulics Resultsوّيه ٕ٘بييس. دٙدطٜ  Run Plotsثط ضٚي زوٕٝ  .8
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ٔي ثبقس. ذٍ چيٗ ػٕٛزي لطٔع  Hydraulic Powerٚ ٔٙحٙي ؾجع  Jet Impact Force (JIF)زٚ ٔٙحٙي ضؾٓ ٔي قٛ٘س: ٔٙحٙي آثي 
ٕٞبٖ ٔحسٚزٜ خطيبٖ ٔشٛض  ٚ ذٍ ػٕٛزي ٔكىي ، زثي خطيبٖ وٙٛ٘ي ضا ٘كبٖ ٔي زٞٙس. زض حبَ حبيط ذٍ زثي خطيبٖ ثبيس زض ٔبوؿيٕٓ ٘مُٝ 

 لطاض ٌيطز. gal/min 429ٔٙحٙي آثي زض حسٚز 

٘يبظ زاضيٓ  JIFٔي ثبقس وٝ ثطاي سٕيع وطزٖ حفطٜ ا٘شربة وطزيٓ. ثٙبثط ايٗ ثطاي ثٟيٙٝ ؾبظي  gpm 500شط اظ ٔمساض زثي ٔي زا٘يٓ وٝ ايٗ ٔمساض وٕ

)ٔبوؿيٕٓ فكبض دٕخ(  psi 4000)فكبض وٙٛ٘ي( ٚ  3000فكبضٜ َطاحي قسٜ ضا ٔرشهطي افعايف زٞيٓ.آظٔبيف ثب فكبض ٞبي َطاحي قسٜ ثيٗ 
ضا ثٝ فكبضيس،  tabٚاضز وطزٜ وّيس  Planned Pump Pressure٘يبظ زاضيٓ. ٔمساض  gpm 500ي ٘عزيه ٘كبٖ ٔي زٞس وٝ ثٝ زثي خطيب٘

 ٔٙحٙي زٚثبضٜ ٔحبؾجٝ ذٛاٞس قس.

 ضا سبيخ ٕ٘بييس. psi 3800ٔمساض  Planned Pump Pressureزض فيّس  .9

ٕ٘بيف  Pick Nozzlesٕ٘بييس. دٙدطٜ وّيه  Suggest Nozzlesحبَ ثبيس ثجيٙيٓ ثٝ چٝ ٘بظَ ٞبي ٘يبظ زاضيٓ. ثط ضٚي زوٕٝ  .12
 زازٜ ٔي قٛز.

 

وّيه ٕ٘بييس سب ثٝ  Accept Nozzlesضا ديكٟٙبز ٔي زٞس. ثط ضٚي زوٕٝ   3x13زاضيس ،  BHAزض  3x15ايٗ دٙدطٜ ظٔب٘ي وٝ  .11
 ٘بظَ ٞبي ديكٟبزي سغييط يبثيس.

ثٝ ٕ٘بيف زض ٔي آيس وٝ  Pressure Dropٝ حصف قسٜ ٚ نفح Hydraulics Resultsاظ نفحبر  Bit Optimizationنفحٝ ٘ىشٝ: 
 ثبظ سبة وٙٙسٜ ٘بظَ ٞبي خسيس ٚ افز ٞبي فكبض ٔي ثبقس.

 ٚ دبضأشطٞبي زيٍط ٞٙٛظ زض ايٗ ٔحسٚزٜ ٞؿشٙس. ECD٘ىشٝ: ُٕٔئٗ قٛيس وٝ 
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 شذيطٜ وطزٖ ٚضٚزي ٞب

خطا ثط٘بٔٝ اؾشفبزٜ وطزيس ثٝ ػٙٛاٖ يه فبيُ وٝ زض ا BHA, Geometry  ٚSurveyثٝ قٕب اخبظٜ ٔي زٞس ٚضٚزي ٞبي  Hydraulicsثط٘بٔٝ 
 ٘بٍٔعاضي قسٜ شذيطٜ وٙيس.

ضا ا٘شربة ٕ٘بييس. دٙدطٜ  Save Asضفشٝ ٚ ٌعيٙٝ  Fileثٝ ٔٙٛي  Hydraulics Inputsثطاي شذيطٜ ؾبظي فبيُ ٞبيشبٖ اظ دٙدطٜ  .1

Save As .ٕ٘بيف زازٜ ٔي قٛز 

ٕٞٝ ٌي زض يه فيُ شذيطٜ ٔي  BHA, Geometry  ٚSurveyقشٝ ثبقيس ٔىب٘ي ضا ثطاي شذيطٜ فبيّشبٖ ا٘شربة ٕ٘بييس.سٛخٝ زا .2
 قٛ٘س.

 وّيه ٕ٘بييس. Saveٚاضز وطزٜ ؾذؽ ثط ضٚي زوٕٝ  File Name٘بٔي ضا زض  .3

 زٜ لطاض ٔي ٌيطز.دطأشط ٞبي آيشٓ ٞب شذيطٜ ٔي قٛ٘س ، ٘ٝ وذي اَلاػبر آٟ٘ب، ثٙبثطايٗ ٞط سغييط زض آٟ٘ب ايدبز قٛز زض اخطا ثؼسي ٔٛضز اؾشفبسٟٙب ٘ىشٝ: 

 ثبض ٌعاضي فبيُ شذيطٜ قسٜ
 فبيُ ٞبي شذيطٜ قسٜ ضا ٔي سٛا٘يس ثب اؾشفبزٜ اظ زؾشٛضاِؼُٕ ٞبي ظيط ثبضٌعاضي وٙيس.

ثط ضٚي سبظٜ سطيٗ ِيؿز زؾشٛضي  Fileضا ا٘شربة ٕ٘بييس ٚ يب اظ ٔٙٛي  Openضفشٝ ٚ ٌعيٙٝ   Fileثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .1
 ٕبييس.اؾشفبزٜ قسٜ وّيه ٘

ٔي ثبقس وٝ ثطاي ثبض ٌعاضي ٚضٚزي  File > Load Last Inputsزض ثبضٌعاضي اَلاػبر ٔي سٛاٖ اؾشفبزٜ وٙيس  اظ ٌعيٙٝ ٞبي ٔفيس زيٍط ٘ىشٝ:

آذطيٗ فبيُ ٞبي وٝ وبض وطزٜ ايس ٕ٘بيف زازٜ ٔي قٛز وٝ ثب وّيه ثط ضٚي آٖ  Load Last Inputsٞبي زؾشي ٔي ثبقس. زضؾز زض ظيط ٌعيٙٝ 
 ٔي سٛا٘يس ثبضٌعاضيف وٙيس.

  

 Swab & Surge -7ثرف 

 وبض ضا قطٚع وٙيٓ. User-defined Tripping Scheduleضا ثطضؾي ذٛاٞيٓ وطز. ثيبيس ثب سحّيُ  Swab and Surgeٞٓ اوٖٙٛ ٚيػٌي 

 ضا ا٘شربة ٕ٘بييس. Openضفشٝ ٚ ٌعيٙٝ   Fileثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .1
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 Program Files > Schlumberger > Drillingثٝ ٔؿيط  SwabSurge.hydregبيُ ثطاي ثبظ وطزٖ ٕ٘ٛ٘ٝ ف .2

Office > bin > asl_data .ثطٚيس 

 وّيه ٕ٘بييس. Files of typeثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز فيّس  .3

ٕ٘بيف زازٜ  Hydraulics Inputsوّيه وٙيس. دٙدطٜ  Openضا ا٘شربة ٕ٘بييس. ثط ضٚي زوٕٝ  SwabSurge.hydregفبيُ  .4
 ٔي قٛز.

 

 ثطٚيس.  Parametersضا ا٘شربة ٕ٘بييس. ثٝ ثرف  Swab/Surgeظثب٘ٝ  .5
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Pumps On  ا٘شربةPumps On  ٝٔايٗ اخبظٜ ضا ثٝ ثط٘بHydraulics  زثي خطيبٖ دٕخ ٚاضز قسٜ ٔي زٞس وٝ اظ
 زض نفحٝ اؾشفبزٜ وٙس.

Pumps Off  ا٘شربةPumps Off  طز.زض ٘ظط ٔي ٌي 0زثي خطيبٖ ضا 

Acceleration/Deceleration 0.6 دبضأشط feet/sec2  زضAcceleration/Deceleration  ٝثٝ ايٗ ٔؼٙب ٔي ثبقس و 

the time from rest to full tripping speed for the top section is 5 
seconds 

Stand Length Stand Length  ،90 feet  ٖثٝ ٔؼٙي ٚاضز وطزstand طي ٔي ثبقس ٘ٝ اسهبلار ٞبي اظ ِِٛٝ حف
 سىي زض آٖ ٔٛلغ.

Gauges Sensor Location  40.25)ٔحُ ؾٙؿٛض( زض feet .ثبلاي ٔشٝ اؾز 
Formation Marker  ،14000 feet  500يب feet ثبقس. ظيط ِِٛٝ خساضي ٔي 
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 ايدبز قٛز. Swab/Surge Plotوّيه وٙيس سب  Run. حبَ وٝ ٚضٚزي ٞب ضا وبٔلا ثطضؾي ٕ٘ٛزيس ثط ضٚي زوٕٝ 6

 

 ٚظٖ ٌُ ٞٓ اضظ ٔشٝ زض ٔمبثُ ػٕك ا٘ساظٜ ٌيطي قسٜ ضا ٘كبٖ ٔي زٞس.ايٗ ٌطاف ٘ىشٝ: 

 ٕ٘بيف زازٜ ٔي قٛز. Report Logosوّيه ٕ٘بييس. دٙدطٜ  Reportثط ضٚي زوٕٝ  .6

 وّيه ٕ٘بييس. OKثط ضٚي زوٕٝ  .7

 ضا ثيبثيس. Swab/Surgeضا دبييٗ ثىكيس سب ثرف  Scrollزض نفحٝ ٌعاضـ  .8
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Swab/Surge Output  ضا ثطضؾي ٕ٘ٛزٜ ٚ ٚظٖ ٌُ ٞٓ اضظ ثبbit ، )ٔٙظٛض ٚظٖ ٌُ زض ػٕمي اؾز وٝ ٔشٝ لطاض زاضز(casing shoe  ،
sensor location  ٚformation marker  .ثب اؾشفبزٜ اظ زض ثطاثط ػٕك ٔشٝ ثرٛا٘يسScroll  ٖٛثٝ ؾش( َٚثٝ ؾٕز ضاؾز خسG )Total 

Tripping Time ؽ ثب اؾشفبزٜ اظ ثطٚيس ؾذScroll  ٚ ٝ6.76ثٝ دبييٗ نفحٝ ضفش hrs .وطزٖ ؾفز ٚ زض ايٗ ٌعاضـ ظٔبٖ ثؿشٗ ضا ثرٛا٘يس 
(ِِٝٛconnection make-up time( ظٔبٖ قشبة ٚ قشبة ٔٙفي ، )acceleration and deceleration time ثٝ ػلاٜٚ ظٔبٖ يه )

tripping ٖٚٚخٛز زاضز وكيسٜ ٔي قٛز وبُٔ ثطاي ٞط ََٛ ِِٛٝ اي وٝ اظ چبٜ ثيط. 

 ضا ثطضؾي ذٛاٞيٓ وطز. Swab and Surge   ،Margin-Based Tripping Scheduleٞٓ اوٖٙٛ ٘ٛع زيٍطي اظ سحّيُ 

 ضا ثجٙسيس. Swab/Surge Report  ٚSwab/Surge Plotدٙدطٜ ٞبي  .1

 ضا ا٘شربة ٕ٘بييس. Swab/Surgeظثب٘ٝ  Hydraulics Inputاظ دٙدطٜ  .2

 ضا ا٘شربة ٕ٘بييس. Margin-Based Tripping Scheduleثطٚيس ٚ زوٕٝ  Analysis Typeثٝ ثرف  .3
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 Swab/Surge  ٚRheologyاَلاػبر ٟٔٓ زضثبضٜ اثطار ٔشمبثُ ٚضٚزي 
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 ٘ىشٝ ٞب: 

  ٚلشيP-T Rheology  ثط ضٚيOFF  ٚ ٜسٙظيٓ قسDirection  ٘يعRIH  ٔي ثبقسSurge Trip Margin  ٝثMud 

Weight  ٝزض نفحRheology .ايبفٝ ٔي قٛز 

  ٝٚلشي وDirection  ثطاثط،POOH  ٔي ثبقسSwab Trip Margin  اظMud Weight  ٝاذص قسٜ اظ نفحRheology 
 وٓ ٔي قٛز.

  اٌطEMW  ٜٔحبؾجٝ قسٜ زض ٔشٝ ذبضج اظ دٙدطtrip .ثبقس. ٔمساضـ ثٝ ضً٘ لطٔع زض ٌعاضـ ٔكرم ٔي قٛز 

  ٝٚلشي وP-T Rheology  ثط ضٚيOn/Theoretical  يبOn/Semi-Empirical  سٙظيٓ قسٜ ثبقس  ٚظٖ ٌُ ٔجٙب اظ
 اؾز. Equivalent Static Densityٕ٘ي ثبقس أب ٔشٙبظط ثب  Mud Weightثطاثط ثب  Rheologyنفحٝ 

  ٝٔثط٘بHydraulics  ثطاي سحّيُ ٞبيUser-Defined Tripping Schedule  اظ ٔطظٞبي ديٕبيف ٔكبثٟي اؾشفبزٜ ٔي
 وٙس.

 حيٗ سٛلف زض ٔطظ ٞبي سٙظيٓ قسٜ ايدبز قٛز. وٝ ثيكشطيٗ ؾطػز ٞبي ديٕبيف يديٕبيكسب ٔطظ  وّيه وٙيس  Runٝ ثط ضٚي زوٕ .1
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 Maximumثطاي  User-Defined Tripping Scheduleٔي ثبقس، ft/s 5 ٘ىشٝ: ثيكشطيٗ ؾطػز ديٕبيف ثطاي  ايٗ ٔطظ ثٟيٙٝ قسٜ 

Surge Pressure  231.4ثطاثط ثب psi ٝ20000 زض ػٕك ٔش feet .ٔي ثبقس 

 ٕ٘بيف زازٜ ٔي قٛز. Report Logosوّيه ٕ٘بييس. دٙدطٜ  Reportثط ضٚي زوٕٝ  Swag/Surge Scheduleاظ دٙدطٜ  .2

ثٝ ثرف  Scrollٕ٘بيف زازٜ ٔي قٛز. ثب دبييٗ وكيسٖ  Swab/Surge Reportوّيه ٕ٘بييس.  OKثط ضٚي زوٕٝ  .3

Swab/Surge Output .ٌعاضـ ثطٚيس 

 Tripثبقس زض حبِيىٝ ٞيچ ٔمساضي اظ ٔطظ ديٕبيف ) feet/sec 5( زض trippedوٙيس آيب ٕٔىٗ اؾز ثرف ثبلاي ؾطػز ديٕبيف ) ثطضؾي٘ىشٝ: 

Margin.ثٝ ضً٘ لطٔع ػلأز ٌصاضي ٘كسٜ ثبقس ) 
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زض لؿٕز ثبلا  G)ٕٞبُ٘ٛض وٝ زض ؾشٖٛ  hrs 5.50ثٝ ا٘شٟبي خسَٚ ثطٚيس ٚ ظٔبٖ ديٕبيف وّي ضا ثٝ نٛضر  Scrollثب اؾشفبزٜ اظ  .4
ٔطظ ٞبي ديٕبيف سٛؾٍ وبضثط سؼييٗ ٔي قٛ٘س وٝ وٝ  ظٔب٘ي ثطاثط  hr 15 mins 1٘كبٖ زازٜ قسٜ ( ثرٛا٘يس. ايٗ نطفٝ خٛيي زض 

 ايٗ ٔيشٛ٘ٝ سفؿيط ثكٝ ثٝ زٜ ٞب ٞعاض زلاض ٞعيٙٝ زوُ.

 Power Drive  ٚMotorاخطا ٞبي  -7ثرف
 ضا زض قشٝ حفبضي ٔكبثٝ زض اذشيبض قٕب لطاض ٔي زٞس. power driveٛض ٚ ، ٞٓ اوٖٙٛ سٛا٘بيي اخطاي ٔشHydraulicsضٚـ 

 ثبض ٌعاضي اَلاػبر

 ٕ٘بيف زازٜ ٔي قٛز. Openضا ا٘شربة ٕ٘بييس. دٙدطٜ   Openضفشٝ ٚ ٌعيٙٝ   Fileثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .1

 لطاض زاضز ثطٚيس. bin > asl_dataثٝ ٕ٘ٛ٘ٝ فبيُ اَلاػبسي وٝ زض زايطوشٛضي  .2

وّيه وطزٜ ؾذؽ  SwabSurge.hydregضا ا٘شربة ٕ٘بييس. ثط ضٚي  hydreg.*ٌعيٙٝ  Files of typeاظ ِيؿز وكٛيي  .3
 ضا وّيه وٙيس. Openزوٕٝ 

 BHAٚيطايف 

 اخطا ٔي قٛز. BHA Editorضا ا٘شربة ٕ٘بييس. ثط ٘بٔٝ  BHAضفشٝ ٌعيٙٝ  Editثٝ ٔٙٛي   Hydraulicsاظ دٙدطٜ انّي  .1

2. BHA .ضا ثؿٍ زٞيس 
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 ضا ا٘شربة ٕ٘بييس. Rotary Steerable > Anadrill > 6 3/4" OD > PD 675ٔؿيط  Catalogاظ  .3
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 سهٛيط ضا ٌطفشٝ ٚ ظيط ٔشٛض ضٞب وٙيس. .4

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   184 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

 + demoٕ٘بيف زازٜ ٔي قٛز.  Save Asضا ا٘شربة ٕ٘بييس. دٙدطٜ  Save Asضفشٝ ٚ ٌعيٙٝ  Fileثٝ ٔٙٛي  BHAاظ دٙدطٜ انّي  .5

PD 675’ ٚ ٜثط ضٚي زوٕٝ  ضا سبيخ وطزOK .وّيه ٕ٘بييس 

 BHAثبضٌعاضي 

 A675M1240SP Motor Bearing Flowثطاي  %5ٚاضز وطزٜ ٚ ٔمساض  Hydraulicsوٝ ثٝ سبظٌي ٚاضز وطزيس زض  BHAزض ايٗ سٕطيٗ، 
 ٚاضز ٔي وٙيس.

زازٜ ٔي  Select  BHAوّيه وٙيس. دٙدطٜ ٕ٘بيف  BHAثط ضٚي زوٕٝ خؿشدٛ زض ؾٕز ضاؾز فيّس  Hydraulicsز ض ثط٘بٔٝ  .1
 قٛز.

 demoضا ايدبز وطزيس ثطٚيس.  BHAثٝ ٔحّي وٝ ثٝ سبظٌي  Zeus > A. Structure > W-13 > B-13 > Planثب ا٘شربة  .2

+ PD675’ .ضا ا٘شربة ٕ٘بييس 
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 ثبضٌعاضي ٔي قٛ٘س. Hydraulicsزض ثط٘بٔٝ  BHAوّيه ٕ٘بييس. اَلاػبر  OKثط ضٚي زوٕٝ  .3
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 ضا سبيخ ٕ٘بييس.  5ػسز  Motor Bearing Flowٕبييس. زض فيّس ضا ا٘شربة ٘ Motorظثب٘ٝ  .4
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 :ٟٓٔHydraulics ، ٖؾيؿشٓ  زضنس ٔحطن خطيبRotary Steearable  زض دبضأشط ٞبي يبفز قسٜ زض وبضثطي

asl_ccl\drill_rotary_steerable_cat.csv  وٝ زضbin directory.ٞيچ اٌط  ٔي ثبقٙس ضا ٔحبؾجٝ ٔي وٙٙسBias Unit Flow 

Restrictor  ٚخٛز ٘ساقشٝ ثبقٝ آٖ ٔمساض ثطاثط ثب نفط ٔي قٛز. ثرفA  ُاظ فبيcsv .زض قىُ ظيط ٘كبٖ زازٜ قسٜ اؾز 

 

 وّيه ٕ٘بييس. ديبْ ظيط ثٝ ٕ٘بيف زض ٔي آيس. Run Plotsثط ضٚي زوٕٝ  Hydraulicsزض دٙدطٜ  .5
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ٌٛيس ػٕك ا٘ساظٜ ٌيطي قسٜ ثعضٌشط اظ ََٛ ضقشٝ حفبضي ٔي ثبقس. ضا وّيه وٙيس. ديبْ زيٍطي ثٝ ٕ٘بيف زض ٔي آيس وٝ ٔي  OKزوٕٝ  .6

 ضا وّيه ٕ٘بييس. OKزوٕٝ 

ضا وّيه  OKٕ٘ي ثبقٙس. زوٕٝ  TJ ID = 0يه ديبْ ٞكساض ثٝ ٕ٘بيف زض ٔي آيس وٝ ٘كبٖ ٔي زٞس ٞيچ وساْ اظ ذٌُٛ ِِٛٝ زاضاي  .7
 ٕ٘بييس.

ضا  OKذبضج اظ ٔحسٚزٜ ٚالؼي خطيبٖ دٕخ ٔٛسٛض ٔي ثبقس. زوٕٝ  َطح، ديبٔي ثٝ ٕ٘بيف زض ٔي آيس وٝ ٔي ٌٛيس ٔحسٚزٜ زثي خطيبٖ .8

 ايدبز قسٜ ٚ ٕ٘بيف زازٜ ٔي قٛ٘س. hydraulicsوّيه ٕ٘بييس. ٘شبيح 
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 ٔكبٞسٜ ٌعاضـ

 وّيه ٕ٘بييس. Run Reportثط ضٚي زوٕٝ  Hydraulics Resultsاظ دٙدطٜ  .1

 وّيه ٕ٘بييس سب آٖ ضا لجَٛ وطزٜ ثبقيس. OK٘س ٞط ثبض ثط ضٚي ؾٝ ديبٔي وٝ لجلا ثٝ ٕ٘بيف زض آٔس٘س زٚثبضٜ ظبٞط ٔي قٛ .2

www.Ir وّيه ٕ٘بييس. ٌعاضـ ٕ٘بيف زازٜ ٔي قٛز. OKٕ٘بيف زازٜ ٔي قٛز. ثط ضٚي زوٕٝ  Report Logosدٙدطٜ  .3
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 PT Rheology -8ثرف 

س. سٕبْ دٙدطٜ ٞبي اَلاػبر اؾشفبزٜ وٙي P-T (Pressure - Temperature)ٞٓ اوٖٙٛ يبز ذٛاٞيس ٌطفز وٝ چُٛض اظ ٚيػٌي ٞبي 

Hydraulics  .ضا ثجٙسيس 

 :ٟٓٔ*.hydreg  فطٔز فبيُ اَلاػبسي وٝ ثب ٘ؿرٝ ٞبي لجّيHydraulics  ٝايدبز قسٜ ضا ٘كبٖ ٔي زٞس. ٕٞٝ اَلاػبر خسيس اظ ايٗ ِحظٝ ث

ثبضٌعاضي وٙيس أب ثٝ ٔدطز شذيطٜ ؾبظي  hydreg.*ُ شذيطٜ ٔي قٛ٘س. ٞٙٛظ ٔي سٛا٘يس اَلاػبر  ضا ثب دؿٛ٘س فبي (hyd.*)ثؼس ثب دؿٛ٘س فبيُ خسيس 
 ايٗ اَلاػبر فبيّشبٖ دؿٛ٘س فبيُ خسيس ضا ثٝ ذٛز ٔي ٌيطز.

ثٝ فبيُ ٕ٘ٛ٘ٝ ٕ٘بيف زازٜ ٔي قٛز.  Openضا ا٘شربة ٕ٘بييس. دٙدطٜ   Openضفشٝ ٚ ٌعيٙٝ   Fileثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .1

 ثطٚيس. PTRheology.hydregاَلاػبر 

فبيُ  .ضا ا٘شربة ٕ٘بييس Program Files > Schlumberger > Drilling Office > bin > asl_dataٔؿيط  .2

PTRheology.hydreg .ضا ا٘شربة ٕ٘بييس 

 ٕ٘بيف زازٜ ٔي قٛز. Hydraulics Inputs-PTRheologyوّيه ٕ٘بييس. دٙدطٜ  Openثط ضٚي زوٕٝ  .3

 يس.سٙظيٓ وٙ On/Theoreticalضا ثط ضٚي ٌعيٙٝ  P-T٘ىشٝ: 
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 ٘ىشٝ ٞب:

  سٙظيٕبرTheoretical  ٘كبٖ ٔي زٞس وٝ سٙظيٕبر وّي يطايت، ثطاي سرٕيٗ اثط زٔب ٚ فكبض ضٚي ضئِٛٛغي ٚ زا٘ؿيشٝ ٌُ ٔٛضز
 اؾشفبزٜ لطاض ذٛاٞٙس ٌطفز.

  يب ثٝ ػجبضر زيٍط %0زض ايٗ ٔثبَ ٌّي ثب ٘ؿجز ٘فز ثٝ آة WBM  آة زاضيٓ. %100ثب 

 Mud Weight  11.55ثطاثط lbm/gal ( 14.7ٔي ثبقس وٝ زض ٔحسٚزٜ زٔب ٚ فكبض psi or atmospheric, and 68 F )
 ا٘ساظٜ ٌيطي قسٜ اؾز.

  ٔجٙبيPlastic Viscosity  40ضا ثطاثط cP  ٚYield Point  29ضا lbf/100 ft2   . ثطاي ايٗ قجيٝ ؾبظي لطاض زٞيس

Bingham Plastic .فكبض ٚ زٔب زض ٔحسٚزٜ ٔكبثٟي زازٜ ٔي قٛز ، 

 ضا ا٘شربة ٕ٘بييس. دٙدطٜ ظيط ٕ٘بيف زازٜ ٔي قٛز. Temperature٘ٝ ظثب .4
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 ٘ىشٝ ٞب:

 Water Depth 0 ثطاثط ft  .ايٗ ٔمساض ثطاثط ثب ٔي ثبقسon-land rig  ُٔي ثبقس وٝ زض فبيWellbore Geometry  سؼطيف

ٚ  Sea Floor Temperature ،Thermocline Temperatureقسٜ ٚ ٔؿشميٕب اظ دبيٍبٜ زازٜ ذٛا٘سٜ ٔي قٛز. ثٙب ثطايٗ 

Thermocline Depth .غيط فؼبَ ٔي ثبقٙس 

 Pump Flowrate  ٝثطاي ايٗ قجيٝ ؾبظي زٔبيي اظ نفحBit/Flow (400 gal/min) .ٌطفشٝ ٔي قٛز 

 وّيه ٕ٘بييس. Run Plotsثط ضٚي زوٕٝ  .5

 زض  ٚ سبثيط ٞط زٚ ٔي وٙس حؿبة ضا  ؾذؽ فكبض  ٚ( circulationزض اثشسا دطٚفيُ زٔب ضا زض ؾطاؾط ؾيؿشٓ چطذف ) Hydraulics٘ىشٝ: ثط٘بٔٝ 

mud rheology  ٚdensity  ٖٚزض دبييٗ زضannulus  .وُ ٔشٝ ٚ ؾذؽ زض ثبلا، ضقشٝ حفبضي ٚ سدٟيعار ؾُحي ٔحبؾجٝ ٔي قٛز ،total 

standpipe pressure  2535ضز ايٗ ٔٛضز psi .ٔي ثبقس 

ٕ٘بيف زازٜ ٔي  P-T Resultsضا ا٘شربة ٕ٘بييس.  دٙدطٜ  P-T Rheologyٚ  قسٜ Viewٚاضز ٔٙٛي  Hydroاظ دٙدطٜ انّي  .6

 Pressure, Temperature, Equivalent Mudٔي سٛا٘يس ( multi-tab outputقٛز. اظ دٙدطٜ ذطٚخي چٙس ظثب٘ٝ اي )

Weight, Plastic Viscosity and Yield Point profiles, all plotted against Measured Depth, 
throughout the Drill String and Annulus .ثطضؾي ٕ٘بييس 
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ضا ا٘شربة ٕ٘بييس. دٙدطٜ  Hydraulics Inputs - PTRheologyقسٜ  ٌعيٙٝ  Windowٚاضز ٔٙٛي  Hydroاظ دٙدطٜ انّي  .7

Hydraulics Inputs – PTRheology .ٕ٘بيف زازٜ ٔي قٛز 

 ضا ا٘شربة ٕ٘بييس. Rheologyظثب٘ٝ  .8

ضا اظ ِيؿز وكٛيي On/Semi- Empirical يس. ثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز فيّس وّيه ٕ٘بييس.ثطٚ P-Tثٝ فيّس  .9
 ا٘شربة ٕ٘بييس.

 – Fit Typeٔي ٌٛيس ثب يطايت ٔٛضز ٘يبظ ثطاي سرٕيٗ اثط زٔب ٚ فكبض  ثب اؾشفبزٜ اظ ا٘شربة  Hydraulicsايٗ اسشربة ثٝ ثط٘بٔٝ ٘ىشٝ: 

Exponential   َزض ػٛو اؾشفبزٜ اظ يطايت وّي وٝ زض نفحٝ يب ذُي زض ٔثبOn/Theoretical زيسيٓ ٔشٙبؾت قٛز. 
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ٔٙبؾت زض  pressure  ٚtemperatureضا زض ٔمبثُ  Fann٘ىشٝ: ٕٞبٖ َٛض وٝ زض ثبلا ٘كبٖ زازٜ قسٜ ثط ٘بٔٝ ٕٞٝ ضزيف ٞبي اَلاػبر 
شذيطٜ قسٜ ا٘س.( ؾشٖٛ ٞبي  PTRheology.hydregزض فبيُ  ٔثبَ ٔب ، ايٗ اَلاػبر( لطاض ٔي زٞس.  زض spreadsheetنفحٝ ٌؿشطزٜ )

ا٘شربة قسٜ اؾشفبزٜ قسٜ ا٘س. وٝ زض ايٗ ٔثبَ  Rheologicalٔكرم قسٜ ثب ضً٘ ظضز، اَلاػبسي ٞؿٙشس وٝ ثطاي ٔشٙبؾت وطزٖ اؾبؼ ٔسَ 
Bingham Plastic.اؾشفبزٜ قسٜ اؾز 

12. Scroll  ضا زض نفحٝ ٌؿشطزٜ اَلاػبرFann ٙيس.دبييٗ ٚ ثبلا و 

چه ٔبضن ٔي قٛ٘س. ايٗ چه ٔبضن ثٝ قٕب اخبظٜ ٔي زٞس سب آيشٓ ٞبيي وٝ زض َطح ذطٚخي  3ؾشٖٛ ضزيف ٔٛخٛز زض  22ضزيف اظ  12سٟٙب ٘ىشٝ: 

P-T Fit Type Check  ٕ٘بيف زازٜ ٔي قٛز ضا وٙشطَ وٙيس. ايٗ وبض ثٝ ٔٙظٛض ٔطست ٚ ٔٙظٓ وطزٖ ا٘دبْ ٔي قٛز ظيطا زض غيط ايٗ نٛضر َطح

 سٕبْ ضزيف ٞبي اَلاػبر ٚاضز قسٜ ٔشٙبؾت ٔي وٙس ذٛاٜ چه ثبوؿكبٖ ا٘شربة قسٜ ثبقس يب ٘ٝ. Hydraulicsي ذيّي قّٛؽ ٔي قٛز. ثط٘بٔٝ ثؼس

 P-Tضا ا٘شربة ٕ٘بييس. دٙدطٜ  P-T Fann Fit Checkضفشٝ ٚ ٌعيٙٝ  Optionsثٝ ٔٙٛي  Hydraulicsاظ دٙدطٜ انّي  .11

Rheology Plot .ٕ٘بيف زازٜ ٔي قٛز 
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ضا ثطاي ايٗ اَلاػبر سُجيك ٔي زٞس. ايٗ َطح  Plastic Viscosity  ٚYield Pointاَلاػبر چبٞي   Exponential Fit Type٘ىشٝ: 
 ثب اَلاػبر ٕ٘بيف زازٜ قسٜ ٔشٙبؾت قسٜ ا٘س. psi 10000ٚ  7500اَلاػبر ضا ٕ٘بيف ٔي زٞس أب  psi 5000ٚ  2500سٟٙب اَلاػبر فكبض 

ضا ا٘شربة ٕ٘بييس. دٙدطٜ  Hydraulics Inputs – PTRheologyضفشٝ ٚ ٌعيٙٝ  Windowثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .12

Hydraulics Inputs – PTRheology .ٕ٘بيف زازٜ ٔي قٛز 

 ضا دبن وٙيس. Sensitivity Analysis and Annulus Detailed Reportچه ثبوؽ  .13

 Flowrate Sensitivity Analysis  ٚAnnulus Detailedضفشٝ ٚ ٌعيٙٝ Options ثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .14

Report  .ُٕٔئٗ قٛيس ٞط زٚ اظ حبِز ا٘شربة ذبضج قسٜ ا٘س.ضا ا٘شربة ٕ٘بييس 

 ٕ٘بيف زازٜ ٔي قٛز. Report Logosوّيه ٕ٘بييس. دٙدطٜ  Run Reportثط ضٚي زوٕٝ  .15

 وّيه ٕ٘بييس. OKثط ضٚي زوٕٝ  .16

 زض ا٘شٟبي ٌعاضـ ا٘شربة ٕ٘بييس. P-T Rheologyظثب٘ٝ ٚلشي وٝ دٙدطٜ ٌعاضـ ثٝ ٕ٘بيف زض آٔس  .17

 

 Pressure, Temperature, Mud Weight, Plastic Viscosity  ٚYieldٔجيٗ دطٚفيُ ٞبي  P-T Rheology ٌعاضـ٘ىشٝ: 

Point  زضannulus  ٚdrillstring .ٔي ثبقس 

ٕٛػٝ دطٚفيُ ٞبي ظيط ثطاي ايٗ قجيٝ ؾبظي ضا ثطاي ايدبز ٔد Hydraulics ،View > P-T Rheology زض ٔٙٛي انّي  .18
 ا٘شربة ٕ٘بييس.
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 ثط ضٚي ٞط ظثب٘ٝ وّيه ٕ٘بييس سب َطح ٞبي دطٚفيُ ٕ٘بيف زازٜ قٛز. .19

 َطح ٞب ٚ ٌعاضقبر -8ثرف

ٌعاضـ  ٞبيoptionايدبز وٙيس. زض اثشسا ُٕٔئٗ قٛيس وٝ ٕٞٝ  Hydraulic Inputsقٕب ٔي سٛا٘يس ٌعاضقي اظ ٞط نفحٝ ذطٚخي يب اظ دٙدطٜ 
 فؼبَ ٞؿشٙس.

ضا ا٘شربة ٕ٘بييس. دٙدطٜ  Hydraulics Inputs – PTRheologyضفشٝ ٚ ٌعيٙٝ  Windowثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .1
Hydraulics Inputs – PTRheology .ٕ٘بيف زازٜ ٔي قٛز 

ضا  Sensitivity Analysis  ٚAnnulus Detailed Reportضفشٝ ٚ ٌعيٙٝ Options ثٝ ٔٙٛي  Hydroاظ دٙدطٜ انّي  .2
 ا٘شربة ٕ٘بييس. ُٕٔئٗ قٛيس ٞط زٚ اظ حبِز ا٘شربة ذبضج قسٜ ا٘س.

 وّيه ٕ٘بييس. Run Reportثط ضٚي زوٕٝ  .3

 ذلانٝ ٌعاضـ

 ٔي ثبقس. output propertyزض ثطٌٝ ٞبي اِٚيٗ نفحٝ ٌعاضـ ، نفحٝ ذلانٝ اي اظ ٚضٚزي ٞب ٚ ٔطٚض ٔرشهطي اظ ٘شبيح 
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 ٌعاضـ ٔفهُ

 ,annular ID, OD, measured depth, inclination, TVDخعئيبر ، ( ضا ا٘شربة ٕ٘بييسDetailsظثب٘ٝ زْٚ ) .1

annular velocity, critical transport rate, flow regime  ٚReynolds Number .٘كبٖ زازٜ قسٜ اؾز 

 

 ٌعاضـ حؿبؾيز

 طيبٖ دٕخ ٘كبٖ زازٜ ٔي قٛز.ثطاي زثي خ ECDافز فكبض ٚ  ( ضا ا٘شربة ٕ٘بييس.Sensitivityظثب٘ٝ ؾْٛ  ) .1

 

ٌعاضـ قٕب ضا  File > Export (Save)اؾشفبزٜ وٙيس. زؾشٛض  File٘ىشٝ: ثطاي شذيطٜ ؾبظي ٚ چبح ايٗ ٌعاضقبر اظ ٌعيٙٝ ٞبي ٔٛخٛز زض ٔٙٛي 
 ٔي ٘ٛيؿس. Tabbed Text fileيب  Excelزض 

 انلاح ٌعاضقبر
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ثبظ  Excelس ٚيطاؾشبضي قٛ٘س ٍٔط ايٙىٝ آٟ٘ب ضا زض ٚيطاؾشبض زيٍطي ٕٞچٖٛ اغّت فيّس ٞب زض ٌعاضقبر لفُ ٔي ثبقٙس ٚ ٕ٘ي سٛا٘ٙ .1

ثٝ ٚيػٜ آٟ٘بيي وٝ ٞيچ اثطي ثطضٚي ٘شبيح ٔحبؾجٝ قسٜ يب اؾبٔي اَلاػبر سغييط يبثٙس  flyآيشٓ  ٞب ٔي سٛا٘ٙس زض  اظ سؼساز وٕي. وٙيس
، ... ٔي ثبقٙس. ٕٞچٙيٗ فيّس ٞبي وٙشطَ ويفيز ٔي  Operator, Well Name, Districtايٗ آيشٓ ٞب قبُٔ ٚاضز وطزٖ ٘ساض٘س. 

ٚيطايف قٛ٘س. ثطاي زيسٖ ٕٞٝ ؾَّٛ ٞبيي وٝ ٔي سٛا٘ٙس ثٝ َٛض  Summary Reportزض ٌٛقٝ اي اظ ا٘شٟبي ؾٕز ضاؾز  سٛا٘ٙس
لبثُ ٚيطاؾشبضي  ضا فكبض زٞيس. ٔىبٖ ٕ٘ب ثٝ ؾَّٛ Tabلطاض زٞيس ٚ وّيس  A1( ضا زض cursorزؾشي ٚيطايف ٔي قٛ٘س ٔىبٖ ٕ٘ب )

ازأٝ زٞيس سب ثٝ ذلانٝ ٌعاضـ زضؾز ثطٚيس ٚ زليمب ثجيٙيس وٝ چٝ ؾَّٛ ٞبيي ضا ٔي سٛا٘يس  Tabثؼسي ذٛاٞس دطيس. ثٝ فكبض زازٖ 
 سغييط زٞيس. ثٝ ٌعاضقبر زيٍط ثطيس ٚ آٖ ٞب ضا ٘يع ثطضؾي ٕ٘بييس.

 انلاح ٚ شذيطٜ َطح ٞب

 شذيطٜ وٙيس. motor power٘ٛقز اظ ٔٙحٙي ٞبي ٌطافيىي فطو وٙيس وٝ قٕب ٔي ذٛاٞيس يه وذي سفؿيط 

1. Summary Report  ٜضا ثجٙسيس ٚ ثٝ دٙدطHydraulics Results .ثبظٌطزيس 

 ضا ا٘شربة وٙيس. Motor Analysisظثب٘ٝ  .2

 Format Seriesضا ثب زاثُ وّيه وطزٖ ثط ضٚي آٖ سغييط زٞيس. دؽ اظ زاثُ وّيه دٙدطٜ  blue motor curveضً٘ ذٍ  .3
 ٕبيف زازٜ ٔي قٛز.٘

 

وّيه وٙيس  Colorزوٕٝ خٟز زاض زض ؾٕز ضاؾز فيّس ضا ثٝ ٔٙظٛض ثطخؿشٝ سط وطزٖ ظبٞط آٖ لطٔع وٙيٓ. ثط ضٚي ثيبيس ضً٘ ٔٙحٙي  .4
 ثطاق سطيٗ ضً٘ لطٔع ضا ا٘شربة ٕ٘بييس.ٞب ضا ثجيٙيس ٚ ؾذؽ  ضً٘ سب خسَٚ

 ف زازٜ قسٜ وّيه ٕ٘بييس.ٞٓ اوٖٙٛ ذٍ قٕب لطٔع ٔي ثبقس.وّيه ٕ٘بييس. زض خبي ذبضج اظ ٔٙحٙي ٕ٘بي OKثط ضٚي زوٕٝ  .5
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 ضا ُٔبثك قىُ ظيط ا٘شربة ٕ٘بييس.  ..Titleٔي سٛا٘يس ثب ضاؾز وّيه وطزٖ ثط ضٚي ٌطاف ػٙٛا٘ي ضا ثٝ آٖ ايبفٝ ٕ٘بييس. ٔٙٛي  .6

 

 ٕ٘بيف زازٜ ٔي قٛز. Format Titleدٙدطٜ 
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فؼبَ ٔي   tabs, fields, and radio buttons( قٛز. ٕٞٝ visibleٗ )ضا ا٘شربة ٕ٘بييس سب ػٙٛاٖ ضٚق Visibleچه ثبوؽ  .7
 قٛ٘س.

 ضا ا٘شربة ٕ٘بييس. Textظثب٘ٝ  .8
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 ضا سبيخ ٕ٘بييس. A675XP4570 - Tutorial Graphػجبضر  Textزض فيّس  .9

 ييس.ضا سبيخ ٕ٘ب 11ػسز  Sizeوّيه ٕ٘بييس. زض فيّس  Fontثط ضٚي ظثب٘ٝ  11ثطاي وبٞف ا٘ساظٜ فٛ٘ز سبٖ ثٝ  .12

( ػٙٛاٖ ضا ثٝ ثبلاي drag and dropوّيه ٕ٘بييس. ػٙٛاٖ زض ٌطاف ظبٞط ٔي قٛز اظ ضٚـ وكيسٖ ٚ ضٜ وطزٖ ) OKثط ضٚي زوٕٝ  .11
 َطح ا٘شمبَ زٞيس.

 

ضا ا٘شربة  Save Asثبظ قٛز.ٌعيٙٝ ٞب optionسب ٔٙٛي  وٙيس ٞٓ اوٖٙٛ آٔبزٜ ايس سب ٌطاف ضا شذيطٜ وٙيس.ثط ضٚي چبضر وّيه ضاؾز  .12
 ييس. ايٗ وبض دٙدطٜ ضا ثبظ ٔي وٙس وٝ ثٝ قٕب اخبظٜ ذٛاٞس سب ايٗ ٌطاف ضا زض ٔحُ ٔٛضز ٘ظطسبٖ شذيطٜ ٕ٘بييس.ٕ٘ب

 شذيطٜ ٕ٘بييس.  vtc (Chart file), .wmf file (Windows Meta-file) or as a bitmap (.bmp).٘ىشٝ: فبيُ ضا ثٝ نٛضر 

ضا  wmf.وّيه وطزٜ ٚ  Save as typeٕٝ خٟز زاض زض ؾٕز ضاؾز فيّس شذيطٜ ٕ٘بييس. ثط ضٚي زو wmf.فبيُ ضا ثب دؿٛ٘س  .13
 ضا سبيخ ٕ٘بييس. motor.wmfػجبضر  File nameا٘شربة ٕ٘بييس. زض لؿٕز 

 وّيه ٕ٘بييس سب ٌطاف ضا زض فبيّي شذيطٜ وٙيس وٝ زض آ٘دب ثشٛا٘يس ثؼسا ثطاي ٕ٘بيف دطزاظـ قٛز. OKثط ضٚي  .14

Power Draw 

Power Draw طاؾشبضي ٌطافيىي ؾبزٜ اي ٔي ثبقس وٝ قٕب ضا زض ٚيطايف ذطٚخي ٌطافيىي ايدبز قسٜ زض اثعاض ٚيDrilling Office  يبضي ٔي

ٔي سٛا٘س ثٝ َٛض ٔؿشمُ ثطاي ايدبز َطح ٞب  ٚ ٌطاف ٞبي انّي اؾشفبزٜ قٛز، أب ٞسف اِٚيٝ آٖ ٚيطايف ٌطاف ٞبي  Power Drawاٌطچٝ  زٞس.
 قٕب ضا لبزض ثٝ ا٘دبْ ٔٛاضز ظيط ٔي ؾبظز: Power Drawٔي ثبقس.  Drilling Officeايدبز قسٜ زض ثط٘بٔٝ 

 ٞب ٚ َطح ٞب ضا ثبظ ٚ شذيطٜ وٙيس. يهٌطاف 

 ٚيطايف ٚ سفؿيط ٌطافيه ٞب 

 ايبفٝ وطزٖ ٔٛاضز ٌطافيىي ٕٞچٖٛ ذٍ ٞب ، ديىبٟ٘بي خٟز زاض ٚ قىُ ٞب 

 ايبفٝ وطزٖ ٔدٕٛػٝ اَلاػبر ايبفي يب سٛاثغ ثٝ َطح ٞب 

 زٖ فبثُ ٞبي ٚاضز وطEnhanced Windows Meta (EMF) 

 چبح وطزٖ ٌطافيه ٞب 

 ٚيػٌي ٞبي خسيس
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  :اوٖٙٛ ٔي سٛا٘يس ثط ضٚي ٞط ٔٛضزي وّيه ضاؾز وٙيس سب سٙظيٕبر ٚيػٌي ٞبي آٖ ٔٛضز ضا قطٚع وٙيس. وبض وطز وّيه ضاؾز ٓٞ

ٔي سٛا٘س  Power Drawر ٔٛضزي ، انلاحبر ايدبز ٔي قٛ٘س. ػلاٜٚ ثط انلاحب objects propertiesؾذؽ اظ دٙدطٜ 
ضا زض اذشيبض قٕب لطاض  Properties( دٙدطٜ Annotationsيىؿبٖ اظ ؾط ثطي سفؿط ٘ٛقز ) Typeانلاحبر چٙسيٗ ٔٛضز اظ يه 

 زٞس.

 .وبض وطز زاثُ وّيه: ثط ضٚي ٔٛضزي وٝ لطاض اؾز ٚيػٌي ٞبي آٖ ضا سٙظيٓ وٙيس زاثُ وّيه وٙيس 

 Drilling Officeٚاضز قٛ٘س ٕ٘ي سٛا٘ٙس زٚثبضٜ ثٝ  Power Drawيه َطفٝ ٔي ثبقس، فبيُ ٞبي ٌطافيىي وٝ ثٝ  ٘ىشٝ: خطيبٖ وبض يه فطآيٙس
 ٚاضز قٛ٘س.

 Query Toolآٔٛظـ 
 ٕ٘بيي وّي

  ٔمسٔٝ اي ثطQuery Tool 

 ديف اظ قطٚع 

  قطٚعQuery Tool 

  ا٘شربة وطزٖ فيّس ٞبي اَلاػبر ثطايQuery 

  ٖسؼييٗ وطزQuery Criteria 

 يطٜ ٚ اخطا يه شذQuery 

  اخطايQueryٜٞبي اظ ديف سؼييٗ قس 

 Query Toolٔمسٔٝ اي ثط  -1ثرف 
وٝ ٔرعٖ اَلاػبر زض  Drilling Office Data Objectsاَلاػبر ضا اظ  ثٝ قٕب اخبظٜ ٔي زٞس سب ثٝ نٛضر ٔشمبثُ Query Toolثط٘بٔٝ 

Drilling Office س.خؿشدٛ ٚ ذبضج وٙي اؾز Query Tool دبؾرٍٛي ؾٛالار َطاحي قسٜ ثطاي ٟٔٙسؾيٗ حفبضي ٚ ٔسيطاٖ دطٚغ ٔرهٛنب ، ٜ
 ثٝ ٚؾيّٝ خؿشدٛي اَلاػبر زض دبيٍبٜ زازٜ فطاٞٓ قسٜ اؾز.

 Query Toolٚيػٌي ٞبي 

  ايدبزqueries 

  ديف ثيٙيqueries 

  ٜشذيطqueries ثطاي اؾشفبزٜ ٔدسز 

  اخطاqueries ٜاظ ديف سؼطيف قس 

  ٝذطج وطزٖ اَلاػبر ثExcel ثطاي سدعيٝ سحّيُ ثيكشط 

 ديف اظ قطٚع -2ثرف 

يه ضٚظ ٔكرم ٚ ، ٘حٜٛ خؿشدٛ دبيٍبٜ اَلاػبر  ثطاي فؼبِيز ٞبي ا٘دبْ قسٜ زض Query Toolزض َي ايٗ ثرف آٔٛظقي ٔجب٘ي اؾشفبزٜ اظ 
ٚ سِٛيس وطزٖ  flagsر ازأٝ ٚ ثٟيٙٝ ؾبظي شدٛ قبُٔ ٘بْ فؼبِيز ، ٔسفيّس ، حفطٜ ٚ فؼبِيز ٞبي وٝ ثٝ آٟ٘ب ُٔؼّك ٞؿشٙس ضا ٔطٚض ذٛاٞيٓ وطز. خؿ

 ،٘يع ذٛاٞس قس.
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 ضا ٚاضز وٙيس. welltraktutorial.pbf ضا اخطا وطزٜ ٚ فبيُ زازٜ ٕ٘ٛ٘ٝ DataBrowserديف اظ قطٚع ايٗ آٔٛظـ، ثط٘بٔٝ 

 Query Toolقطٚع  -3ثرف 

 ٚيس.ثط Start > Schlumberger > Drilling Officeثٝ ٔؿيط  Query Toolثطاي قطٚع  .1

 ضا ٘بزيسٜ ثٍيطيس. 2اٌط ثط٘بٔٝ ضا زض حيٙي وٝ ثط٘بٔٝ زيٍطي زض حبَ اخطا ٔي ثبقس ثبظ وطزيس ٔطحّٝ ٘ىشٝ: 

 ٔي قٛز. loginنفحٝ آغبظيٗ قبُٔ ٕ٘بيف زيبِٛي  .2

 Query Toolاظ ثط٘بٔٝ  Step 1ٔٛفميز آٔيع ، دٙدطٜ  ,loginسبٖ ضا ا٘شربة ٕ٘بييس. ثٝ ٔحى  user nameاظ ِيؿز وكٛيي  .3
 ثٝ ٕ٘بيف زض ٔي آيس.

 

 Queryا٘شربة فيّس ٞبي اَلاػبسي ثطاي  -4ثرف 
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زض ؾٕز ضاؾز لطاض ٌطفشٝ  Available Data Fieldsزض ؾٕز چخ  ٚ  Drilling Office Data Objectsقبذٝ  Step 1زض دٙدطٜ 
 اؾز.

 ضا ا٘شربة ٕ٘بييس.  Fieldآيىٗ  .1

ٔطثٌٛ ثٝ  Available Data Fieldضا ثٝ ػٙٛاٖ آيشٓ  Nameثطٚيس. ٚ چه ثبوؽ  Available Data Fieldsثٝ ثرف  .2

Field object .ا٘شربة وٙيس 

 < Fieldثبظ قٛز. ٔؿيط  Drilling Office Data Objectsوّيه وٙيس سب قبذٝ دطٚغٜ  Fieldزض ؾٕز چخ  +ثط ضٚي  .3

Structure > Slot > Well > Borehole .ضا ا٘شربة ٕ٘بييس 

 Boreholeٔطثٌٛ ثٝ  Available Data Fieldآيشٓ  Name، چه ثبوؽ  Available Data Fieldsزض ثرف  .4

object .ا٘شربة وٙيس 
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ا٘شربة قٛ٘س. ٔٛيٛػبر ا٘شربة قسٜ  queryٚ فيّس ٞبي اَلاػبر ٔشؼسز ي ٕٔىٗ اؾز ثطاي  (Multiple objects٘ىشٝ: ٔٛيٛػبر ٔشؼسز )
سي ا٘شربة قسٜ ثطاي ٞط ٔٛيٛع ا٘شربة قسٜ سٛؾٍ چه ثبوؽ ٞب ٔكرم ٔي سٛؾٍ آيىٖٛ ٞبي ضٍ٘ي ٘كبٖ زازٜ ٔي قٛز. فيّس ٞبي اَلاػب

 قٛ٘س.

 ٕ٘بيف زازٜ ٔي قٛز. Query Preview Windowوّيه ٕ٘بييس. دٙدطٜ  !Query Nowثط ضٚي زوٕٝ  .5

 

ٛا٘يس ٔي س قٕب ٔي قٛز.ٕ٘بيف زازٜ  preview window٘بْ فيّس ٚ ٘بْ حفطٜ ثطاي سٕبْ حفطٜ ٞبي يبفز قسٜ  زاض دبيٍبٜ اَلاػبر زض  ٘ىشٝ:
 . Preview - rows of the queryا٘شربة وٙيس قٕبضٜ ضزيف ٞبي لبثُ ضٚيز ضا ثب سغييط قٕبضٜ ٔٛخٛز زض فيّس 

 Daily Operationsسٕطوع وٙيٓ. ٞٓ اوٖٙٛ اَلاػبر ضا زض  Step 1: Specify Data Fields for Queryثيبيس زٚثبضٜ ثط ضٚي دٙدطٜ 

Report خؿشدٛ ٔي وٙي.ٓ 

 ضا ا٘شربة ٕ٘بييس. Daily Operation Reportآيشٓ  ثؿٍ زٞيس. Borehole > Plan/Executeقبذٝ دطٚغٜ ضا زض ٔؿيط  .6

 ا٘شربة ٕ٘بييس. Available Data Fieldsضا اظ چه ثبوؽ ثرف  Nameٌعيٙٝ  .7

8. Daily Operation Report  ٚ ٜضا ثبظوطزWellbore Activity  .زض ثرف ضا ا٘شربة ٕ٘بييسAvailable Data Fields 

 ضا ا٘شربة ٕ٘بييس. Name, Comment, Duration, Optimum Flag  ٚProductive Flag، ٌعيٙٝ ٞبي 
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 وّيه ٕ٘بييس. Requery٘جؿشٝ ايس ثط ضٚي زوٕٝ  Query Previewوّيه ٕ٘بييس. اٌط دٙدطٜ  !Query Nowثط ضٚي زوٕٝ  .9
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ٔؼُٛف وٙيٓ. ٞٓ اوٖٙٛ ثب سؼييٗ اَلاػبر خؿشدٛ ثٝ ٔطحّٝ  Step 1: Specify Data Fields for Queryثيبييس سٛخٝ ٔبٖ ضا ثٝ دٙدطٜ 
 ثؼسي ٔي ضٚيٓ.

 Step 2: Specifyوّيه ٕ٘بييس. دٙدطٜ  Step 1: Specify Data Fields for Queryزض دٙدطٜ  Nextثط ضٚي زوٕٝ  .12

Query Criteria .ٕ٘بيف زازٜ ٔي قٛز 

 Query Criteriaسؼييٗ  -5ثرف

 ٔكرم ذٛاٞيس وطز. Daily Operation Reportٔؼيبضي ضا زض  ،زض ايٗ ثرف

1. Daily Operation Report  ضا اظ ِيؿزDatabase Objects .ا٘شربة ٕ٘بييس 
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 ٕ٘بيف زازٜ ٔي قٛز. Criteria on Daily Operation Reportوّيه ٕ٘بييس. دٙدطٜ  Add Criterionثط ضٚي زوٕٝ  .2

ضا ا٘شربة  Nameٔٛضز ٌعاضـ ػّٕيبر ضٚظا٘ٝ  ٘كبٖ زازٜ قسٜ اؾز. ٔكرهٝ زض  data attributesزض ِيؿز ؾٕز چخ  .3
 ٕ٘بييس.

 وّيه ٕ٘بييس. Show Valuesثط ضٚي زوٕٝ  .4

 زض حيٗ خؿشدٛي اَلاػبر اظ دبيٍبٜ زازٜ ٕ٘بيف زازٜ ٔي قٛز. Progressدٙدطٜ  .5

 

ٚظا٘ٝ ضا ٘كبٖ ٔي زٞس. ثطاي ايٗ ٕٞٝ سبضيد ٞبي  ٌعاضقبر ػّٕيبر ض Criteria on Daily Operation Reportدٙدطٜ  .6

 ٘كبٖ زازٜ قسٜ ا٘شربة ٕ٘بييس. Valuesضا اظ آ٘چٝ زض ِيؿز  3/1/2221ثرف آٔٛظقي 

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   229 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 

ثبظ ٌطزيس. زض  Step 2: Specify Query Criteriaوّيه ٕ٘بييس سب ايٗ ٔؼيبض ضا لجَٛ وطزٜ ثبقيس. ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .7
 بثي قٕب ٕ٘بيف زازٜ قسٜ اؾز.ٔؼيبض ا٘شر Criteria Expressionثرف 
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 Queryشذيط ٚ اخطا يه  -6ثرف 

 Step 3: Save and Runوّيه ٕ٘بييس. دٙدطٜ  Step 2: Specify Query Criteriaزض دٙدطٜ  Nextثط ضٚي زوٕٝ  .1

Query .ٕ٘بيف زازٜ ٔي قٛز 
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 ٕ٘بيف زازٜ ٔي قٛز. Save Asوّيه ٕ٘بييس. دٙدطٜ  Save Queryثط ضٚي زوٕٝ  .2

ضا  Activity Query، ػجبضر  Query descriptionلجَٛ وٙيس. زض فيّس  queryضا ثطاي ايٗ  file nameطو ديف ف .3
 سبيخ ٕ٘بييس.
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 ثبظ ٌطزيس. Step 3: Save and Run Queryضا وّيه ٕ٘بييس. ثٝ دٙدطٜ  Saveزوٕٝ  .4

 زازٜ ٔي قٛز. ٕ٘بيف Excelاخطا قسٜ ٚ ٘شبيح زض نفحٝ  Query وّيه ٕ٘بييس. Finishثط ضٚي زوٕٝ  .5

 

 ٞبي اظ ديف سؼطيف قسQuerieٜاخطا   -7ثرف 

 اخطا ٔي قٛ٘س. Step 1: Specify Data Fields for Queryٞبي اظ ديف سؼطيف قسٜ اظ دٙدطٜ Querie٘ىشٝ: 

 ثبظٌطزيس. Query Toolثٝ دٙدطٜ انّي  .1

 Openّيه ٕ٘بييس. دٙدطٜ و Load Queryثط ضٚي زوٕٝ  Step 1: Specify Data Fields for Queryاظ دٙدطٜ  .2
 ٕ٘بيف زازٜ ٔي قٛز.
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 وّيه وٙيس. دٙدطٜ ظيط ٕ٘بيف زازٜ ٔي قٛز. Openضا ا٘شربة ٕ٘بييس. ثط ضٚي زوٕٝ  query.pqyفبيُ  .3

 

 وّيه ٕ٘بييس. OKثطضٚي زوٕٝ  .4

 وّيه ٕ٘بييس سب ٘شبيح لبثُ ضٚيز قٛ٘س. !Query Nowثط ضٚي  .5

 DrillVizآٔٛظـ 
 ٕ٘بي وّي
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 ط ٔجب٘ي آٔٛظـٍ٘بٞي اخٕبِي ث 

  قطٚعDrillViz 

  سٛنيف وٙشطَ ٞبيDrillViz 

 ٗايدبز يه ٔسَ ظٔي 

 َايبفٝ وطزٖ ؾُح ثٝ ٔس 

 َايبفٝ وطزٖ اَلاػبر چبٜ ثٝ ٔس 

 سؼطيف يه ثرف سمبَغ 

 ايدبز/ ثبضٌعاضي / ٚيطايف اٞساف 

  زضن ٔٙٛيView 

  وبُٔ وطزٖ َطحي چبٜ زضGeoFrame 

 ا٘يٕيكٗ ٚ سٛنيفبر ٌطافيىي 

 اخٕبِي ثط ٔجب٘ي آٔٛظـٍ٘بٞي  -1ثرف

DrillViz ( ٓاثعاض ؾبذز ٔسَ ظٔيٗ ٚ سدؿvisualization ؾٝ ثؼسي ٔي ثبقس وٝ ثٝ َطاحي ، سدؿٓ ٚ قجيٝ ؾبظي دطٚغٜ ٞبي حفبضي وٕه )

 ellipses of، حدٓ ٞب ، ٔؿيط ٞبي چبٜ ، اٞساف حفبضي ، ٘كبٍ٘طٞبي چبٜ زض ؾٝ ثؼس ثٝ ػلاٜٚ ٔي سٛا٘س ؾُٛح DrillVizٔي وٙس. 

uncertainty  ، ٔٙحٙي ٞبيlog  ٝٔاَلاػبر ؾٝ ثؼسي ضا زض ََٛ ٔؿيط چبٜ ٘كبٖ ٔي زٞس. ثط٘ب ٚDrillViz  اظ َطيكGeoFrame 

database  ٚupdates in sync as data is modified ( ثب  زيٍط ثط٘بٔٝ ٞب سجبزَ اَلاػبرshares .ٔي وٙس ) وبض وطزٖ ثبWITS  ٚ
IDEAL ،  DrillViz  3ٕ٘بيف  زض ٕٞبٖ ِحظٝ اي وٝ اَلاػبر وؿت ٔي قٛ٘س ثٝ ضٚظ ضؾب٘ي ٔي وٙس.اَلاػبر ضاD  ٝٔي سٛا٘س شذيطٜ قٛز ث

ؾيؿشٓ ٔرشهبر  ٔي ثبقس زيسٜ قٛز. .distributionوٝ قبُٔ  OI Viewer، وٝ ٔي سٛا٘س ثب اؾشفبزٜ اظ Open Inventorػٙٛاٖ يه فبيُ 
DrillViz  ثط اؾبؼ ٔٛلؼيز فيّس، ثب field location  ٚ Mean Sea Level ٔي ثبقس. (0,0,0)ثٝ نٛضر 

ايٗ آٔٛظـ ضا ثب زض ذٛاؾز ثبضٌعاضي اَلاػبر  َطاحي قسٜ اؾز. DrillVizايٗ آٔٛظـ ثٝ ٔٙظٛض ديف ثطز قٕب زض ٔيبٖ ٔطاحُ ديچيسٜ اؾشفبزٜ اظ 

Survey  ٚField  قطٚع ٔي قٛز. ثطاي ايٗ ثرف آٔٛظقي قٕب اظ فيّسZeus زض فيّس . اؾشفبزٜ ذٛاٞيس وطزZeus  ٝچبٞي ٚخٛز زاضز وٝ ٔب ث
 اظ آٖ اؾشفبزٜ ذٛاٞيٓ وطز. working wellػٙٛاٖ 

 اؾشفبزٜ ٕ٘بييس. English units systemزض ايٗ آٔٛظـ ثبيس اظ 

 DrillVizقطٚع  -2ثرف 

www.Ir وّيه ٕ٘بييس. ضفشٝ ٚ ثط ضٚي آيىٗ    Start >    > DrillVizثٝ  ٔؿيط  .1
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 DrillVizسٛنيف وٙشطَ ٞبي  -3ثرف

ؾٝ ٔي ثبقس وٝ لؿٕز اػظٓ دٙدطٜ ضا ثٝ ذٛز اذشهبل ٔي زازٜ اؾز.  3Dاَٚ ، نفحٝ ٕ٘بيف  دُٙسمؿيٓ ٔي قٛز.  دُٙ٘بحيٝ ٕ٘بيف ثٝ چٟبض 

قٕب ٔي سٛا٘يس ؾٝ دُٙ زيٍط ضا ثب  ٞب دٟٙبٖ ٔي ثبقٙس.2D cross sectionٞب ثطاي ٘كبٖ زازٖ cross sectionدُٙ زيٍط سب ظٔبٖ سؼطيف وطزٖ 

دُٙ ؾٕز چخ زض ثبلاي نفحٝ  يب ثب وكيسٖ ٌٛقٝ دبييٗ ؾٕز ضاؾز ثجيٙيس. اظ َطيك وّيه وطزٖ ثط ضٚي  DrillVizعضي وطزٖ دٙدطٜ ث

ثٝ قٕب اخبظٜ ٔي زٞٙس سب  Open Inventor، آيىٖٛ ٞبي 3Dزض ؾٕز ضاؾز دُٙ  .ٔي ثبقس 3D (dimension3)سٟٙب ثطاي ٘كبٖ زازٖ ٔٛاضز

 ٙيس.ضا زؾز وبضي و 3Dسهٛيط 

 

Select/Pick mode ٔ ا٘شربثي يب ثطٌعيسٖ. قىُ ٘كبٍ٘ط ثٝ قىُ يب ديىبٖ سغييط ٔي يبثس. زض ايٗ  ٛيٛػبرزؾشىبضي

mode  ٔٛيٛػبسي ضا زض نفحٝ ٌطافيىي زؾز وبضي ٔي وٙس.، وبضثط 

 

View mode  ٕٗ٘بيف ا٘شربة ٞب. ٘كبٍ٘ط ثٝ قىُ يه آيىٗ زؾز سغييط ٔي وٙس. زض ايmode زٚضثيٗ  ، وبضثط

 ضا زض فًبي ؾٝ ثؼسي حطوز ٔي زٞس.
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Help .ٝٔوٕه ضؾب٘ي ديطأٖٛ ثط٘ب 

 

Home )ثط ٌطزا٘سٖ ٕ٘ب ثٝ ٔٛلؼيشي وٝ ثطاي اِٚيٗ ثبض زاقز )اٌط ثبظ٘كب٘سٖ ا٘دبْ ٘كسٜ ثبقس 

 

Set Home ٝثبظ٘كب٘سٖ ٔٛلؼيز فؼّي ثٝ خبي ٔٛلؼيز اِٚي 

 

View All  

 .قٕب لبثُ ٔكبٞسٜ قٛزٔٛخت ٔي قٛز سب سهٛيط ثطاي 

 

Seek   .ٚلشاي واٝ ثاط ضٚي اي آيىاٗ      ثٝ وبضثط اخبظٜ ٔي زٞس يه ٔطوع خسيس ثطاي چطذف زٚضثيٗ ا٘شرابة ٕ٘بياس

ؾذؽ زض خبي وٝ ٔي ذٛاٞيس ٔطواع چاطذف   سغييط ٔي يبثس.  crosshairوّيه ٔي وٙيس قىُ ٘كبٍ٘ط ثٝ 

 ٛاٖ ٔطوع چطذف زٚضثيٗ ا٘شربة ٔي قٛز.خسيسسبٖ ثبقس وّيه وٙيس. اِٚيٗ خبي وٝ وّيه وٙيس ثٝ ػٙ

 

Projection  ثؼس اؾشفبزٜ ٕ٘بييس.3ثؼس يب  2وبثط ضا لبزض ٔي ؾبظز ثطاي ٔكبٞسٜ َطح اظ 

 

Dolly Dial .وبضثط ضا لبزض ثٝ ثعضي ٕ٘بيي ٚ وٛچه ٕ٘بيي ٔي وٙس 

 ٘ىبر:

 ( ٜثطاي سغييط ٚيؼيز ٔٛقٛاضmouse ٗثي )selection mode )ٖ٘كبٍ٘ط ديىب(  ٚchange view mode  ، )٘كبٍ٘ط زؾز(
 ضا ثفكبضيس. ESCوّيس 

  ٖفكبض زازShift + Ctrl + LEFT mouse button  ثطايzoom .وطزٖ ثطٚي َطح 

  ٖفكبض زازCtrl + LEFT mouse button .ثطاي حطوز زازٖ َطح 
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 Earth Modelايدبز يه  -4ثرف

 ٕ٘بيف زازٜ ٔي قٛز. Data Selectionدٙدطٜ ضا ا٘شربة ٕ٘بييس.  ...New Modelٌعيٙٝ  Fileاظ ٔٙٛي  .1

 

 ٕ٘بيف زازٜ ٔي قٛز. Select a fieldوّيه ٕ٘بييس. دٙدطٜ   ثطٚيس. ثط ضٚي زوٕٝ خؿشدٛ  Fieldثٝ فيّس  .2

 ثؿٍ زٞيس. Zeusدبيٍبٜ زازٜ دطٚغٜ ضا ثٝ فيّس  .3

 ثبظ ٌطزيس. Data Selectionوّيه ٕ٘بييس. ثٝ دٙدطٜ  OKثط ضٚي زوٕٝ  .4
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 ضا زض آٖ سبيخ ٕ٘بييس. DrillViz Exampleضا ا٘شربة وطزٜ ٚ ػجبضر  Nameفيّس  .5

ضا سبيخ ٕ٘بييس. زض فيّس  ft 9000-ٔمساض  E/-W From (ft)+ثطٚيس. زض فيّس   Model Boundariesزض ايٗ دٙدطٜ ثٝ ثرف  .6

To   6000ٔمساض ft .ضا سبيخ ٕ٘بييس 

 ضا سبيخ ٕ٘بييس. ft 6000ٔمساض   Toس. زض فيّس ضا سبيخ ٕ٘بيي ft 9000-ٔمساض  N/-S From (ft)+زض فيّس  .7

 ضا سبيخ ٕ٘بييس. ft 15000ٔمساض   Toضا سبيخ ٕ٘بييس. زض فيّس  ft 0ٔمساض TVD From (ft) زض فيّس  .8
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 ثبظ ٔي ٌطزيس. DrillVizوّيه ٕ٘بييس. ثٝ دٙدطٜ انّي  OKثط ضٚي زوٕٝ  .9

 ي وٝ سب ايٙدب ا٘دبْ زازيس ا٘شربة ٕ٘بييس.ضا ثطاي شذيطٜ وطزٖ وبض Save Modelٌعيٙٝ  Fileاظ ٔٙٛي  .12

 ايبفٝ وطزٖ ؾُٛح ثٝ ٔسَ -5ثرف 

 ؾُٛحي وٝ ٘كبٖ زٞٙسٜ  ٚيػٌي ٞبي غئِٛٛغيىي ٞؿشٙس ٔي سٛا٘ٙس ثب ٚاضز وطزٖ يه فبيُ اَلاػبر يب سؼطيف ؾُح زٚ ٚخٟي  ايدبز قٛ٘س. ا٘ٛاع
 ٔؼشجط ؾُح قبُٔ ٔٛاضز ظيط ٔي قٛز:

 افك ٞب 

 ٔطظ ٚاحس ضؾٛثي 

  سٛاِئطظ 

  قٙبؾي چيٙٝ ٞبي ٕٞجؿشٍي٘كبٍ٘ط 

 ديٛؾشٍي٘ب 
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 ٚاضز وطزٖ ؾُٛح اظ يه فبيُ

ضا  Surfaces from OI objectٚ ؾذؽ   Create Surfacesضفشٝ ٚ ٌعيٙٝ  Insertثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1

 ٕ٘بيف زازٜ ٔي قٛز. Surface From Inventor Object Dialogا٘شربة ٕ٘بييس. دٙدطٜ 

 

 commentضا سبيخ ٕ٘بييس. اٌط ذٛاؾشيس ٔي سٛا٘يس سٛييحي ٔٙبؾت زض  Surface 1ضفشٝ ٚ ػجبضر  Surface Nameّس ثٝ في .2
 ثٙٛيؿيس.

 Openوّيه ٕ٘بييس. ايٗ وبض قٕب ضا لبزض ٔي ؾبظ سب فبيُ  Fileاظ ٕٞيٗ دٙدطٜ ثط ضٚي زوٕٝ  Object Informationزض ثرف  .3

Inventor  ٜضا ثبضٌعاضي ٕ٘بييس. دٙدطOpen .ٕ٘بيف زازٜ ٔي قٛز 

ثطٚيس.  horizon1.ivثٝ فبيُ  Program Files\Schlumberger\Drilling Office\bin\asl_dataثب ا٘شربة  .4

ثبظ  Surface From Inventor Object Dialogوّيه ٕ٘بييس. ثٝ دٙدطٜ  Openفبيُ ضا ا٘شربة وطزٜ ثط ضٚي زوٕٝ 
 ٌطزا٘سٜ ٔي قٛيس. 

ثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز ايٗ فيّس وّيه ٕ٘بييس. اِٚيٗ ٔٛضز  ثطٚيس.  Objectsثٝ فيّس  .5

_Imported_Surface_0 .ضا ا٘شربة ٕ٘بييس 
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 زض دكز ايٗ دٙدطٜ ، اِٚيٗ ؾُح ا٘شربة قسٜ ثب َطح لطٔع ٘كبٖ زازٜ ٔي قٛز. DrillViz٘ىشٝ: زض دٙدطٜ انّي 
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 ضيس.ؾذب VOIوّيه ٕ٘بييس سب ايٗ ؾُح ضا ثٝ  Applyثط ضٚي  .6

 ضً٘ َطح ثٝ ضً٘ ظضز دط ضً٘ سغييط ٔي يبثس. ٘ىشٝ:
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ظـ ٘ىشٝ: ػّٕيبر دصيطـ ٕٔىٗ اؾز ديبْ ظيط ضا ٕ٘بيف زٞس وٝ ٘كبٖ زٞٙسٜ ايٗ اؾز وٝ دبيٍبٜ زازٜ ٞبيشبٖ لجلا قبُٔ اَلاػبر ٕ٘ٛ٘ٝ ثرف آٔٛ

 وٙيس سب وبض ازأٝ يبثس. OKٔي ثبقس. 

 حبَ ؾُح زْٚ ٚ ؾْٛ ضا ايبفٝ ذٛاٞيٓ وطز.

ضا سبيخ  Surface 2ضفشٝ ٚ ػجبضر  Surface Nameثٝ فيّس  Surface From Inventor Object Dialogزض دٙدطٜ  .7
 ٕ٘بيييس.

 ضا خؿشدٛ وٙيس. horizon2.ivوّيه وطزٜ ٚ  Fileثط ضٚي  .8

شربة ضا ا٘ Imported_Surface_ 1_، ثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز ايٗ فيّس وّيه ٕ٘ٛزٜ ٚ  Objectsزض فيّس  .9
 ٕ٘بييس.

 ايبفٝ ٕ٘بييس. VOIوّيه ٕ٘بييس سب ؾُح ضا ثٝ  Applyثط ضٚي  .12

 ضا سبيخ ٕ٘بيييس. Surface 3ضفشٝ ٚ ػجبضر  Surface Nameثٝ فيّس  .11

 ضا خؿشدٛ وٙيس. horizon 3.ivوّيه وطزٜ ٚ  Fileثط ضٚي  .12

ضا ا٘شربة  Imported_Surface_ 2_، ثط ضٚي زوٕٝ خٟز زاض زض ؾٕز ضاؾز ايٗ فيّس وّيه ٕ٘ٛزٜ ٚ  Objectsزض فيّس  .13
 ٕ٘بييس.

 ضا ثجيٙيس. Surface From Inventor Object Dialogٚ  وّيه ٕ٘بييس سب ؾُح ؾْٛ ضا ايبفٝ وطزٜ ثبقيس OKثط ضٚي زوٕٝ  .14

 قبُٔ ؾٝ ؾُح ٔي ثبقس. D view-3ٞٓ اوٖٙٛ ٘ىشٝ: 
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 ٚاضز وطزٖ ؾُٛح زٚثؼسي -6ثرف

ضا ا٘شربة ٕ٘بييس.  ...Planar Surfaceٚ ؾذؽ  Create Surfacesضفشٝ ٌعيٙٝ  Insertثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1

 ضا ايدبز ٕ٘بييس. planeٕ٘بيف زازٜ ٔي قٛز. اظ ايٗ دٙدطٜ قٕب لبزض ٔي ثبقيس يه ؾُح  Create a planar surfaceدٙدطٜ 
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 ضا سبيخ ٕ٘بييس. Plane 1ػجبضر  Surfaceزض فيّس  .2

 وّيه ٕ٘بييس. OKيس. ثط ضٚي زوٕٝ ٕٞٝ ٔمبزيط ديف فطو ضا حفظ وٙ .3

 شذيطٜ وبضسبٖ -7ثرف 

ضا ا٘شربة ٕ٘بييس. دٙدطٜ َجمٝ ثٙسي  ...Commit Surface to Modelضفشٝ ٌعيٙٝ  Editثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1
 ٚيػٌي ٞب ثٝ ٕ٘بيف زض ٔي آيس.
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 ذيطٜ ايٗ اَلاػبر ا٘شربة وٙيس.ثطاي ش Commitچٟبض ؾُح ضا ثب ٞبي لايز وطزٖ آٟ٘ب ٚ ؾذؽ وّيه ثط ضٚي  .2

 ٕ٘ي ثبقٙس ٚ اظ ِيؿز حصف ٔي قٛ٘س. Unclassified Featureٔي قٛ٘س آٖ اَلاػبر زيٍط  Commit٘ىشٝ: ٚلشي اَلاػبر 

 ثبظ ٌطزا٘سٜ ٔي قٛيس. DrillVizوّيه ٕ٘بييس.دٙدطٜ ثؿشٝ قسٜ ٚ ثٝ دٙدطٜ انّي  Closeثط ضٚي زوٕٝ  .3

. قي ضا سب ٔٛلؼي حطوز زٞيس وٝ ثشٛا٘يس چٟبض ٔٛضزي وٝ ايدبز وطزيس ضا ثجيٙيس. يسثطٚ View Modeثٝ  ثب فكبض زازٖ  .4

ٕٞيكٝ زض ٘بحيٝ حبِز  دبييٗ ؾٕز چخ ظبٞط  Surface 1 – Horizon٘بْ آيشٓ ٞبي وٝ ثٝ سبظٌي ا٘شربة قسٜ زض ايٗ حبِز ، 
 ٔي قٛز.
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 ايبفٝ وطزٖ اَلاػبر چبٜ ثٝ ٔسَ -8ثرف

ثب ضً٘  subject well  ٚoffset wellsلاػبر چبٜ ضا ٚاضز وٙيس. اَلاػبر چبٜ ثٝ نٛضر ضٍ٘ي ، ثطا ٔكرم قسٖ ثيٗ ٞٓ اوٖٙٛ آٔبزٜ ايس سب اَ

 ثٝ نٛضر ديف فطو ثب ضً٘ ؾجع ٘كبٖ زازٜ ٔي قٛز. subject wellوس ٌعاضي ٔي قٛ٘س. 

ضا ا٘شربة ٕ٘بييس.  Insert > Load > Wells > Subject Wellضفشٝ ؾذؽ  Insertثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1
 ٕ٘بيف زازٜ ٔي قٛز. Select a working surveyدٙدطٜ 

ضا ا٘شربة  Tutorial #1ثؿٍ زٞيس ٚ  Zeus > A. Structure > W-13 > B-13 > Planقبذٝ دبيٍبٜ زازٜ دطٚغٜ ضا ثٝ  .2
www.Ir وّيه ٕ٘بييس. OKوٙيس. ثط ضٚي زوٕٝ 
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 Selectضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...Insert > Load > Wells > Offset Wellsٔؿيط  DrillVizاظ دٙدطٜ انّي  .3

Surveys .ٕ٘بيف زازٜ ٔي قٛز 
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 ضا ا٘شربة ٕ٘بييس. A. Structureدبيٍبٜ زازٜ دطٚغٜ ضا ثؿٍ زازٜ ٚ  .4

 ثبظ ٌطزا٘سٜ ٔي قٛيس. DrillVizوّيه وٙيس. ثٝ دٙدطٜ انّي  OKثط ضٚي زوٕٝ  .5

 ٚايبيي زيٍط ا٘شربة ٕ٘بييس.ضا ثطاي چطذب٘سٖ ٔسَ ٚ ٔكبٞسٜ آٖ اظ ظ  .6

 ضا ا٘شربة ٕ٘بييس. Well Surveyقي ؾجع ضً٘ ضا اظ ٘ٛاض اثعاض ا٘شربة وٙيس.   .7
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 سؼطيف يه ثرف سمبَغ -8ثرف 

ثٝ  E, W,  ٚTVDٚ  ٔٛلؼيز ٞط وساْ ضا ثب ٔكرم وطزٖ ٔمبزيط ( ضا ايدبز ذٛاٞيٓ وطز cross sectionsزض ايٗ ثرف آٔٛظـ ، ثرف سمبَغ )

 سٙظيٓ ٔي وٙيٓ. Azimuth  ٚDipظٚايبي ػلاٜٚ 

 ثجيٙيس. 3D viewٞب ضا ػلاٜٚ ثط  2D viewضا َٛضي ثبظ وٙيس وٝ ثشٛا٘يس  DrillViz٘ىشٝ: ديف اظ ايٙىٝ ايٗ سٕطيٗ ضا قطٚع وٙيس دٙدطٜ 

 Define Cross Sectionضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...Edit > Define Cross Sectionٔؿيط  DrillVizاظ دٙدطٜ انّي  .1

Plane .ٕ٘بيف زازٜ ٔي قٛز 

 ٕ٘بيف زازٜ ٔي قٛ٘س. 3D view٘ىشٝ: سغييطاسي وٝ ايدبز ٔي وٙيس زض ٕٞبٖ ِحظٝ زض 

 ظيطيٗ ضا ثٟشط ثجيٙيس. 3D viewثط ضٚي ٘ٛاض ػٙٛاٖ زض ثبلاي دٙدطٜ ٔحبٚضٜ اي وّيه وٙيس ٚ آٖ ضا ثٝ وٙبض ي ثىكيس سب ثشٛا٘يس  .2

ٔي ثبقٙس ضا لجَٛ وٙيس. ثط ضٚي  Support 2D#0ثرف سمبَغ ٚخٛز زاضز ٚ ثٝ َٛض اسٛٔبسيه  ٔمبزيط ديف فطيي وٝ ثطاي اِٚيٗ .3

Apply .وّيه وٙيس.ا٘دبْ ايٗ وبض ايٗ ٔٛلؼيز ضا زض دٙدطٜ ٔحبٚضٜ اي ٘كبٖ زازٜ قسٜ زض ظيط ثٝ دبيبٖ ذٛاٞس ضؾب٘س 
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3D view .ُٔبثك قىُ ظيط ثٝ ضٚظ ضؾب٘ي ٔي قٛز 
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 ضا ا٘شربة وطزٜ ثبقيس. 2D Viewثجطيس ٚوّيه وٙيس سب يىي اظ دُٙ ٞبي  DrillVizٜ انّي ٘كبٍ٘ط ٔٛؼ ضا ثٝ دٙدط .4

 وّيه ضاؾز وٙيس.ٔٙٛي وكٛيي ٕ٘بيف زازٜ ٔي قٛز. 2D Viewزضٖٚ دُٙ  .5

 

6. Cross Section  ٜ2ضا ٞبي لايز وٙيس ؾذؽ وّيه چخ وٙيس. دٙدطD Cross Section .ٕ٘بيف زازٜ ٔي قٛز 
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7. Support 2D#0 ٝػٙٛاٖ ثرف سمبَغ خسيس ا٘شربة وطزٜ ثط ضٚي زوٕٝ  ضا ثOK .وّيه ٕ٘بييس 

سغييط زٞيس. ثٝ  90ثٝ  0ضا اظ حبِز ديف فطو  Azimuth sliderثط ٌطزيس.  Define Cross Section Planeثٝ دٙدطٜ  .8
 بزاقز وٙيس.ضا ي 3D viewسغييط زٞيس. سغييطار ٔشٙبظط ضٚي  degrees 90ضا  Dip sliderحبِز ديف فطو ثط ٌكشٝ ٚ 

ضا ا٘شربة  Display Well Data ضفشٝ وّيه ضاؾز وٙيس سب ٔٙٛي ٔكبثٝ آ٘چٝ لجلا ا٘دبْ زازيس ثبظ قٛز. 2D Viewثٝ دٙدطٜ  .9
وٝ قبُٔ ؾٝ ؾُح ٚ يه دّٗ )ٕٞب٘ٙس قىُ ظيط( ٔي ثبقس، َطح ضيعي  2D cross section viewوٙيس. ٔؿيط خطيبٖ چبٜ زض 

 ذٛاٞس قس.

 

ثبلي ٔب٘سٜ سىطاض وٙيس ٚ ٔؿيط خطيبٖ چبٜ ضا  2D viewثيكشط زض زٚ دٙدطٜ  cross section planesضا ثطاي سؼطيف زٚ  ٔي سٛا٘يس ايٗ ضٚـ
 ضٚي آٟ٘ب ٘كبٖ زٞيس.

 ايدبز /ثبضٌعاضي/ ٚيطايف اٞساف -9ثرف 
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DrillViz enables you to create a target either by moving the target selector with the 3D cursor to 
the desired position, or by typing the desired parameters in the Edit Target window. 

  Target Dynamicallyايدبز يه 

)وٝ ظٔب٘ي وٝ فؼبَ ٔي قٛز ثٝ ضً٘ ظضز زض ٔي آيس(  3D Target Selector( ، cylindrical partثط ضٚي ثرف اؾشٛا٘ٝ اي ) .1
بييٗ ثجطيس. ثبي حطوز افمي ، ثط ضٚي ٔطثغ احبَٝ وٙٙسٜ اؾشٛا٘ٝ وّيه وٙيس )زض ايٙدب ٘يع ضً٘ ظضز ثٝ وّيه وٙيس ٚ آٖ ضا ثبلا ٚ د

 ( ضا اظ يه َطف ثٝ َطف زيٍط حطوز زٞيس.selectorٔؼٙبي فؼبَ ثٛزٖ ٔي ثبقس( ٚ ا٘شربة وٙٙسٜ )

 

 ايدبز يه ٞسف ثٝ َٛض زؾشي

 ٕ٘بيف زازٜ ٔي قٛز. Edit Targetضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...Insert > Create Targetٔؿيط   DrillVizاظ دٙدطٜ انّي  .1
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 ثٙٛيؿيس. Remarkاٌط ذٛاؾشيس ٔي سٛا٘يس سٛييحي زض لؿٕز ضا سبيخ ٕ٘بييس.  Tutorial Targetػجبضر  Nameزض فيّس  .2

 ضا سبيخ ٕ٘بييس. ft 100ٔمساض  Major Axisاظ ٕٞيٗ دٙدطٜ ثطٚيس. زض فيّس  Geometryثٝ ثرف  .3

 ضا ثطاي آٖ سبيخ ٕ٘بييس. ft 100ضفشٝ ٚ ٔمساض  Thicknessثٝ فيّس  Tabاؾشفبزٜ اظ  ثب .4

 ضا زض ايٗ سٕطيٗ ضاحز سط ٔي وٙس.Target ضا افعايف ذٛاٞس زاز ٚ ديسا وطزٖ  Targetثب ديطٚي اظ ٔطاحُ فٛق اِصوط، ؾبيع ٘ىشٝ: 

 وّيه ٕ٘بييس. OKثط ضٚي زوٕٝ  .5

www.Ir
an

-S
PE.co

m



 Drilling Officeنرم افسار آموزش 

   236 
   ddte.blogfa.com                                                     حفاري انحرافيتكنولوژي            

 ثبضٌعاضي ٞسف ٔٛخٛز )حبيط(

 سؼطيف ٔي قٛ٘س. Zeusزٚ ٞسف ثطاي فيّس ٘ىشٝ: 

 Target Selector Dialogضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...Insert > Load > Targetsٔؿيط   DrillVizاظ دٙدطٜ انّي  .1
 ٕ٘بيف زازٜ ٔي قٛز.

 

2. Target #1  ٕٝضا ا٘شربة وطزٜ ٚ ثط ضٚي زوApply .وّيه ٕ٘بييس 

3. Target #2 ٕضا ا٘شربة وطزٜ ٚ ثط ضٚي زو ٝOK .دٙدطٜ   وّيه ٕ٘بييسTarget Selector Dialog .ٕ٘بيف زازٜ ٔي قٛز 

 3D viewٞب ضا ثطاي  targetوطزٖ ا٘شربة وٙيس ثٝ َٛضي وٝ ثشٛا٘يس ايٗ  zoomضا ثطاي  DrillViz ،Dolly dialاظ دٙدطٜ  .4
 ٜ ا٘شربة قسٜ ظبٞط قٛ٘س.ٔؿيط خطيبٖ چب red trackٞب ثبيس ثٝ نٛضر ٘مبٌ ؾفيس وٛچىي زض  targetديسا وٙيس. ايٗ 
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 ٘ىشٝ: زٚ ٞسف ، ؾفيس ثعضٌشط  ثٝ َٛض زيٙبٔيىي ثطاي  ايٗ سٕطيٗ ايدبز قس٘س.

 ٚيطايف ٞسف ٔٛخٛز

 قٕب ٔي سٛا٘يس ٞسف ٔٛخٛز ضا انلاح وٙيس.

 وّيه چخ وٙيس سب آٖ ضا ا٘شربة وطزٜ ثبقيس. 3D viewٞب زض targetثط ضٚي يىي اظ  .1

 وٝ يه ٞسف ضا ا٘شربة وٙيس ثٝ زٚض آٖ ٕ٘بيف زازٜ ٔي قٛز.: يه زايطٜ لطٔع  ظٔب٘ي ٘ىشٝ

ٕ٘بيف زازٜ ٔي قٛز.  Edit Targetضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...Edit > Target Editorٔؿيط  DrillVizاظ  دٙدطٜ انّي  .2
 دبضأشط ٞب ضا انلاح وٙيس.

 وّيه ٕ٘بييس. OKثطاي سىٕيُ سغييطار ثط ضٚي زوٕٝ  .3

 Viewزضن ٔٙٛي  -9ثرف 

ثؼسى ضا سغييط  ؾٝ اؾشفبزٜ وٙيس سب زٚضٕ٘بى View، ٔي سٛا٘يس اظ ٔٙٛي فًبيى( ايبفٝ وطزيس ٞٓ اوٖٙٛ وٝ آيشٓ ٞبي ثؿيبضي ضا ثٝ قىّشبٖ )اضايف
 زٞيس يب قىُ ٔسِشبٖ ضا ػٛو وٙيس.
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Ellipse of Uncertainty 

اظ ثط٘بٔٝ ٞبي وبثطزي  Survey Editorيب  Well Design، زض اثشسا ضٚـ ٔحبؾجبر ٚ اثعاض  Ellipse of Uncertaintyثطاي ٘كبٖ زازٖ 

Drilling Office .سؼطيف وٙيس 

 ايٗ ٔطحّٝ لجلا ثطاي ايٗ ثرف آٔٛظقي ا٘دبْ قسٜ اؾز.

 ضا ا٘شربة ٕ٘بييس. View > Display EOUٔؿيط  DrillVizانّي اظ دٙدطٜ  .1

 سٛؾٍ ِِٛٝ ؾجع ضً٘ ثعضٌي ٘كبٖ زازٜ قسٜ اؾز. EOUظيط،  3D viewزض 

 

Clipping 

Clipping .ثٝ قٕب اخبظٜ ٔي زٞس سب ثركي اظ ٔسَ ضا ا٘شربة ٚ حدٓ ضا خسا وٙيس 

ٕ٘بيف زازٜ  Clipping Dialogضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...Clippingضفشٝ ٚ ٌعيٙٝ  Viewثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1
 ٔي قٛز.
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2. E/W Axis minimum slider  1500-ضا ثٝ ؾٕز ضاؾز زض حسٚز ft  سغييط زٞيس. ٚ ٘شبيح ضا زض حيٗ حبنُ قسٖ ٔسَ زض
3D view .ٔكبٞسٜ وٙيس 

Display Volume/Volume Explosion 

 ٌعيٙٝ اي ثطاي ٔكبٞسٜ  حدٓ ٞب زض ٔمبثُ ؾُٛح ٚخٛز زاضز. viewزض ٔٙٛي 

 Explosionس. دٙدطٜ ضا ا٘شربة ٕ٘بيي ...Volume Explosionضفشٝ ٚ ٌعيٙٝ  Viewثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1

Dialog .ٕ٘بيف زازٜ ٔي قٛز 

 

 GeoFrameوبُٔ وطزٖ َطاحي چبٜ زض   -12ثرف 

 ثطاي ؾُٛح ٕ٘بيف سٙظيٓ وٙيس. 3D٘ىشٝ: ديف اظ قطٚع ايٗ سٕطيٗ، ٕ٘بيف 
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ثبيس قجيٝ اِٚيٝ قٕب  3D viewضا ا٘شربة ٕ٘بييس.  Display Surfacesضفشٝ ٚ ٌعيٙٝ  Viewثٝ ٔٙٛي  DrillVizاظ دٙدطٜ انّي  .1

 ا٘شربة قسٜ ٚ ثٝ ضً٘ لطٔع ٘كبٖ زازٜ قسٜ( Survey objectثٝ سهٛيط ظيط ثبقس ) ثب 

 

 ضا اخطا وٙيس. Well Designثط٘بٔٝ  .2

ٕ٘بيف  Open a Proposalضا ا٘شربة ٕ٘بييس. دٙدطٜ  Openضفشٝ ٚ ٌعيٙٝ   Fileثٝ ٔٙٛي  Well Designاظ دٙدطٜ انّي  .3
 زازٜ ٔي قٛز.

ضا ا٘شربة  Tutorial #1ثؿٍ زٞيس. ٚ  Zeus > A. Structure > W-13 > B-13 > Planضا زض ٔؿيط  دبيٍبٜ زازٜ دطٚغٜ .4
 اؾشفبزٜ ٔي وٙيس( DrillVizٕ٘بييس. )ٕٞب٘ٙس چبٞي وٝ زض 

 MDٕ٘بيف زازٜ ٔي قٛز. زوٕٝ  Hold Dialogضا ا٘شربة ٕ٘بييس. دٙدطٜ  Add >Holdٔؿيط  Well Designاظ دٙدطٜ انّي  .5
 MDضا زض ؾشٖٛ  ft 18000ثٝ ا٘شٟبي وبضثطي ضفشٝ ٚ  Scrollوّيه ٕ٘بييس. ثب اؾشفبزٜ اظ  OKزٜ ٚ ثط ضٚي زوٕٝ ضا ا٘شربة وط

 ضا فكبض زٞيس سب اَلاػبر ثٝ ضٚظ ضؾب٘ي قٛ٘س. tabسبيخ ٕ٘بييس. وّيس 

 س.ضا ٔكبٞسٜ وٙي DrillViz 3D view  ٚWell Designا٘ساظٜ دٙدطٜ ٞب ضا خٛضي سٙظيٓ وٙيس وٝ ثشٛا٘يس  .6

سب ػّٕيبر ٘ٛقشٗ فبيُ اضسجبٌ ثطلطاض  DrillVizضا ا٘شربة ٕ٘بييس. سغييط قٕب ثب  Saveضفشٝ ٌعيٙٝ  Fileثٝ ٔٙٛي  Well Designزض  .7
 ٘رٛاٞس وطز.

 ٘كبٖ ٔي زٞس ٚلشي وٝ  اَلاػبر خسيس ضا زضيبفز ٔي وٙٙس. DrillVizسٛخٝ: ضقشٝ چبٜ لطٔع ، سغييطار ََٛ زض 
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 Well Designثطٌطزيس ثٝ ثط٘بٔٝ 

وّيه وٙيس يب   deleteثرف آذط ٔؿيط خطيب٘ي وٝ ايبفٝ وطزيس ضا ثب ا٘شربة ضزيف ا٘شٟبيي حصف وٙيس. ثط ضٚي  آيىٗ  .8

 ضا ا٘شربة ٕ٘بيييس. Edit > Delete Rowٔؿيط 

 ضا ا٘شربة ٕ٘بييس. File > Saveثطاي شذيطٜ اَلاػبر انّي زض فبيُ ٔؿيط  .9

 ذٛال ٌطافيىي ٚ ا٘يٕيكٗ -11ثرف 

 ضا ا٘شربة ٕ٘بييس. Draw Styleضاؾز وّيه ٕ٘بييس. ِيؿز وكٛيي ٕ٘بيف زازٜ ٔي قٛز. آيشٓ  3D viewط ضٚي ث .1
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ثؿشٝ ثٝ ايٙىٝ وساْ يه زض آٖ   single to doubleيب  double to singleوٙٛ٘ي ضا اظ  buffer، ا٘شربة زض ٌطٜٚ ا٘شٟبيي  .2
 ِحظٝ زاضاي سيه ٔي ثبقس سغييط زٞيس.

 ي ؾُٛح ٚ سغييطار ذٛال زيٍطايدبز دكز ٕ٘ب
 وّيه ٕ٘بييس سب آٖ ضا ا٘شربة وطزٜ ثبقيس. ٚلشي ا٘شربة قس لطٔع ضً٘ ٔي قٛز. 3D viewزض  Surface #1ثطضٚي  .1

ٕ٘بيف زازٜ  Material Editorضا ا٘شربة ٕ٘بييس. دٙدطٜ  Edit >Material Editorٔؿيط  DrillVizاظ دٙدطٜ انّي  .2
 ٔي قٛز.
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3. Transparency slider  سٙظيٓ وٙيس. 0.4ضا ثط ضٚي 

 زض ٌٛقٝ ؾٕز ضاؾز ثجٙسيس. ايٗ ٚيطايكٍط ضا ثب  .4

 سٙظيٓ وٙيس. transparency 0.4ضا ثطاي ؾٝ ؾُح زيٍطي وٝ ايبفٝ وطزيس سىطاض وٙيس ٚ ٕٞٝ ضا زض  4سب  1ٔطحّٝ  .5

وٝ  buffer flushايٗ چٙيٗ ٘كٛز اظ سىٙيه قٛز. زض نٛضسي وٝ  gauzyآٖ افعايف ٔي يبثس  transparencyٞط ؾُح ثبيس ظٔب٘ي وٝ ٘ىشٝ: 
 زض قطٚع ايٗ ثرف  ثطاي ثطٚظ ضؾب٘ي وطزٖ سٛنيف قس اؾشفبزٜ وٙيس.

WireFrame Objects 

 سٛا٘يس آٖ ضا ثجيٙيس.ايٗ اؾز وٝ ٔي  wire frameٔعيز ٕ٘بيف يه ٔٛضز زض حبِز 

 (Tutorial #1) زض حبَ وبضسبٖ ضا ا٘شربة وٙيس. .1

 ضا ضٚقٗ وٙيس. View    ،Display EOU (Ellipse of Uncertainty)زض ٔٙٛي   .2

3. View > Attribute Editor  ٜضا ا٘شربة وٙيس دٙدطAttribute Editor .ٕ٘بيف زازٜ ٔي قٛز 

 ضا ا٘شربة ٕ٘بييس. Drawing Styleظثب٘ٝ  .4
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 ضا ا٘شربة ٕ٘بييس. Wire Frameثطٚيس.زوٕٝ  Styleثٝ ثرف  .5

 وّيه وٙيس. OKثط ضٚي زوٕٝ  .6

)لطٔع( سغييط ٔي زٞس ثٝ َٛضي وٝ ثشٛا٘يس ٔؿيط خطيبٖ انّي  )آثي( ضا زضٖٚ آٖ ٕٞب٘ٙس  wire frameضا ثٝ  EOU دبْ ٔطاحُ فٛق اِعوط ،٘ىشٝ: ا٘
www.Ir ٘كبٖ زازٜ قس ثجيٙيس. 3D viewاظ  zoomed-inآ٘چٝ زض ثرف 
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 (Attaching a Camera for Animationٚنُ وطزٖ زٚضثيٗ ثطاي ا٘يٕيكٗ )

1. wire frame EOU ضا ا٘شربة ٕ٘بييس 

ٕ٘بيف زازٜ  Attribute Editorضا ا٘شربة ٕ٘بييس. دٙدطٜ  ...View > Attribute Editorٔؿيط  DrillVizاظ دٙدطٜ انّي  .2
 ٔي قٛز.
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 ضخ ٔي زٞس ضا ثٝ ٚيٛح ثجيٙيس. 3D viewايٗ زيبِٛي ضا ثٝ وٙبضي ثىكيس سب ثشٛا٘يس ٞط چٝ زض  .3

 ٕ٘بييس. ايٗ وبض فيّس ٔشٗ زض ايٗ نفحٝ ضا فؼبَ ٔي وٙس. ضا ا٘شربة Attach to cameraچه ثبوؽ  .4

 ٔي ثبقس. ft 14089.3٘ىشٝ: ديف فطو ػٕك ا٘ساظٜ ٌيطي اِٚيٝ ، ػٕك وّي چبٜ 

سٙظيٓ ٕ٘بييس. ايٗ وبض يه زيس  0اؾشفبزٜ وطزٜ ٚ ٞط زٚ ضا ثط ضٚي  Measured Depth and Distanceٞب ثطاي  slidersاظ  .5

 ٔي زٞس. drillbit ،starting at the top of the well  ٚlooking forwardاظ 

 ضا سبيخ ٕ٘بييس. ft/second 50ٔمساض  Depth changeثطٚيس . زض فيّس  Animationثٝ ثرف  .6

 ثبيس ثٝ نٛضر ظيط ظبٞط قٛز.  Attribute Editorاظ  Cameraنفحٝ 
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 ٚع وٙيس.وّيه ٕ٘بييس. سب ٔطاحُ ا٘يٕيكٗ ضا قط Animationزض ثرف  Startثط ضٚي  .7

 ٔشٛلف وٙيس. now-relabeled Stop٘ىشٝ: ٔي سٛا٘يس ا٘يٕيكٗ ضا زض ٞط ظٔب٘ي ثب وّيه ثط ضٚي زوٕٝ 
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